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About This Guide

This guide describes how to install, upgrade, and update Novell Open Enterprise Server (OES) 2 
SP3. Except where specifically stated, the content of this guide applies to installing OES on a 
computer’s physical hardware rather than on a Xen virtual machine host server.

 “What's New in the OES 2 Install” on page 13

 “Preparing to Install OES 2 SP3” on page 17

 “Installing OES 2 SP3 as a New Installation” on page 47

 “Installing or Configuring OES 2 SP3 on an Existing Server” on page 113

 “Upgrading to OES 2 SP3” on page 119

 “Completing OES Installation or Upgrade Tasks” on page 153

 “Updating (Patching) an OES 2 SP3 Server” on page 157

 “Using AutoYaST to Install and Configure Multiple OES Servers” on page 179

 “Installing OES as a Xen VM Host Server” on page 187

 “Installing, Upgrading, or Updating OES on a Xen-based VM” on page 189

 “Installing and Managing NetWare on a Xen-based VM” on page 203

 “Upgrading NetWare on a Xen-based VM” on page 219

 “Disabling OES 2 Services” on page 221

 “Reconfiguring eDirectory and OES Services” on page 223

 “Security Considerations” on page 231

 “Installing with EVMS as the Volume Manager of the System Device” on page 233

 “OES 2 SP3 File and Data Locations” on page 243

 “Upgrading to OES 2 SP3 Through a ZENworks Linux Management Server” on page 245

 “Documentation Updates” on page 261

Audience

This guide is intended for system administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

The latest version of the OES 2 SP3: Installation Guide is available at the Open Enterprise Server 2 
documentation Web site (http://www.novell.com/documentation/oes2/inst_oes_lx/data/front.html).
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Additional Documentation

For more information about See

Planning and implementing OES 2 SP3 OES 2 SP3: Planning and Implementation Guide

Migration from and coexistence with other products “Different Migration Tools” in the OES 2 SP3: 
Migration Tool Administration Guide

Installing OES 2 SP3 on a Xen Virtual Host Server Chapter 10, “Installing, Upgrading, or Updating 
OES on a Xen-based VM,” on page 189

SLES 10 Installation and Administration details SUSE LINUX Enterprise Server 10 Installation and 
Administration Guide (http://www.novell.com/
documentation/sles10/book_sle_reference/data/
book_sle_reference.html)
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1
1What's New in the OES 2 Install

This section summarizes the features that have been updated with each release of Novell Open 
Enterprise Server (OES) 2 Linux.

 Section 1.1, “New or Changed with the September 2011 Patch Release,” on page 13

 Section 1.2, “What’s New in the OES 2 SP3 Install,” on page 13

 Section 1.3, “What’s New in the OES 2 SP2 Install,” on page 14

 Section 1.4, “What’s New in the OES 2 SP1 Install,” on page 14

 Section 1.5, “What’s New in the OES 2 Install,” on page 14

1.1  New or Changed with the September 2011 
Patch Release
With the release of the September 2011 patches for OES 2 SP3, the base platform has been upgraded 
to SLES 10 SP4.

SLES 10 SP4 support is enabled by updating OES 2 SP3 servers with the move-to-sles10-sp4 patch. 
Novell encourages customers to update to this latest set of patches. For more information, see 
“Updating (Patching) an OES 2 SP3 Server” in the OES 2 SP3: Installation Guide.

SLES 10 SP4 is considered a lower-risk update that contains a set of consolidated bug fixes and 
support for newer hardware. It does not impact the kernel ABI or third-party certifications. 

With the release of the September 2011 patches, OES 2 SP2 customers who upgrade to OES 2 SP3 
via the move-to patch will receive the SLES 10 SP4 updates. New installations of OES 2 SP3, 
migrations to OES 2 SP3, and down-server upgrades to OES 2 SP3, should all be performed using 
SLES 10 SP4 media.

1.2  What’s New in the OES 2 SP3 Install
The following features were added or modified from the SP2 release installation:

Table 1-1   OES 2 SP3 Release

Functionality Description

SLP Services List Backup and Sync The OpenSLP configuration in OES 2 SP3 lets you 
specify that the list of services is backed up on the 
server. You can also configure SLP to query other 
Directory Agents for their service lists in cases 
where SLP has been restarted. See “Specifying 
SLP Configuration Options” on page 75.

Common Proxy User Support OES 2 SP3 includes support for a common proxy 
user. See “Specifying OES Common Proxy User 
Information” on page 77.
What's New in the OES 2 Install 13
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1.3  What’s New in the OES 2 SP2 Install
The following features were added or modified from the SP1 release installation:

Table 1-2   OES 2 SP2 Release

1.4  What’s New in the OES 2 SP1 Install
The following features were added or modified from the initial release installation:

Table 1-3   OES 2 SP1 Release

1.5  What’s New in the OES 2 Install
In the initial release of OES 2, the following features were added to the OES installation:

Functionality Description

Create an EVMS Based Proposal In the YaST install, an option is available to 
automatically create an EVMS based proposal for 
the system device. See Section A.2, “Configuring 
the System Device to Use EVMS,” on page 234.

Upgrade through the Patch Channel You can now upgrade an OES 2 SP1 server to OES 
2 SP2 through the update (patch) channel. See 
Section 5.4.5, “Using the Patch Channel to 
Upgrade (Online),” on page 130.

Functionality Description

Unsupported packages are no longer removed by 
default. 

Installing OES 2 while installing SLES 10 SP1: See 
“Specifying the Add-On Product Installation 
Information” on page 51. 

Installing OES 2 services on a server that is already 
running SLES 10 SP1: See “Installing or 
Configuring OES 2 SP3 on an Existing Server” on 
page 113.

OES servers are now configured to use eDirectory 
certificates for all HTTPS services by default in 
every installation/upgrade scenario except an 
upgrade from OES 2, where the option used during 
the initial server install/upgrade is retained.

Certificate management in OES 2: See “Certificate 
Management” in the OES 2 SP3: Planning and 
Implementation Guide.

Updating through the Novell patch channels now 
requires registering the server with the Novell 
Customer Center using either purchased activation 
codes or 60-day evaluation codes.

This change is reflected in various instructions 
throughout this and other guides.
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Table 1-4   OES 2 Initial Release

Functionality Description

Open Enterprise Server 2 Linux is an add-on 
product that can be installed with SUSE Linux 
Enterprise Server 10 SP1 or added to a server 
running SLES 10 SP1 with updates. 

Installing OES 2 while installing SLES 10 SP1: See 
“Specifying the Add-On Product Installation 
Information” on page 51. 

Installing OES 2 services on a server that is already 
running SLES 10 SP1: See “Installing or 
Configuring OES 2 SP3 on an Existing Server” on 
page 113.

DVD media is now also available to perform the 
installation.

See “Preparing Physical Media for a New Server 
Installation or an Upgrade” on page 39.

OES 2 can be installed on x86-64 bit hardware. See Table 2-1 on page 19.

Configuring OES services is easier to find and 
perform on multiple services.

See “Configuring OES Services” on page 79 and 
“Installing or Configuring OES 2 SP3 on an Existing 
Server” on page 113.

A specific tool for extending the schema is available 
in YaST.

See “Extending the Schema” on page 28.

You can install OES 2 Linux on a Xen-based virtual 
machine host server.

See “Chapter 10, “Installing, Upgrading, or 
Updating OES on a Xen-based VM,” on page 189.”

You can install OES 2 Linux as a Xen-based virtual 
machine host server.

See “Chapter 9, “Installing OES as a Xen VM Host 
Server,” on page 187.”

The method for updating OES matches the method 
for updating SLES 10 SP1.

“Updating (Patching) an OES 2 SP3 Server” on 
page 157.
What's New in the OES 2 Install 15
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2
2Preparing to Install OES 2 SP3

You should perform the tasks and understand the information outlined in the following sections:

 Section 2.1, “Before You Install,” on page 17

 Section 2.2, “32-Bit vs. 64-Bit,” on page 17

 Section 2.3, “Meeting All Server Software and Hardware Requirements,” on page 18

 Section 2.4, “eDirectory Rights Needed for Installing OES,” on page 20

 Section 2.5, “Installing and Configuring OES as a Subcontainer Administrator,” on page 21

 Section 2.6, “Preparing eDirectory for OES 2 SP3,” on page 24

 Section 2.7, “Deciding What Patterns to Install,” on page 30

 Section 2.8, “Obtaining OES 2 Software,” on page 39

 Section 2.9, “Preparing Physical Media for a New Server Installation or an Upgrade,” on 
page 39

 Section 2.10, “Setting Up a Network Installation Source,” on page 41

 Section 2.11, “Always Install OES as an Add-On Product,” on page 45

 Section 2.12, “Install Only One Server at a Time,” on page 46

 Section 2.13, “What's Next,” on page 46

2.1  Before You Install
Before you install Novell Open Enterprise Server (OES) 2 SP3, you should review the information 
in the following sections:

 “Planning Your OES 2 Implementation” in the OES 2 SP3: Planning and Implementation 
Guide 

 “Before You Install” in the OES 2 SP3 Readme

2.2  32-Bit vs. 64-Bit
OES 2 and SUSE Linux Enterprise Server (SLES) 10 are available in both 32-bit (i386) and 64-bit 
(x86-64) architectural versions. 

 Section 2.2.1, “64-Bit eDirectory,” on page 18

 Section 2.2.2, “64-Bit NCP Server,” on page 18

 Section 2.2.3, “Matching Software with Server Hardware,” on page 18

 Section 2.2.4, “Don’t Mix 32-Bit and 64-Bit OES and SLES,” on page 18
Preparing to Install OES 2 SP3 17
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2.2.1  64-Bit eDirectory

Selecting Novell eDirectory automatically installs the correct version of eDirectory. 

 OES 2 SP3 64-bit media installs 64-bit eDirectory.

 OES 2 SP3 32-bit media installs 32-bit eDirectory.

2.2.2  64-Bit NCP Server

Selecting NCP Server automatically installs the correct version of NCP Server. 

 OES 2 SP3 64-bit media installs 64-bit NCP server. 

 OES 2 SP3 32-bit media installs 32-bit NCP server.

2.2.3  Matching Software with Server Hardware

Make sure that you understand which software can be installed on which server hardware.

 64-Bit Server Hardware: Supports either the 32-bit versions of OES and SLES or the 64-bit 
versions of OES and SLES. 

 32-Bit Server Hardware: Supports only the 32-bit versions of OES and SLES.

2.2.4  Don’t Mix 32-Bit and 64-Bit OES and SLES

The 32-bit and 64-bit versions of OES and SLES are not compatible with each other. In other words, 
you cannot install 32-bit OES with 64-bit SLES on the same server hardware, and the reverse is also 
true.

2.3  Meeting All Server Software and Hardware 
Requirements
Before installing OES 2 SP3, ensure that your system meets the following requirements.

 Section 2.3.1, “Server Software,” on page 18

 Section 2.3.2, “Server Hardware,” on page 19

2.3.1  Server Software

As part of the OES 2 SP3 installation, you install SUSE Linux Enterprise Server 10 SP4.

IMPORTANT: OES 2 SP3 services were developed and tested on a default SLES 10 SP4 server 
base. 

As you install OES 2 SP3, do not change any of the SLES 10 Base Technologies package selections, 
such as Java support. Doing so can cause various problems, such as the installation failing or one or 
more OES 2 SP3 services not working properly.

If you are installing on an existing SLES 10 SP4 server, be sure to verify that all of the default SLES 
10 SP4 components are installed before attempting to install OES 2 SP3 services.
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2.3.2  Server Hardware

Table 2-1   Server Hardware Requirements

System Component Minimum Requirements Recommended Requirements

Computer Server-class computer with 
Pentium II or AMD K7 450 
MHz processor

IMPORTANT: Although OES 2 is an add-on 
product to SLES 10, it only runs on the 
processors indicated below, which are 
generically referred to as i386 and x86_64. 
Other processors that are supported by SLES 
10, such as Itanium (IA64), are not supported 
for running OES services.

Server-class computer with Pentium III, 
Pentium III Xeon, Pentium 4, Intel Xeon 700 
MHz, AMD K8 CPUs (Athlon64 and Opteron), 
Intel EM64T or higher processor. 

NOTE: Some OES services run in 32-bit mode 
only. 

Memory 1 GB of RAM 2 GB of RAM for the base system. Additional 
RAM might be required depending on which 
OES components are selected and how they 
are used.

Free Disk Space 7 GB of available, 
unpartitioned disk space

10 GB of available, unpartitioned disk space. 
Additional disk space might be required, 
depending on which OES components are 
selected and how they are used.

CD-ROM or DVD Drive 4X CD-ROM or DVD drive if 
installing from physical media

48X CD-ROM or DVD drive if installing from 
physical media

Hard Drive 20 GB

Network Board Ethernet 100 Mbps

IP address  One IP address on a 
subnet

 Subnet mask

 Default gateway

Mouse N/A USB or PS/2

Server computer BIOS Using a CD-ROM or DVD 
installation source, prepare 
the BIOS on your server 
computer so that it boots from 
the CD-ROM or DVD drive 
first.
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NOTE: The RAM and disk space amounts shown here are for system components only. The OES 
service components you install might require additional RAM and disk space. 

Be sure to complete the planning instructions found in the OES 2 SP3: Planning and 
Implementation Guide for each component you install.

2.4  eDirectory Rights Needed for Installing OES
The following eDirectory rights are discussed in this section:

 Section 2.4.1, “Rights to Install the First OES Server in a Tree,” on page 20

 Section 2.4.2, “Rights to Install the First Three Servers in an eDirectory Tree,” on page 20

 Section 2.4.3, “Rights to Install the First Three Servers in any eDirectory Partition,” on page 20

2.4.1  Rights to Install the First OES Server in a Tree

To install an OES server in a tree, you must have rights to extend the schema, meaning that you need 
Supervisor rights to the [Root] of the tree. 

You can extend the schema by using the Novell Schema Tool in YaST or by having a user with 
Supervisor rights to the [Root] of the eDirectory tree install the first OES server and the first 
instance of each OES service that will be used into the tree. For more information, see Section 2.6.4, 
“Extending the Schema,” on page 28.

2.4.2  Rights to Install the First Three Servers in an eDirectory 
Tree

If you are installing the server into a new tree, the Admin user that is created during the OES 
installation has full rights to the root of the tree. Using the account for user Admin allows the 
installer to extend the eDirectory schema for OES as necessary. To install the first OES server in an 
eDirectory tree, you must have the Supervisor right at the [Root] of the eDirectory tree. 

2.4.3  Rights to Install the First Three Servers in any eDirectory 
Partition

By default, the first three servers installed in an eDirectory partition automatically receive a replica 
of that partition. To install a server into a partition that does not already contain three replica servers, 
the user must have either the Supervisor right at the [Root] of the tree or the Supervisor right to the 
container in which the server holding the partition resides.

Video Card and Monitor 1024 X 768 resolution or 
higher with a minimum color 
depth of 8 bits (256 colors)

Although it is technically possible to run the 
ncurses installation at a lower resolution, some 
informational messages aren’t displayed 
because text strings don’t wrap to the 
constraints of the window.

System Component Minimum Requirements Recommended Requirements
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2.5  Installing and Configuring OES as a 
Subcontainer Administrator

IMPORTANT: The information explained in Section 2.4, “eDirectory Rights Needed for Installing 
OES,” on page 20 is prerequisite to the information contained in this section.

This section outlines the required eDirectory rights and explains how a subcontainer administrator 
approaches various installation tasks.

 Section 2.5.1, “Rights Required for Subcontainer Administrators,” on page 21

 Section 2.5.2, “Starting a New Installation as a Subcontainer Administrator,” on page 23

 Section 2.5.3, “Adding/Configuring OES Services as a Different Administrator,” on page 24

2.5.1  Rights Required for Subcontainer Administrators

For security reasons, you might want to create one or more subcontainer administrators 
(administrators that are in a container that is subordinate to the container that user Admin is in) with 
sufficient rights to install additional OES servers, without granting them full rights to the entire tree.

A subcontainer administrator needs the rights listed in Table 2-2 to install an OES server into the 
tree. These rights are typically granted by placing all administrative users in a Group or Role in 
eDirectory, and then assigning the rights to the Group or Role. Sample steps for assigning the rights 
to a single subcontainer administrator are provided as a general guide.

Table 2-2   Subcontainer Administrator Rights Needed to Install

Rights Needed Sample Steps to Follow

Supervisor right to itself 1. In iManager > View Objects > the Browse tab, browse to and select 
the subcontainer administrator.

2. Click the administrator object, then select Modify Trustees.

3. Click the Assigned Rights link for the administrator object.

4. For the [All Attributes Rights] property, select Supervisor, then click 
Done > OK.

Supervisor right to the 
container where the server 
will be installed

1. Browse to the container where the subcontainer administrator will 
install the server.

2. Click the container object and select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] and [Entry rights] properties, select 
Supervisor, then click Done > OK > OK.
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Supervisor right to the W0 
object located inside the 
KAP object in the Security 
container

1. Browse to Security > KAP.

2. In KAP, click W0 and select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] and [Entry rights] properties, select 
Supervisor, then click Done > OK > OK.

Supervisor right to the 
Security container when 
installing the NMAS login 
methods

If the subcontainer administrator will install the NMAS login methods:

1. Browse to and select Security

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] and [Entry rights] properties, select 
Supervisor, then click Done > OK > OK.

Create right to its own 
container (context)

1. Browse to and select the container where you created the 
subcontainer administrator.

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [Entry Rights] property, select Create, then click Done > OK > 
OK.

Create right to the container 
where the UNIX Config 
object is located.

1. Browse to and select the container where the UNIX Config object is 
located. By default, this is the Organization object.

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [Entry Rights] property, select Create, then click Done > OK > 
OK.

Read right to the Security 
container object for the 
eDirectory tree

This is not needed if the Supervisor right was assigned because of NMAS.

If the subcontainer administrator won’t install the NMAS login methods, do 
the following:

1. Browse to and select Security

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] property, select Read, then click Done > 
OK > OK.

Rights Needed Sample Steps to Follow
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When you install DNS/DHCP into an existing tree with DNS/DHCP, see the following additional 
guidelines:

 For DNS, see “eDirectory Permissions ” in the OES 2 SP3: Novell DNS/DHCP Administration 
Guide.

 For DHCP, see “eDirectory Permissions ” in the OES 2 SP3: Novell DNS/DHCP 
Administration Guide.

2.5.2  Starting a New Installation as a Subcontainer 
Administrator

You can install a new OES server into an existing tree as a subcontainer administrator if you have: 

 The rights described in “Rights Required for Subcontainer Administrators” on page 21 

 (If applicable) The rights described for the server installations in “eDirectory Rights Needed 
for Installing OES” on page 20.

When you reach the eDirectory Configuration - Existing Tree page, enter your fully distinguished 
name (FDN) and password. After verifying your credentials, the installation proceeds normally.

Read right to the 
NDSPKI:Private Key 
attribute on the 
Organizational CA object 
(located in the Security 
container)

1. Browse to Security and select the Organizational CA object.

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. Click the Add Property button.

6. Select NDSPKI:Private Key and click OK.

The Read right should be automatically assigned.

7. Click Done > OK > OK.

Read and Write rights to the 
UNIX Config object.

1. Browse to and select the UNIX Config object.

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] property, select Write (Read is already 
selected), then click Done > OK > OK.

Write right to the [All 
Attribute Rights] property for 
the admingroup object.

1. Browse to and select the admingroup object.

2. Select Modify Trustees.

3. Click Add Trustee, browse to and select the subcontainer 
administrator, then click OK.

4. Click the Assigned Rights link for the administrator object.

5. For the [All Attributes Rights] property, select Write (Compare and 
Read are already selected), then click Done > OK > OK.

Rights Needed Sample Steps to Follow
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2.5.3  Adding/Configuring OES Services as a Different 
Administrator

To add or configure OES services on an OES server that another administrator installed, see 
“Adding/Configuring OES Services on a Server That Another Administrator Installed” on page 118.

2.6  Preparing eDirectory for OES 2 SP3
 Section 2.6.1, “If Your Directory Tree Is Earlier than eDirectory 8.6,” on page 24

 Section 2.6.2, “If Your LDAP Server Is Running NetWare 6.5 SP2 or Earlier,” on page 25

 Section 2.6.3, “If Your Tree Has Ever Contained an OES 1 Linux Server with LUM and NSS 
Installed,” on page 25

 Section 2.6.4, “Extending the Schema,” on page 28

2.6.1  If Your Directory Tree Is Earlier than eDirectory 8.6

If you are installing an OES 2 server into an eDirectory tree that is earlier than eDirectory 8.6, do the 
following before installing your first OES server in an existing NetWare tree:

1 Extend the schema by using Deployment Manager. See “Schema Update” in the NW65 SP8: 
Installation Guide.

2 Ensure that the schema is synchronized throughout the tree from [ROOT]:

2a Enter the following commands at the System Console prompt of the NetWare server with 
the Master of [ROOT]:

set DSTRACE=on

set DSTRACE=nodebug

set DSTRACE=+Schema

set DSTRACE=*SSD

set DSTRACE=*SSA

2b Toggle to the Directory Services screen and look for the message All Processed = 
YES.

2c On each server that holds a Master of a partition, enter the following commands at the 
System Console prompt:

set DSTRACE=off

set DSTRACE=nodebug

set DSTRACE=+Schema

set DSTRACE=*SS

2d Toggle to the Directory Services screen and look for the message All Processed = 
YES.
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2.6.2  If Your LDAP Server Is Running NetWare 6.5 SP2 or 
Earlier

If you are installing into an eDirectory tree that is using a NetWare server to supply LDAP, you 
should upgrade the LDAP server that the OES installation will communicate with to NetWare 6.5 
SP3 or later. A server running NetWare 6.5 SP2 or earlier will probably abend.

2.6.3  If Your Tree Has Ever Contained an OES 1 Linux Server 
with LUM and NSS Installed

Having NSS volumes on OES servers requires certain system-level modifications, most of which are 
automatic. For more information, see “System User and Group Management in OES 2 SP3” in the 
OES 2 SP3: Planning and Implementation Guide

 “NetStorage, X-Tier, and Their System Users” on page 25

 “An NSS Complication” on page 25

 “eDirectory Solves the Basic Problem” on page 26

 “ID Mismatches on OES 1” on page 26

 “The OES 1 Solution: the nssid.sh Script” on page 26

 “OES 2 SP1 and Later Require a New Approach” on page 26

 “The OES 2 Solution: Standardizing the UIDs on all OES servers” on page 26

NetStorage, X-Tier, and Their System Users

By default, certain OES services, such as NetStorage, rely on a background Novell service named 
X-Tier. 

To run on an OES server, X-Tier requires two system-created users (named novlxsrvd and 
novlxregd) and one system-created group that the users belong to (named novlxtier). 

An NSS Complication

The two X-Tier users mentioned above, and their group, are created on the local system when X-
Tier is installed. For example, they are created when you install NetStorage, and their respective 
UIDs and GID are used to establish ownership of the service’s directories and files.

For NetStorage to run, these X-Tier users and group must be able to read data on all volume types 
that exist on the OES server. 

As long as the server has only Linux traditional file systems, such as Ext3 and Reiser, NetStorage 
runs well. 

However, if the server has NSS volumes, an additional requirement is introduced. NSS data can only 
be accessed by eDirectory users. Consequently, the local X-Tier users can’t access NSS data, and 
NetStorage can’t run properly.
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eDirectory Solves the Basic Problem

When NSS volumes are created on the server, the two X-Tier system users and their group are 
moved to eDirectory and enabled for Linux User Management (LUM). (See “Linux User 
Management: Access to Linux for eDirectory Users” in the OES 2 SP3: Planning and 
Implementation Guide.). 

After the move to eDirectory, they can function as both eDirectory and POSIX users, and they no 
longer exist on the local system. 

ID Mismatches on OES 1

On OES 1, problems occur when additional OES NetStorage servers with NSS volumes are installed 
in the same eDirectory container. Because the UIDs and GID are assigned by the system, unless the 
installation process is exactly the same for each OES 1 server, the UIDs and GID don’t match 
server-to-server.

When the local X-Tier UIDs and GID on subsequently installed servers don’t match the X-Tier 
UIDs and GID in eDirectory, NetStorage can’t access the NSS volumes on the server.

The OES 1 Solution: the nssid.sh Script

To solve the problem of mismatched Ids, the OES 1 installation program looks for X-Tier ID 
conflicts, and if the IDs on a newly installed server don’t match the IDs in eDirectory, the program 
generates a script file named nssid.sh. The OES 1 documentation instructs installers to always 
check for an nssid.sh file on a newly installed server, and if the file is found, to run it. The 
nssid.sh script synchronizes all of the X-Tier IDs with those in eDirectory. 

However, this solution is only viable through the first release of OES 2. 

OES 2 SP1 and Later Require a New Approach

System-level changes in SUSE Linux Enterprise Server 10 SP2 and later invalidate the nssid.sh 
script solution for mismatched IDs. Synchronizing the X-Tier IDs with an OES 1 installation can 
now cause instability in other non-OES components. Therefore, starting with OES 2 SP1, you 
should standardize all X-Tier IDs on existing servers before installing a new server with X-Tier-
dependent services.

The OES 2 Solution: Standardizing the UIDs on all OES servers

If your eDirectory tree has ever contained an OES 1 Linux server with NSS and LUM installed, do 
the following on each server (including OES 2) that has NSS and LUM installed:

1 Log in as root and open a terminal prompt. Then enter the following commands:

id novlxregd

id novlxsrvd

The standardized X-Tier IDs are UID 81 for novlxregd, UID 82 for novlxsrvd, and GID 81 
for novlxtier.

2 If you see the following ID information, the X-Tier IDs are standardized and you can move to 
the next server:

uid=81(novlxregd) gid=81(novlxtier) groups=81(novlxtier)
uid=82(novlxsrvd) gid=81(novlxtier) groups=81(novlxtier),8(www)
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If you see different IDs than those listed above, such as 101, 102, 103, etc., record the numbers 
for both X-Tier users and the novlxtier group. You need these IDs to standardize the IDs on the 
server.

3 Download the following script file:

 fix_xtier_ids.sh (http://www.novell.com/documentation/oes2/scripts/fix_xtier_ids.sh)

4 Customize the template file by replacing the variables in angle brackets (<>) as follows:

 <server_name>: The name of the server object in eDirectory. 

Replace this variable with the server name.

For example, if the server name is myserver, replace <server_name> with myserver so that 
the line in the settings section of the script reads

server=myserver

 <context>: The context of the X-Tier user and group objects. 

Replace this variable with the fully distinguished name of the context where the objects 
reside.

For example, if the objects are an Organizational Unit object named servers, replace  
ou=servers,o=company.

 <admin fdn>: The full context of an eDirectory admin user, such as the Tree Admin, who 
has rights to modify the X-Tier user and group objects. 

Replace this variable with the admin name and context, specified with comma-delimited 
syntax. 

For example, if the tree admin is in an Organization container named company, the full 
context is cn=admin,o=company and the line in settings section of the script reads

admin_fdn=”cn=admin,o=company”

 <novlxregd_uid>: The UID that the system assigned to the local novlxregd user. It might 
or might not be the same on each server, depending on whether the nssid.sh script ran 
successfully. 

Replace this variable with the UID reported for the novlxregd user on this server as listed 
when you ran the commands in Step 1 on page 26.

In the example script, the original UID is 101. It is changed to 81 in the third line of the 
script. The sixth line changes the UID on all of the files and directories on the server that 
are owned by the novlxregd user from 101 to 81.

 <novlxsrvd_uid>: The UID that the system assigned to the local novlxsrvd user. It might 
not be the same on each server, depending on whether the nssid.sh script ran 
successfully.

Replace this variable with the UID reported for the novlxsrvd user on this server as listed 
when you ran the commands in Step 1 on page 26.

In the example script, the original UID is 103. It is changed to 82 in the fourth line of the 
script. The seventh line changes the UID on all of the files and directories on the server 
that are owned by the novlxsrvd user from 103 to 82.

 <novlxtier_gid>: The GID that the system assigned to the local novlxtier group. It might 
not be the same on each server, depending on whether the nssid.sh script ran 
successfully. 
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Replace this variable with the GID reported for the novlxtier group on this server as listed 
when you ran the commands in Step 1 on page 26.

In the example script, the original GID is 101. It is changed to 81 in the second line of the 
script. The six and seventh lines change the GID from 101 to 81 for all of the files and 
directories on the server that are owned by the novlxtier group.

5 Make the script executable and run it on the server.

IMPORTANT: Changes to the X-Tier files are not reported on the terminal. 

Error messages are reported, but you can safely ignore them. The script scans the entire file 
system, and some files are locked because the system is running. 

6 Repeat from Step 1 for each of the other servers in the same context. 

2.6.4  Extending the Schema

An eDirectory tree must have its schema extended to accommodate OES 2 servers and services as 
explained in the following sections.

 “Who Can Extend the Schema?” on page 28

 “Which OES 2 SP3 Services Require a Schema Extension?” on page 28

 “Extending the Schema While Installing OES 2” on page 29

 “Using the YaST Plug-In to Extend the Schema” on page 29

 “Extending the Schema for Novell Cluster Services” on page 30

Who Can Extend the Schema?

Only an administrator with the Supervisor right at the [Root] of an eDirectory tree can extend the 
tree’s schema. 

Which OES 2 SP3 Services Require a Schema Extension?

The following service schema extensions are included with OES 2 SP3. 

A single asterisk (*) indicates a service that is either required for OES 2 servers or for the default 
services that are installed on every OES 2 server. They are implemented when the first OES 2 SP1 or 
later server is installed in the tree. 

Unmarked extensions are implemented the first time their respective services are installed, unless 
the schema was previously extended using another method, such as the YaST plug-in (see “Using 
the YaST Plug-In to Extend the Schema” on page 29).

 CIFS

 Directory Services*

 iFolder

 iPrint

 DHCP

 DNS

 Domain Services for Windows
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 Linux User Management*

 NCP

 NCS

Novell Cluster Services requires you to extend the schema manually. Follow the instructions in 
“Extending the eDirectory Schema to Add Cluster Objects” in the OES 2 SP3: Novell Cluster 
Services 1.8.8 Administration Guide for Linux.

 NetStorage

 NMAS*

 Novell Storage Services

 Storage Management Services*

Extending the Schema While Installing OES 2

The simplest way to extend the schema for OES 2 servers is to have a tree admin install the first 
OES 2 server and the first instance of each OES 2 service that you plan to run on your network. 

After this initial installation, you can assign subcontainer admins with the required rights to install 
additional servers and services. For more information on the required rights for the various OES 
services, see “Rights Required for Subcontainer Administrators” on page 21.

Using the YaST Plug-In to Extend the Schema

If you want a subcontainer admin to install the first OES 2 server or the first instance of an OES 2 
service in an existing tree, and you don’t want to grant that admin the Supervisor right to the [Root] 
of the tree, someone with the Supervisor right to [Root] can extend the schema by using YaST from 
any of the following locations: 

 An OES 2 SP3 server running in another tree

 An OES 2 SP3 server that was installed without any OES 2 services added (the YaST plug-in is 
a default OES 2 component)

or

 A SLES 10 SP4 server with the yast2-novell-schematool.rpm installed. The RPM is 
available on the OES 2 SP3 installation media and can be launched at a terminal prompt 
following installation by entering yast2 novell-schematool.

To run the Novell Schema Tool:

1 On the server’s desktop, click Computer and open the YaST Control Center.

2 Click Open Enterprise Server > Novell Schema Tool.

3 Depending on the installation method you used, you might be required to insert your OES 2 
installation media.

4 On the Novell eDirectory Extension Utility page, specify the information for an eDirectory 
server with a Read/Write replica of the Root partition.

Be sure to provide the correct information to authenticate as an admin user with the Supervisor 
right at the [Root] of the target tree. Otherwise, the schema extension fails.

5 If you are preparing the tree so that a subcontainer admin can install the first OES 2 SP1 or later 
server, select the services marked with an asterisk (*) in “Which OES 2 SP3 Services Require a 
Schema Extension?” on page 28. 
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Although this step is not required if the tree already has an OES 2 SP1 or later server installed, 
selecting the marked services won’t cause any problems. 

6 Select all of the other services you plan to run on any of the OES 2 servers in the tree.

7 Click Next.

The schema is extended.

The YaST2 novell-schematool utility writes the schema event messages to the /var/opt/
novell/eDirectory/log/oes_schema.log file on the server where the utility is running.

Extending the Schema for Novell Cluster Services

If you want a subcontainer administrator to install the first instance of Novell Cluster Services in a 
tree, you can extend the schema by following the instructions in “Extending the eDirectory Schema 
to Add Cluster Objects” in the OES 2 SP3: Novell Cluster Services 1.8.8 Administration Guide for 
Linux.

2.7  Deciding What Patterns to Install
A default SLES 10 SP4 installation has the following base technology, graphical environment, and 
primary function patterns selected for installation. With the exception explained in the two 
Important notes below, you can accept or deselect these patterns and install additional patterns as 
desired.

Table 2-3   Standard SLES 10 SP4 Installation Patterns

Pattern Description

Server Base System Consists of all packages that are common to all Novell SUSE Linux 
Enterprise products. Also provides a Linux Standard Base 3.0 
compliant runtime environment.

This pattern is selected for installation by default. 

IMPORTANT: You must either install this pattern or the Common 
Code Base pattern.

Common Code Base The largest system. It includes all packages available with SUSE 
Linux, except those that would result in dependency conflicts. 

IMPORTANT: You must either install this pattern or the Server Base 
System pattern.

Novell AppArmor Novell AppArmor is an open source Linux application security 
framework that provides mandatory access control for programs, 
protecting against the exploitation of software flaws and compromised 
systems. AppArmor includes everything you need to provide effective 
containment for programs (including those that run as root) to thwart 
attempted exploits and even zero-day attacks. AppArmor offers an 
advanced tool set that largely automates the development of per-
program application security so that no new expertise is required.

This pattern is selected for installation by default. 
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The OES add-on installation includes the following OES Services patterns:

Table 2-4   OES Services Pattern Descriptions

GNOME Desktop Environment The GNOME desktop environment is an intuitive and attractive 
desktop for users. The GNOME development platform is an extensive 
framework for building applications that integrate into the rest of the 
desktop.

This pattern is selected for installation by default.

X Window System In continuous use for over 20 years, the X Window System provides 
the only standard platform-independent networked graphical window 
system bridging the heterogeneous platforms in today's enterprise: 
from network servers to desktops, thin clients, laptops, and 
handhelds, independent of operating system and hardware.

This pattern is selected for installation by default.

Print Server Sets up a print server to host print queues so that they can be 
accessed by other computers on the same network, including 
machines running Microsoft Windows operating systems. The print 
server can accept print jobs from client computers and direct them to 
locally attached printers or to network printers. LPD, CUPS, and SMB 
print servers and queues are supported.

This pattern is selected for installation by default.

Pattern Description

Novell AFP A Novell AFP server allows Macintosh clients to access data stored on NSS 
volumes in the same way they access data on a Mac OS X server.

This pattern selects and installs these services:

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell Storage Services (NSS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Pattern Description
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Novell Archive and 
Version Services

Novell Archive and Version Services systematically captures and stores 
versions of your network files in an archive database, on a schedule that you 
determine. Users can search for a previous version of a file and quickly 
restore it.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

 Novell Storage Services (NSS)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Novell Backup/Storage 
Management Services 
(SMS)

The Novell backup infrastructure (called Storage Management Services or 
SMS) provides backup applications with the framework to develop a complete 
backup and restore solution.

SMS helps back up file systems (such as NSS) or application data (such as 
data from GroupWise) on NetWare and SUSE Linux Enterprise Server (SLES) 
to removable tape media or other media for off-site storage. It provides a 
single consistent interface for all file systems and applications across NetWare 
and SLES.

This pattern selects and installs these services:

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell CIFS CIFS (Common Internet File System) is a network sharing protocol. Novell 
CIFS enables Windows, Linux, and UNIX client workstations to copy, delete, 
move, save, and open files on an OES 2 server. CIFS allows read and write 
access from multiple client systems simultaneously.

This pattern selects and installs these services:

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell Storage Services (NSS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

 Novell Samba

Pattern Description
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Novell Cluster Services 
(NCS)

Novell Cluster Services is a server clustering system that ensures high 
availability and manageability of critical network resources including data, 
applications, and services. It is a multinode clustering product for Linux that is 
enabled for Novell eDirectory and supports failover, failback, and migration 
(load balancing) of individually managed cluster resources.

Novell Cluster Services lets you add Linux nodes to an existing NetWare 6.5 
cluster without bringing down the cluster, or it lets you create an all-Linux 
cluster. With a mixed cluster, you can migrate services between OS kernels, 
and if services are alike on both platforms (such as NSS), you can set the 
services to fail over across platforms.

Using Novell Cluster Services with iSCSI technologies included in OES, you 
can build inexpensive clustered SANs on commodity gigabit Ethernet 
hardware. You can leverage existing hardware into a high availability solution 
supporting Linux and NetWare clusters.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server with these services:

 High Availability

Novell DHCP Novell DHCP (Dynamic Host Configuration Protocol) uses eDirectory to 
provide configuration parameters to client computers and integrate them into a 
network.

The eDirectory integration lets you have centralized administration and 
management of DHCP servers across the enterprise and lets you set up 
DHCP subnet replication via Novell eDirectory.

This pattern selects and installs these services: 

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell DNS Novell DNS uses Novell eDirectory to deliver information associated with 
domain names, in particular the IP address.

This eDirectory integration lets you have centralized administration and 
management of DNS servers across the enterprise and lets you set up a DNS 
zone via Novell eDirectory.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Pattern Description
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Novell Domain Services 
for Windows

Novell Domain Services for Windows provides seamless cross-authentication 
capabilities between Windows/Active Directory and Novell OES 2 servers. It is 
a suite of integrated technologies that removes the need for the Novell Client 
when logging on and accessing data from Windows workstations in eDirectory 
trees. This technology simplifies the management of users and workstations in 
mixed Novell-Microsoft environments.

This pattern selects and installs these services:

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell DNS

 Novell iManager

 Novell iPrint

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

 Novell Storage Services (NSS)

 Novell NCP Server

This pattern cannot be installed on the same server as these services:

 Novell Samba

 Novell CIFS

 Novell AFP

 Novell Archive and Version Services

 Novell FTP

 Novell iFolder

 Novell NetStorage

 Novell Pre-Migration Server

 Novell QuickFinder

Novell eDirectory Novell eDirectory services are the foundation for the world's largest identity 
management, high-end directory service that allows businesses to manage 
identities and security access for employees, customers, and partners. More 
than just an LDAP data store, eDirectory is the identity foundation for 
managing the relationships that link your users and their access rights with 
corporate resources, devices, and security policies.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 OpenLDAP

Pattern Description
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Novell FTP Novell FTP (File Transfer Protocol) is integrated with Novell eDirectory so that 
users can securely transfer files to and from OES volumes.

This pattern selects and installs these services: 

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Novell iFolder Novell iFolder 3.8 is a simple and secure storage solution that increases user 
productivity by enabling users to back up, access, and manage their personal 
files from anywhere, at any time.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Novell iManager Novell iManager is a Web-based administration console that provides secure, 
customized access to network administration utilities and content from virtually 
anywhere you have access to the Internet and a Web browser.

iManager provides the following benefits:

 Single point of administration for Novell eDirectory objects, schema, 
partitions, and replicas

 Single point of administration for many other network resources

 Management of many Novell products by using iManager plug-ins

 Role-Based Services (RBS) for delegated administration

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Pattern Description
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Novell iPrint Novell iPrint lets employees, partners, and customers access printers from a 
variety of locations across the network and the Internet. From a Web browser, 
users can easily install any printer on the network from any location.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory 

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 CUPS

Novell Linux User 
Management (LUM)

Linux User Management (LUM) enables eDirectory users to function as local 
POSIX users on Linux servers. This functionality lets administrators use 
eDirectory to centrally manage remote users for access to one or more OES 
servers.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Remote Manager (NRM)

Novell NCP Server / 
Dynamic Storage 
Technology

Novell NCP Server for Linux enables support for login scripts, mapping drives 
to OES servers, and other services commonly associated with Novell Client 
access. This means that Windows users with the Novell Client installed can be 
seamlessly transitioned to file services on OES.

NCP Server includes Novell Dynamic Storage Technology, which allows 
seldom-accessed files on NSS volumes to be automatically moved, according 
to policies set by the administrator, from faster-access storage to lower-cost 
storage media where the files can be more easily managed and backed up.

Services included with NCP (NetWare Core Protocol) are file access, file 
locking, security, tracking of resource allocation, event notification, 
synchronization with other servers, connection and communication, print 
services and queue management, and network management.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)
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Novell NetStorage Novell NetStorage provides the solution for simple, Internet-based access to 
file storage. NetStorage is a bridge between a company's protected Novell 
storage network and the Internet. It lets users access files securely from any 
Internet location, with nothing to download or install on the user's workstation.

With Novell NetStorage, a user can securely access files from any Internet-
enabled machine. Users can copy, move, rename, delete, read, write, recover, 
and set trustee assignments (based on their privilege level) on files between a 
local workstation and a Novell storage network. Access is available from any 
Internet-attached workstation, anywhere in the world. There is no need to e-
mail or copy data from one machine to another.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell iManager

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Novell Pre-Migration 
Server

A Novell Pre-Migration Server is not actually a service. Rather, it is a special-
purpose server—the target of a Server ID Transfer Migration.

Selecting this option causes this server to be installed without an eDirectory 
replica, thus preparing it to assume the identity of another server that you plan 
to decommission. For more information, see the OES 2 SP3: Migration Tool 
Administration Guide.

You should also select and install all the services that you plan to migrate from 
the other server. Services that are not installed on this server prior to the 
migration cannot be migrated.

This pattern selects and installs these services:

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory (without a replica)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Pattern Description
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Novell QuickFinder QuickFinder lets your users find the information they're looking for on any of 
your public and private Web sites, your partners' sites, and any number of 
additional Web sites across the Internet or internal file servers, all from a 
single search form on your Web page.

You can easily modify the look and feel of any of the sample search results 
pages to match your corporate design.

You can create full-text indexes of HTML, XML, PDF, Word, OpenOffice.org, 
and many other document formats in almost any language with the 
QuickFinder Unicode indexing engine.

You can configure and maintain your indexes remotely from anywhere on the 
network with the QuickFinder Web-based administration module.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell Domain Services for Windows

Novell Remote Manager 
(NRM)

Novell Remote Manager lets you securely access and manage one or more 
servers from any location through a standard Web browser. You can use 
Novell Remote Manager to monitor your server's health, change the 
configuration of your server, or perform diagnostic and debugging tasks.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

Novell Samba Novell Samba provides Windows (CIFS and HTTP-WebDAV) access to files 
stored on an OES server's file system using an eDirectory username and 
password.

This pattern selects and installs these services: 

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Novell CIFS

 Novell Domain Services for Windows

Pattern Description
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If you want to install these services, you can select them to install with most other patterns during 
the initial server installation by customizing the installation or you can install them after installing 
your initial Open Enterprise Server. For more information, see “Customizing the Software 
Selections” on page 56 and “Installing or Configuring OES 2 SP3 on an Existing Server” on 
page 113.

2.8  Obtaining OES 2 Software
For information on obtaining OES software, see “Getting and Preparing OES 2 Software” in the 
OES 2 SP3: Planning and Implementation Guide.

2.9  Preparing Physical Media for a New Server 
Installation or an Upgrade 
To prepare physical media for an installation or upgrade, you must first download ISO image files 
and then burn the CDs or DVDs that you need for your server. Detailed download instructions are 
available in “Getting and Preparing OES 2 Software” in the OES 2 SP3: Planning and 
Implementation Guide.

Novell Storage Services 
(NSS)

The Novell Storage Services (NSS) file system provides many unique and 
powerful file system capabilities. It is especially suited for managing file 
services for thousands of users in an organization. It also includes Novell 
Distributed File Services for NSS volumes.

Unique features include visibility, trustee access control model, multiple 
simultaneous namespace support, native Unicode, user and directory quotas, 
rich file attributes, multiple data stream support, event file lists, and a file 
salvage subsystem.

NSS volumes are cross-compatible between kernels. You can mount a non-
encrypted NSS data volume on either the Linux or NetWare kernel and move it 
between them. In a clustered SAN, volumes can fail over between kernels, 
allowing for full data and file system feature preservation when migrating data 
to Linux.

IMPORTANT: If you select this service, you might need to reconsider the disk 
partition setup you have chosen. For information, see Appendix A, “Installing 
with EVMS as the Volume Manager of the System Device,” on page 233.

This pattern selects and installs these services:

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell NCP Server

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

This pattern cannot be installed on the same server as these services:

 Xen Virtual Machine Host Server

Pattern Description
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Table 2-5 lists the image files you need, depending on whether your server has a CD drive or a CD/
DVD combo drive. 

Table 2-5   Files to Download

IMPORTANT: You can download the OES 2 CD and the SLES 10 DVD ISO files listed in Table 2-
5 from the OES 2 SP3 download page (http://download.novell.com/
Download?buildid=vU8lidWAgvY~). 

The SLES 10 SP4 CD ISO files listed in Table 2-5 are only available on the SLES 10 SP4 download 
page (http://download.novell.com/Download?buildid=Z4ysu62Q4gw~).

1 Download the ISO files you need for your hardware capabilities.

2 Insert a blank, writable CD or DVD into your CD or DVD burner.

3 Select the option to create a CD or DVD from an image file.

4 Select ISO as the file type.

5 Select the first image file (see Table 2-5) from the location you downloaded it to.

6 Complete the CD or DVD creation process.

7 Label the disk.

8 Repeat this process for each of the ISO image files you downloaded.

Platform Files needed

32-bit server with CD drive  SLES-10-SP4-CD-i386-GM-CD1.iso

 SLES-10-SP4-CD-i386-GM-CD2.iso

 SLES-10-SP4-CD-i386-GM-CD3.iso

 SLES-10-SP4-CD-i386-GM-CD4.iso

 OES2-SP3-i386-CD1.iso

32-bit server with CD/DVD drive  SLES-10-SP4-DVD-i386-GM-DVD1.iso

 OES2-SP3-i386-CD1.iso

64-bit server with CD drive  SLES-10-SP4-CD-x86_64-GM-CD1.iso

 SLES-10-SP4-CD-x86_64-GM-CD2.iso

 SLES-10-SP4-CD-x86_64-GM-CD3.iso

 SLES-10-SP4-CD-x86_64-GM-CD4.iso

 OES2-SP3-x86_64-CD1.iso

64-bit server with CD/DVD drive  SLES-10-SP4-DVD-x86_64-GM-DVD1.iso

 OES2-SP3-x86_64-CD1.iso

32-bit server with CD drive  SLES-10-SP4-CD-i386-GM-CD1.iso

 SLES-10-SP4-CD-i386-GM-CD2.iso

 SLES-10-SP4-CD-i386-GM-CD3.iso

 SLES-10-SP4-CD-i386-GM-CD4.iso

 OES2-SP3-i386-CD1.iso
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2.10  Setting Up a Network Installation Source
The YaST install lets you use installation sources files that are hosted on the network to install a new 
server or upgrade an existing server. The following sections describe how to set up a network 
installation source server on the following platforms:

 Section 2.10.1, “SUSE Linux as a Network Installation Source Server,” on page 41

 Section 2.10.2, “NetWare as a Network Installation Source Server,” on page 43

 Section 2.10.3, “Windows as a Network Installation Source Server,” on page 45

2.10.1  SUSE Linux as a Network Installation Source Server

To prepare a network installation source on a SUSE Linux server, see:

 “Setting Up the Server Holding the Installation Sources” (http://www.novell.com/
documentation/sles10/book_sle_reference/data/sec_deployment_remoteinst_instserver.html) 
in the SLES 10 SP4 Installation and Administration Guide (http://www.novell.com/
documentation/sles10/book_sle_reference/data/book_sle_reference.html) 

 The instructions in the following sections:

 “Requirements” on page 41

 “Procedure” on page 41

 “NFS Protocol Configuration” on page 42

 “FTP Protocol Configuration” on page 42

 “HTTP Protocol Configuration” on page 43

Requirements

To set up a network installation source, you need the following:

 A YaST Network Installation source server

This source server can be SLES 9, SLES 10, SUSE Linux 9.3 or later, OES 1 or OES 2, 
Windows, or NetWare 6.5.

 An active network connection between the installation source server and the OES server you 
are installing or upgrading. 

Procedure

1 Download or copy the ISO image files to a directory of your choice. See “Getting and 
Preparing OES 2 Software” in the OES 2 SP3: Planning and Implementation Guide.

2 Configure your Linux server to be a YaST installation server and select the location for the root 
of the network installation.

The three protocol options to choose from for configuring the YaST installation server are NFS, 
FTP, and HTTP. For the protocol configuration procedures, see the following:

 “NFS Protocol Configuration” on page 42

 “FTP Protocol Configuration” on page 42

 “HTTP Protocol Configuration” on page 43
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FTP and HTTP do not allow you to serve the files without possible modifications to .conf 
files. NFS is the simplest protocol to configure and is recommended.

3 Create a boot CD using the .iso image file for SUSE Linux Enterprise Server SP4 CD 1 and 
label it with that name.

For information on creating this CD, see “Preparing Physical Media for a New Server 
Installation or an Upgrade” on page 39.

This CD will be the network installation boot CD.

With these steps completed, you are ready to perform a new installation or upgrade using a network 
installation source. See “Starting the OES 2 SP3 Installation” on page 47 or “Upgrading to OES 2 
SP3” on page 119.

NFS Protocol Configuration

An NFS share can be shared easily from almost any location on your file system. Use the following 
procedure if you choose to use this protocol:

1 At your network installation server, launch YaST.

2 Select Network Services, then click NFS Server.

You might be prompted to install the NFS server.

3 On the NFS Server configuration screen, select Start in the NFS Server section, select Open 
Port in Firewall in the Firewall section, then click Next.

4 In the Directories section, click Add Directory and specify or browse to the directory where you 
have created the install root (source directory), then click OK.

5 Accept the defaults in the pop-up window for adding a Host. 

If you are experienced with NFS configurations, you can customize the configuration.

6 Click Finish.

FTP Protocol Configuration

These instructions use Pure-FTPd and can be implemented through YaST. Depending on the FTP 
server you use, the configuration might be different. 

If you have created your install root (source directory) within your FTP root, you can forego the 
following procedure and simply start Pure-FTPd. 

The default configuration of Pure-FTPd runs in chroot jail, so symlinks cannot be followed. In order 
to allow FTP access to the install root created outside of the FTP root, you must mount the install 
root directory inside of the FTP root.

If you have not created your install root within your FTP root and you choose to use this protocol:

1 Create a directory inside of your FTP root.

2 Run the following command:

mount --bind /path_to_install_root /path_to_directory_in_ftp_root

For example, 

mount --bind /tmp/OES /srv/ftp/OES
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3 (Optional) If you want to make this install root permanent, add this command to the /etc/
fstab file.

4 Start Pure-FTPd.

HTTP Protocol Configuration

These instructions use Apache2 as provided by SLES 10.

If you choose to use this protocol:

1 Modify the default-server.conf file of your HTTP server to allow it to follow symlinks 
and create directory indexes.

The default-server.conf file is located in the /etc/apache2 directory. In the Directory 
tag of the default-server.conf file, remove None if it is there, add FollowSymLinks and 
Indexes to the Options directive, then save the changes.

2 (Conditional) If the install root is outside of the HTTP root, create a symbolic link to the install 
root with the following command:

ln -s /path_to_install_root /path_to_link 

For example, 

ln -s /tmp/OES /srv/www/htdocs/OES

3 Restart Apache.

2.10.2  NetWare as a Network Installation Source Server

Complete the instructions in this section to set up an Novell Open Enterprise Server (OES) 2 
installation source on an existing NetWare 6.5 server.

 “Prerequisites” on page 43

 “Copy the Files and Mount Them as NSS Volumes” on page 44

 “Create the Boot CDs” on page 45

Prerequisites

You need the following:

 A NetWare 6.5 server accessible on the network where you plan to install the OES 2 SP3 
servers with the following:

 6 GB free disk space on the server

 The Apache Web Server for NetWare installed and running

 The following ISO image files from Novell:

These will set up installation sources for both i386 (32-bit) and x86_64 (64-bit) servers. If you 
plan to install only one of the platforms, then you need only the images associated with that 
platform.
Preparing to Install OES 2 SP3 43



44 OES 2
For information on downloading these image files, see the Novell Open Enterprise Server 2 
Download Instructions (http://www.novell.com/documentation/oes2/esd/di_oes2_sp2.html).

Copy the Files and Mount Them as NSS Volumes

The following instructions create unrestricted access to OES 2 SP3 installation files on a NetWare 
server on your network. Restricting access to the installation files requires additional configuration 
through Apache Manager or requires manual editing of the Apache configuration files. 

For more information on restricting access, see information about the Options, Order, Deny, Allow, 
and other directives on the Apache.org Web Site (http://httpd.apache.org/docs-2.0/mod/
directives.html).

To provide unrestricted access to the OES 2 SP3 image files:

1 Create a directory at the root of a server volume with at least 6 GB of free disk space.

For example, you might create a directory named OES2_INSTALL in a volume named TOOLS.

2 Restrict access to the directory to only those administrators who copy image files to the 
directory. 

This is important because if someone attempts to access these files after they are mounted as 
NSS volumes, the volumes are immediately dismounted and are no longer available.

3 Copy the DVD image files listed in “Prerequisites” on page 43 to the directory you just created.

4 At the server console, mount each image file as an NSS volume:

4a Enter the following command:

nss /MountImageVolume=volume:directory/filename.iso

Replace volume with the NSS volume name, directory with the directory you created in 
Step 1, and filename with the name of the ISO file.

For example:

nss /MountImageVolume=TOOLS:OES2_INSTALL/SLES-10-SP4-i386-DVD1.iso

4b Note the assigned volume name.

Image File Purpose

SLES-10-SP4-CD-i386-GM-CD1.iso Boot CD for i386 (32-bit) SUSE Linux Enterprise Server 
(SLES) 10 SP4 installations 

SLES-10-SP4-CD-x86_64-GM-
CD1.iso

Boot CD for x86_64 (64-bit) SLES 10 SP4 installations

SLES-10-SP4-DVD-i386-GM-
DVD1.iso

Install source for i386 (32-bit) SLES 10 SP4

SLES-10-SP4-DVD-x86_64-GM-
DVD1.iso

Install source for x86_64 (64-bit) SLES 10 SP4

OES2-SP3-i386-CD1.iso Install source for i386 (32-bit) OES 2 SP3 services

OES2-SP3-x86_64-CD1.iso Install source for x86_64 (64-bit) OES 2 SP3 services
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For the first SLES DVD you mount (either 32-bit or 64-bit), the name is SLES10SP_001, 
which is the actual volume name in the image file. For the second image you mount, the 
assigned name is CD_ followed by a four-digit number, starting with 0000. 

The same principle applies to the OES 2 SP3 image files. The first file mounted is the 
actual OES 2 SP3 volume name, but the second image is assigned a CD_xxxx name.

Knowing which volume is for which platform is critical as you create an access URL to 
the volume in Apache Manager. 

5 In a supported browser, start Apache Manager by entering the following URL:

https://server_ip_address:2200/apacheadmin/login.jsp

Replace server_ip_address with the IP address of the NetWare server.

6 Log in as the Admin user or a user with administrative rights to the Apache server.

7 Click the Content Manager  icon .

8 Click Additional Document Directories.

9 In the URL Prefix field, specify an alias name you want people to use to access one of the 
mounted volumes.

For example, if you are mounting the volume with the SLES 10 i386 installation files, you 
might name the alias, sles10sp1-i386. 

10 Click the Search icon next to the File Path field.

11 Click the volume name that matches the alias name you specified in Step 9, then click Finish.

For example, if CD_0001 is the volume name that NetWare assigned to ISO image of the SLES 
10 i386 installation source, you would click CD_0001.

12 Click Save > Save and Apply > OK.

The path to the volume is added as an additional document.

13 Repeat from Step 9 for the other three volumes.

All of the ISO files are now available for access through the Apache Web Server running on the 
NetWare server.

Create the Boot CDs

See Section 2.9, “Preparing Physical Media for a New Server Installation or an Upgrade,” on 
page 39.

2.10.3  Windows as a Network Installation Source Server

To prepare a network installation source on a Windows server, see “Managing an SMB Installation 
Source” (http://www.novell.com/documentation/sles10/book_sle_reference/data/
sec_deployment_remoteinst_instserver.html#sec_deployment_remoteinst_instserver_smb) in the 
SLES 10 SP4 Installation and Administration Guide (http://www.novell.com/documentation/sles10/
book_sle_reference/data/book_sle_reference.html).

2.11  Always Install OES as an Add-On Product
You must always install OES by adding it as an add-on product while running the YaST install. This 
is not the same as adding the OES installation media as an installation source. 
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Failure to do this will prevent the server from registering as an OES 2 server with the Novell 
Customer Center.

2.12  Install Only One Server at a Time
You should install one server at a time into a tree, then wait for the installation program to complete 
before installing an additional server into the same tree.

2.13  What's Next
Proceed to one of the following sections, depending on the task that you want to perform:

 “Installing OES 2 SP3 as a New Installation” on page 47

 “Upgrading to OES 2 SP3” on page 119

 “Updating (Patching) an OES 2 SP3 Server” on page 157

 “Using AutoYaST to Install and Configure Multiple OES Servers” on page 179

 “Installing, Upgrading, or Updating OES on a Xen-based VM” on page 189

 “Installing and Managing NetWare on a Xen-based VM” on page 203

 “Installing with EVMS as the Volume Manager of the System Device” on page 233
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3
3Installing OES 2 SP3 as a New 
Installation

Novell Open Enterprise Server (OES) 2 SP3 is an add-on product to SUSE Linux Enterprise Server 
(SLES) 10 SP4. When you install and configure OES, you can also install and configure SLES 10 
SP4. Therefore, it is helpful to understand how to perform a SLES 10 SP4 installation.

For detailed information on performing a SLES installation, see the SLES 10 SP4 Installation and 
Administration Guide (http://www.novell.com/documentation/sles10/book_sle_reference/data/
book_sle_reference.html).

This section does not provide step-by-step installation instructions because the installation interface 
is mostly self-explanatory. It does, however, provide information about important steps in the 
process that you might need help with.

 Section 3.1, “Starting the OES 2 SP3 Installation,” on page 47

 Section 3.2, “Specifying the Installation Mode,” on page 50

 Section 3.3, “Specifying the Add-On Product Installation Information,” on page 51

 Section 3.4, “Setting Up the Clock and Time Zone,” on page 52

 Section 3.5, “Specifying the Installation Settings for the SLES Base and OES Installation,” on 
page 52

 Section 3.6, “Specifying Configuration Information,” on page 59

 Section 3.7, “Finishing the Installation,” on page 110

 Section 3.8, “Verifying That the Installation Was Successful,” on page 110

 Section 3.9, “What's Next,” on page 112

3.1  Starting the OES 2 SP3 Installation
1 Insert the first disc of the SUSE Linux Enterprise Server 10 SP4 installation media that you 

created into the CD-ROM or DVD drive of the computer that you want to be your OES server

2 Boot the machine. 

3 Continue with one of the following procedures:

 “Installing from a Network Source with DHCP” on page 48

 “Installing from a Network Source without DHCP” on page 49

 “Installing from Physical Media” on page 47

3.1.1  Installing from Physical Media

1 From the CD boot menu, select the second option (Installation), then press Enter.

2 Select the language that you want to use, then click Next.

3 Read and accept the license agreement, then click Next.
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4 (Conditional) If you haven’t already verified that the media you burned is valid, you can check 
it by using the Media Check option; otherwise, click Next to continue with the installation.

The installation process prompts you for each CD at the appropriate time. The progress status 
at the bottom of the screen indicates which CD will be requested next.

5 Follow the prompts, using the information contained in the following sections:

5a “Specifying the Installation Mode” on page 50.

5b “Specifying the Add-On Product Installation Information” on page 51.

5c “Setting Up the Clock and Time Zone” on page 52.

5d “Specifying the Installation Settings for the SLES Base and OES Installation” on page 52.

5e “Specifying Configuration Information” on page 59.

5f “Finishing the Installation” on page 110.

6 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

3.1.2  Installing from a Network Source with DHCP

1 From the CD boot menu, select one of the following Installation options that matches your 
environment, but do not press Enter.

 Installation: The normal installation mode. All modern hardware functions are enabled.

 Installation—ACPI Disabled: If the normal installation fails, it might be because the 
system hardware does not support ACPI (advanced configuration and power interface). If 
this seems to be the case, use this option to install without ACPI support.

 Installation—Local APIC Disabled: If the normal installation fails, it might be because 
the system hardware does not support local APIC (advanced programmable interrupt 
controllers). If this seems to be the case, use this option to install without local APIC 
support.

If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.

 Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

At this point you can either

 Skip to with Step 4 and input everything as the install prompts you.

or

 Pre-specify the IP address information and/or the boot options parameters on the Boot 
Options line (see “Using Custom Boot Options” in the SUSE Linux Enterprise Server 
Installation and Administration Guide (http://www.novell.com/documentation/sles10/
book_sle_reference/data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom
)), 

2 (Optional) If you want to specify the IP address information, do it now. 

Otherwise, continue with Step 3.

3 (Optional) If you want to specify boot options parameters, do it now. Then press Enter and 
continue with Step 7.
 SP3: Installation Guide

http://www.novell.com/documentation/sles10/book_sle_reference/data/sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom
http://www.novell.com/documentation/sles10/book_sle_reference/data/sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom
http://www.novell.com/documentation/sles10/book_sle_reference/data/sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom


Otherwise, continue with Step 4.

4 Press F4, and then select the network installation type (SLP, FTP, HTTP, NFS, SMB/CIFS) that 
you set up on your network installation server.

See Step 2 on page 41 of the SUSE Linux as a Network Installation Source Server procedure.

5 Specify the required information (server name and installation path), then select OK.

6 Press Enter to begin the installation.

7 Follow the screen prompts, referring to the information in the following sections as needed 
(remember that not all required selections are documented):

7a “Specifying the Installation Mode” on page 50.

7b “Specifying the Add-On Product Installation Information” on page 51.

7c “Setting Up the Clock and Time Zone” on page 52.

7d “Specifying the Installation Settings for the SLES Base and OES Installation” on page 52.

7e “Specifying Configuration Information” on page 59.

7f “Finishing the Installation” on page 110.

8 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

3.1.3  Installing from a Network Source without DHCP

1 From the CD boot menu, select one of the following Installation options that matches your 
environment.

 Installation: The normal installation mode. All modern hardware functions are enabled.

 Installation—ACPI Disabled: If the normal installation fails, this might be because of 
the system hardware not supporting ACPI (advanced configuration and power interface). 
If this seems to be the case, use this option to install without ACPI support.

 Installation—Local APIC Disabled: If the normal installation fails, this might be 
because of the system hardware not supporting local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.

If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.

 Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

2 At this point you can pre-specify the IP address information, etc. on the Boot Options line (see 
“Using Custom Boot Options” in the SUSE Linux Enterprise Server Installation and 
Administration Guide (http://www.novell.com/documentation/sles10/book_sle_reference/data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom)), 

If you want to specify the IP address information, etc., do it now. Then press Enter and continue 
with Step 19 on page 50.

Otherwise, press Enter, continue with Step 3, and input everything as the install prompts you.

3 When you receive the following error, select OK and press Enter: 

Could not find the SUSE Linux Enterprise Server 10 Installation source. 
Activating manual set up program.
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4 Select the language, then select OK and press Enter.

5 Select a keyboard map, then select OK and press Enter.

6 Select Start Installation or System, then select OK and press Enter.

7 Select Start Installation or Update, then select OK and press Enter.

8 Select Network, press Enter, then select OK and press Enter.

9 Select the network protocol that matches the configured protocol on your network installation 
server, then press Enter.

10 (Conditional) If you have more than one network interface card, select one of the cards, then 
press Enter.

We recommend eth0.

11 When prompted whether you want to use DHCP, select No, then press Enter.

12 Specify the IP address for the server, then press Enter.

13 Specify the subnet mask, then press Enter.

14 Specify the gateway, then press Enter.

15 Specify the IP address of a name server, then press Enter.

16 Specify the IP address of the network installation server, then press Enter.

17 (Conditional) Depending on the protocol you specified, you might see additional screens for 
FTP or HTTP. Select the options that are appropriate for your network, then continue with 
Step 18.

18 Specify the path to your installation source on the network installation server, then press Enter.

19 Follow the prompts, using the information contained in the following sections:

19a “Specifying the Installation Mode” on page 50.

19b “Specifying the Add-On Product Installation Information” on page 51.

19c “Setting Up the Clock and Time Zone” on page 52.

19d “Specifying the Installation Settings for the SLES Base and OES Installation” on page 52.

19e “Specifying Configuration Information” on page 59.

19f “Finishing the Installation” on page 110.

20 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

3.2  Specifying the Installation Mode
1 When the Installation Mode page displays, select the following two menu options, then click 

Next:

 New Installation 
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 Include Add-On Products from Separate Media

2 Continue with Section 3.3, “Specifying the Add-On Product Installation Information,” on 
page 51.

3.3  Specifying the Add-On Product Installation 
Information

1 When the Add-On Product Installation page displays, click Add.

2 If you are installing OES 2 from a CD, do the following:

2a On the Add-On Product Media page, click CD, then click Next.

2b On the Insert the Add-On Product CD page, select the appropriate drive where you want to 
insert the OES CD.

2c Click Eject.

2d Insert the CD labeled Novell Open Enterprise Server 2 SP3 CD 1, then click Continue.

3 If you are using an alternate installation source, such as a network installation source, click the 
appropriate option for your situation, then click Next and supply the required information.

4 Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.

5 Confirm that the Add-On Product Installation page shows the correct path to the OES media, 
then click Next.

6 Continue with Section 3.4, “Setting Up the Clock and Time Zone,” on page 52.
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3.4  Setting Up the Clock and Time Zone
1 Make sure the Clock, Region, Timezone, and Time and Date settings are what you want, then 

click Next. 

You can configure this information after the installation is complete, but it is easier to do it 
during the installation.

2 Continue with Section 3.5, “Specifying the Installation Settings for the SLES Base and OES 
Installation,” on page 52.

3.5  Specifying the Installation Settings for the 
SLES Base and OES Installation
The Installation Settings page lets you specify which software and services are installed on your 
server.

 Overview tab: This lets you specify everything that is normally required for an OES 
installation. 

 Expert tab: This lets you fully customize your SLES installation settings. For detailed 
information, see “Deployment” (http://www.novell.com/documentation/sles10/
book_sle_reference/data/part_setup.html) in the SLES 10 SP4 Installation and Administration 
Guide (http://www.novell.com/documentation/sles10/book_sle_reference/data/
book_sle_reference.html). Keep in mind, however, that the SLES guide does not contain 
instructions for OES-specific components or configurations.

IMPORTANT: If you accept the defaults at this point in the installation process, only the base OES 
components are installed. 

You can add OES services later, but you should at least read the guidelines and follow the applicable 
procedures in the following sections:

 “Setting Up Disk Partitions” on page 52

 “Customizing the Software Selections” on page 56

 “Accepting the Installation Settings” on page 58

3.5.1  Setting Up Disk Partitions

In most cases, YaST proposes a reasonable partitioning scheme that can be accepted without change. 
You can also use YaST to customize the partitioning.

 “Guidelines” on page 53

 “NSS on the System Disk” on page 54

 “Security Flag Recommendations” on page 54

 “Partitioning X86 Machines” on page 55

 “Disk Partition Statistics” on page 55

 “Combining Hard Disk Partitions” on page 56
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Guidelines

Table 3-1 presents guidelines for setting up disk partitions on your OES server. For more 
information, see “Installation Settings” (http://www.novell.com/documentation/sles10/
book_sle_reference/data/sec_i_yast2_proposal.html) in the SLES 10 SP4 Installation and 
Administration Guide (http://www.novell.com/documentation/sles10/book_sle_reference/data/
book_sle_reference.html)

Table 3-1   Partition Guidelines

Partition 
to Create

Other Considerations

/boot Depending on the hardware, it might be useful to create a boot partition (/boot) to hold the 
boot mechanism and the Linux kernel. 

You should create this partition at the start of the disk and make it at least 8 MB or 1 cylinder. 
As a rule of thumb, always create such a partition if it was included in the YaST original 
proposal. If you are unsure about this, create a boot partition to be on the safe side.

IMPORTANT: In a Xen VM installation, format the /boot partition using Ext2 as the file 
system. For a technical explanation of why this is necessary, see “Paravirtual Mode and 
Journaling File Systems (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/sec_xen_filesystem.html)” in the Virtualization with Xen (http://
www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html) guide.

swap This should normally be twice the size of the RAM installed on your server, up to 1 GB. If you 
create a /boot partition, create the swap partition second. Otherwise, create the swap 
partition first.

/ Define this partition as 3 GB or more. In all cases, create this partition after you create the 
swap partition. Keep in mind that this root (/) partition contains all of the partitions listed below 
that you don’t specifically create.

/var This contains system logs and should therefore be a separate partition to avoid impacting 
system and service stability because of a disk-full condition.

Define this partition as 4 GB or more.

/opt Some (mostly commercial) programs install their data in /opt.

Define this partition as 4 GB or more.

/usr Creating this as a separate partition makes updating the server easier if you need to reinstall 
the system from the beginning because you can keep the partition intact.

Define this partition as 4 GB or more.

/srv This contains the Web and FTP servers.

Consider making this a separate partition to avoid having someone flood the disk by accident 
or on purpose, which impacts system and service stability.

/home User Home directories go here.

Consider making this a separate partition to avoid having someone flood the disk by accident 
or on purpose, which impacts system and service stability.

You can allocate the rest of the disk space to this partition.
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NSS on the System Disk

For OES, Novell Storage Services (NSS) volumes can be used only as data volumes, not as system 
volumes. 

Additionally, they cannot be created as part of the install process. 

However, you must consider whether you will be creating them in the future on the storage device 
where you are installing Linux. (Creating NSS volumes on storage devices that don’t contain Linux 
system partitions requires no special handling.)

The default volume manager for Linux POSIX volumes on SUSE Linux is LVM (Linux Volume 
Manager). However, NSS volumes cannot be created on devices managed by LVM; they require 
EVMS (Enterprise Volume Management System) instead. 

IMPORTANT: If you have only a single storage device on the server (such as a single physical disk 
or a hardware RAID 1 or RAID 5 device) and you plan to use NSS volumes for storing data, you 
must follow the instructions in “Installing with EVMS as the Volume Manager of the System 
Device” on page 233 to partition that storage device before proceeding.

You must also follow the EVMS setup instructions if you are creating Linux system partitions on 
other storage devices that you also want to contain NSS volumes.

Security Flag Recommendations

The following table indicates the recommended security flags for each partition. A question mark 
indicates that some software might not work if this flag is set.

/tmp Creating this as a separate partition is optional. However, because it is writable by everyone, 
best practices suggest creating a separate partition to avoid having someone flood the disk by 
accident or on purpose, which impacts system and service stability.

Place application-specific files on a separate partition.

If you are building a mail server, note where the mail spools reside because they can grow 
quite large, and you need to anticipate this when you are defining partition sizes.

Mount Point Mount Options

/

/var nosuid

/tmp nosuid

/home nosuid, nodev, noexec?

/srv nosuid?, nodev?, noexec?, ro? (after 
installation)

Partition 
to Create

Other Considerations
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Partitioning X86 Machines

 There can be a maximum of four primary partitions or three primary partitions and one 
extended partition. An extended partition can hold 15 (SCSI) or 63 (IDE) logical partitions.

 Each partition is assigned a partition type, depending on the file system planned for the 
partition.

 Each partition holds its own file system.

 Partitions are mounted into the file system tree at mount points. The content of the partition is 
visible to users with sufficient access privileges below the mount point.

 One of the partitions must hold the root (/) file system. Other partitions can be integrated into 
the root file system by using the mount command.

 The /etc/fstab file holds partition and mount point information to allow automatic mounting 
at boot time.

 Device files in the “device” (/dev) partition are used to represent and address partitions; for 
example:

Disk Partition Statistics

Use the following commands to get information about system storage usage:

/usr/local nosuid?, nodev?, ro? (after installation)

IMPORTANT: Proprietary software installations 
might fail if executables in /tmp cannot run as the 
file owner (suid), and devices might not work in /
usr/local, etc. In such cases, remount those 
partitions temporarily with security deactivated.

/dev/hda Master disk on the first IDE channel

/dev/hda1 First primary partition on the IDE channel disk disk

/dev/hda5 First logical partition within the extended partition on that disk

/dev/sdb Second SCSI disk

/dev/sdb3 Third primary partition on the second SCSI disk

df Displays information about partitions

df -h Displays information in megabytes or gigabytes as applicable (human readable 
format)

du Displays disk usage

du /dirA Displays the size of each file and directory in dirA

du -sh Prints a summary of information in megabytes or gigabytes

Mount Point Mount Options
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Combining Hard Disk Partitions

 Partitions from two or more hard disks can be combined by using the logical volume manager 
(LVM).

 Partitions (physical volumes) can be combined into a volume group, which in turn can be 
divided into logical volumes that contain their own file systems. 

Doing this increases flexibility because physical volumes can be easily added to the volume group if 
more storage space is needed. Logical volumes can be added while the machine is up and running.

3.5.2  Customizing the Software Selections

IMPORTANT: To install any of the OES patterns, you must customize the software selections. If 
you don’t make any selections, only the base SLES 10 and base OES packages are installed. 
However, you can install any of the patterns after the base SLES installation is complete. See 
“Installing or Configuring OES 2 SP3 on an Existing Server” on page 113.

To customize which software packages are installed on the server:

1 On the Installation Settings page, click Software.

The Open Enterprise Server add-on adds the OES Services category of patterns to the base 
software selection categories offered by the SLES 10 installation. OES Services include 
patterns that contain Novell services or products such as Novell DNS and DHCP services, 
iPrint, or iManager. 

None of the OES Services is selected by default. This lets you fully customize your OES server.

2 At this point, you can do the following to customize your software selections:

 Select OES Services: You can select any number of the OES Services patterns as long as 
you avoid unsupported service combinations (see “Unsupported Service Combinations” in 
the OES 2 SP3: Planning and Implementation Guide).
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A description of each pattern displays to the right of the pattern when it is selected. For a 
description of OES Services patterns and the components selected with each pattern, see 
Table 2-4 on page 31.

You can manually change the default SLES selections by changing the install status and 
selecting the patterns offered in each category.

IMPORTANT: If you deselect a pattern after selecting it, you are instructing the 
installation program to not install that pattern and all of it dependent patterns. Rather than 
deselecting a pattern, click Cancel to cancel your software selections, then click the 
Software heading again to choose your selections again.

Selecting only the patterns that you want to install ensures that the patterns and their 
dependent patterns and packages are installed.

If you click Accept, then return to software pattern selection page, the selections that you 
made become your base selections and must be deselected if you want to remove them 
from the installation proposal.

You must install at least one of the SLES Base Technologies patterns.

Selecting a pattern automatically selects the other patterns that it depends on to complete 
the installation.
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 Customize Your Selections:  You can view the details of your selection and add or 
remove specific packages for the installation by clicking Details.

3 When you have selected the software components that you want to install, click Accept.

4 If you are prompted with the license agreement for Professional TrueType Fonts, click Accept.

5 (Conditional) If the prompt for Automatic Changes displays, click Continue.

6 (Conditional) If prompted, resolve any dependency conflicts.

3.5.3  Accepting the Installation Settings

1 Review the final Installation Summary page to ensure that you have all the Installation settings 
you desire.

2 After you have changed all the Installation Settings as desired, click Accept. 

3 On the Confirm Installation page, click Install.

The base installation settings are applied and the packages are installed.

4 For installations using a network installation source, you can remove the network boot CD 
(SLES 10 SP4 CD 1) from the CD drive. 

or

For installations using a CD or DVD installation source, leave the CD or DVD in the CD-ROM 
or DVD drive.

5 After the server reboot, proceed with “Specifying Configuration Information” on page 59.
 SP3: Installation Guide



3.6  Specifying Configuration Information
When the server reboots, you are required to complete the following configuration information:

1. “Specifying the Password for the System Administrator “root”” on page 59

2. “Specifying Network Configuration Settings” on page 59

3. “Testing the Connection to the Internet” on page 62

4. “Specifying Novell Customer Center Configuration Settings” on page 63

5. “Updating the Server Software” on page 65

6. “Specifying Service Configuration Settings” on page 68

7. “Specifying LDAP Configuration Settings” on page 70

8. “Specifying eDirectory Configuration Settings” on page 72

9. “Configuring OES Services” on page 79

3.6.1  Specifying the Password for the System Administrator 
“root”

In the Password for the System Administrator root page:

1 Specify the password for the root administrator.

For security reasons, the root user’s password should be at least five characters long and 
should contain a mixture of both uppercase and lowercase letters and numbers. Passwords are 
case sensitive.

The default password length limit is 8 characters. The maximum possible length for passwords 
is 72 characters. If you have a password longer than eight characters, click Expert Options > 
Blowfish > OK.

2 Confirm the password.

3 Click Next.

3.6.2  Specifying the Hostname and Domain Name

On the Hostname and Domain Name page:

1 Specify the DNS hostname associated with the IP address you have or will assign to the server.

2 Specify the DNS domain name for the server.

3 Deselect Change Hostname via DHCP. 

4 Click Next.

3.6.3  Specifying Network Configuration Settings

On the Network Configuration page, you can change the configuration for the following, most of 
which do not apply in an OES server installation scenario:

 Network Mode

 Firewall
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 IPv6

 Network Interfaces

 DSL Connections

 ISDN Adapters

 Modems

 VNC Remote Administration

 Proxy

In this section, we give details only for the components that apply to OES servers.

 “Network Interface” on page 60

 “Firewall” on page 60

Network Interface

Configuration success is directly tied to specific networking configuration requirements. Make sure 
that the settings covered in the steps that follow are configured exactly as specified.

Specify the setting for each network board on the server:

1 On the Network Configuration page, click Network Interfaces.

2 On the Network Card Configuration Overview page, select the network card you want to 
configure, then click Edit.

3 Select Static Address Setup, then specify the IP address and the subnet mask for the interface.

OES requires a static IP address.

4 In the Detailed Settings list, select Hostname and Name Server.

4a In the Name Servers and Domain Search List panel, specify from one to three DNS server 
IP addresses.

4b Click OK to return to the Detailed Settings list.

5 In the Detailed Settings list, select Routing.

5a Specify the IP address of the default gateway on the subnet where you are installing the 
OES server.

5b Click OK to return to the Detailed Settings list.

6 Click Next to return to the Network Card Configuration Overview page.

7 Complete Step 2 through Step 6 for each network board, then click Next to return to the main 
Network Configuration page.

Firewall

For security reasons, a firewall is started automatically on each configured interface. The 
configuration proposal for the firewall is updated automatically every time the configuration of the 
interfaces or services is modified. 

Many of the OES services require an open port in the firewall. Table 3-2 shows the ports that are 
automatically opened when each listed OES service is configured.
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Table 3-2   Open Enterprise Server Services and Ports

Service Default Ports

Domain Services for Windows  1636

eDirectory  389 (LDAP)

 636 (secure LDAP)

IMPORTANT: The scripts that manage the common 
proxy user introduced in OES 2 SP3 require port 636 for 
secure LDAP communications.

 8028 (HTTP for iMonitor)

 8030 (secure HTTP for iMonitor)

 524 (NCP)

iManager  80 (HTTP)

 443 (secure HTTP)

iPrint  80 (HTTP)

 443 (secure HTTP)

 631 (IPP)

Novell AFP  548

Novell Archive and Version Services  26029

Novell CIFS  636 (secure LDAP)

IMPORTANT: The scripts that manage the common 
proxy user introduced in OES 2 SP3 require port 636 for 
secure LDAP communications.

Novell DHCP  67

Novell DNS  53 (HTTP)

 953 (secure HTTP)

Novell FTP  21

Novell Information Portal  80 (HTTP)

 443 (secure HTTP)

Novell NetWare Core Protocol (NCP)  524

Novell Remote Manager  8008 (HTTP)

 8009 (secure HTTP)

OpenWBEM  5988 (HTTP)

 5989 (secure HTTP)

QuickFinder  80 (HTTP)

 443 (secure HTTP)
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To adapt the automatic settings to your own preferences:

1 Click Change > Firewall. 

2 In the left panel, select the settings you want to change, then make the changes in the right 
panel.

3 When you are finished, click Accept.

For more information about the firewall, see Section 44.4.1, “Configuring the Firewall with YaST” 
in the SUSE Linux Enterprise Server Installation and Administration Guide (http://
www.novell.com/documentation/sles10/book_sle_reference/data/
sec_fire_suse.html#sec_fire_suse_yast).

To disable the firewall:

1 On the Network Configuration page, under Firewall, click enabled on the Firewall is enabled 
status line.

When the firewall is disabled, the status for Firewall should read Firewall is disabled. 

2 Verify that the settings on the Network Configuration page are set as desired, then click Next to 
save the configuration, then continue with “Testing the Connection to the Internet” on page 62.

3.6.4  Testing the Connection to the Internet

On the Test Internet Connection page:

1 Select Yes, Test Connection to the Internet, then click Next.

Obtaining the latest SUSE release notes might fail at this point. If it does, view the log to verify 
that the network configuration is correct, then, click Next.

If the network configuration is not correct, click Back > Back and fix your network 
configuration. See “Network Interface” on page 60.

IMPORTANT: Do not skip this test. For a successful install, you must configure the Novell 
Customer Center and update SLES 10 SP4 from the patch channel before configuring OES 
services. 

2 Continue with “Specifying Novell Customer Center Configuration Settings” on page 63. 

Samba  139 (Netbios)

 445 (Microsoft-ds)

Secure Shell  22

Storage Management Services (Backup)  40193 (smdr daemon)

UDP  524

Service Default Ports
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3.6.5  Specifying Novell Customer Center Configuration 
Settings

In contrast to OES 2 SP2, OES 2 SP3 requires that the SLES 10 SP4 base be updated prior to 
installing and configuring OES 2 SP3 services. If not, some OES services, such as Novell FTP, will 
not function properly after the installation and will need to be configured again after the SLES 
patches are applied.

Therefore, when you are entering the Novell Customer Center configuration information, it is 
critical that you enter either your purchased SLES 10 SP4 code or the 60-day evaluation code 
available with your SLES 10 SP4 download.

1 On the Novell Customer Center Configuration configuration page, select all of the following 
options, then click Next.

2 After you click Next, the following message is displayed. 

Wait until this message disappears and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields, then click Submit:

Option What it Does

Configure Now Proceeds with registering this server and the SLES 10 SP4 and OES 2 
SP3 product in the Novell Customer center.

Hardware Profile Sends the information to the Novell Customer Center about the hardware 
that you are installing SLES 10 SP4 and OES 2 SP3 on.

Optional Information Sends optional information to the Novell Customer Center for your 
registration. For this release, this option doesn’t send any additional 
information.

Registration Code Makes the registration with activation codes mandatory.

Regularly Synchronize 
with the Customer 
Center

Keeps the installation sources for this server valid. It does not remove any 
installation sources that were manually added.

Field Information to Specify

Email Address The e-mail address for your Novell Login account.

Confirm Email Address The same e-mail address for your Novell Login account
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5 When the message to complete the registration displays, click Continue.

6 After you click Continue, the following message is displayed with the Manual Interaction 
Required screen. 

Wait until this message disappears and Novell Customer Center Configuration page displays.

Activation Code for 
SLES Components 
(optional):

Specify your purchased or 60-day evaluation registration code for the 
SLES 10 product. 

If you don’t specify a code, the server cannot receive any updates or 
patches.

Activation Code for 
OES Components 
(optional):

Specify your purchased or 60-day evaluation registration code for the OES 
2 product. 

If you don’t specify a code, the server cannot receive any updates or 
patches.

System Name or 
Description (optional):

Specify a description to identify this server.

Field Information to Specify
 SP3: Installation Guide



7 When you see the message Your configuration was successful on the Novell Customer 
Center Configuration page, click OK.

8 Continue with “Updating the Server Software” on page 65.

3.6.6  Updating the Server Software

When you have a successful connection to the Internet and have registered the server in the Novell 
Customer Center, the server displays the Online Update page. You must run the online update now 
for a successful OES installation.

1 On the Online Updates page, click Run Update > Next.

2 On the page that shows that updates are available, click Accept. 

The check marks that are shown on the summary portion of the page are patches that have 
already been installed on your system.
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3 When you see the following message, click Accept.
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4 When you see the following message, click Next.
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5 In the pop-up that informs you about the kernel update, click OK.

The system reboots before continuing the installation.

6 Continue with “Specifying Service Configuration Settings” on page 68.

3.6.7  Specifying Service Configuration Settings

Because the server was rebooted during the installation, the default settings for CA management lost 
the root password as indicated by the red text under CA Management.

1 Reset the password for root.
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1a On the Installation Settings page, click the CA Management link.

1b On the Managing CA and Certificates page, click Edit Default Settings.

1c On the Edit Default Settings page, specify the password for root in the Password and 
Confirm Password fields, then click Next.

The Installation Settings page reappears with no red text.

2 Observe the settings on the Installation Settings page.

 CA Management: This indicates the certificate that is used by the Apache Web server if 
another certificate is not specified. 

By default, OES creates and installs a replacement eDirectory certificate later in the 
installation process. We recommend that you accept the eDirectory certificate option 
because it is much more secure than the certificate that is proposed. 

Alternatively, you can install a third-party certificate. 

In all cases, do not disable the configuration at this point because the services that use 
Apache will not work if you do. 

For more information about OES certificate management, see “Certificate Management” 
in the OES 2 SP3: Planning and Implementation Guide.

 OpenLDAP Server: Do not enable this option. On OES servers, Novell eDirectory 
LDAP server replaces the SLES 10 OpenLDAP server.

3 If you are not installing a third-party certificate, click Next.

or
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If you are installing a third-party certificate, click CA Management and refer to the information 
about Certificate Authority Management on SLES, see in the “Managing X.509 Certification” 
in the SUSE LINUX Enterprise Server 10 Installation and Administration Guide (http://
www.novell.com/documentation/sles10/book_sle_reference/data/cha_yast_ca.html). Then 
return to these instructions to continue your OES installation.

4 If you did not select the Novell eDirectory pattern for this server, continue with “Specifying 
LDAP Configuration Settings” on page 70.

Otherwise, skip the next section and continue with “Specifying eDirectory Configuration 
Settings” on page 72.

3.6.8  Specifying LDAP Configuration Settings

Many of the OES services require eDirectory. If eDirectory was not selected as a product to install 
on this server but other OES services that do require LDAP services were installed, the LDAP 
Configuration service displays, so that you can complete the required information.

To specify the required information on the Configured LDAP Server page:

1 In the eDirectory Tree Name field, specify the name for the existing eDirectory tree that you are 
installing this server into.

2 In the Admin Name and Context field, specify the name and context for user Admin in the 
existing tree.

3 In the Admin Password Name field, specify a password for user for user Admin in the existing 
tree.

4 Add the LDAP servers that you want the services on this server to use. The servers that you add 
should hold the master or a read/write replica of eDirectory. Do the following for each server 
you want to add:

4a Click Add.

4b On the next page, specify the following information for the server to add, then click Add.

 IP address
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 LDAP port and secure LDAP port

5 When all the LDAP servers that you want to specify are listed, click Next.

6 Verify that the Novell Open Enterprise Server Configuration page displays the settings that you 
expected, then click Next.
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7 Continue with “Configuring OES Services” on page 79.

3.6.9  Specifying eDirectory Configuration Settings

When you specify the eDirectory configuration settings, you can specify information to create a new 
tree and install the server in that new tree or you can install the server into an existing tree by 
specifying the information for it. Use the following instructions as applicable:

 “Creating a New eDirectory Tree and Installing the Server in It” on page 72

 “Installing the Server into an Existing eDirectory Tree” on page 73

 “Specifying Synchronizing Server Time Options” on page 75

 “Specifying SLP Configuration Options” on page 75

 “Selecting the Novell Modular Authentication Services (NMAS) Login Method” on page 76

 “Specifying OES Common Proxy User Information” on page 77

Creating a New eDirectory Tree and Installing the Server in It

1 On the eDirectory Configuration - New or Existing Tree page, select New Tree.

2 In the eDirectory Tree Name field, specify a name for the eDirectory tree that you want to 
create.

On OES servers, services that provide HTTPS connectivity are configured to use one of the 
following certificates: 

 An eDirectory certificate issued by the Novell International Cryptographic Infrastructure 
(NICI),
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 A third-party server certificate,

 The YaST self-signed common server certificate created in Step 2 on page 69. 

Self-signed certificates provide minimal security and limited trust. Unless you have 
invested in a third-party certificate, we recommend that you use the eDirectory certificates 
instead.

By default, the Use eDirectory Certificates for HTTPS Services check box is selected. This 
means that the existing server certificate and key files (YaST or third-party) will be replaced 
with eDirectory server certificate and key files.

The default YaST server certificate and key files are:

 Key file: /etc/ssl/servercerts/serverkey.pem

 Certificate file: /etc/ssl/servercerts/servercert.pem

 The eDirectory server certificate and key files are:

 Key file: /etc/ssl/servercerts/eDirkey.pem

 Certificate file: /etc/ssl/servercerts/eDircert.pem

For more information on certificate management, see “Certificate Management” in the OES 2 
SP3: Planning and Implementation Guide.

3 On the eDirectory Configuration - New Tree Information page, specify the required 
information:

 The fully distinguished name and context for the user Admin on the existing server

 The password for user Admin on the existing server.

4 Click Next. 

5 On the eDirectory Configuration - Local Server Configuration page, specify the following 
information:

 The context for the server object in the eDirectory tree.

 A location for the eDirectory database. 

The default path is /var/opt/novell/eDirectory/data/dib, but you can use this 
option to change the location if you expect to have a large number of objects in your tree 
and if the current file system does not have sufficient space.

 The ports to use for servicing LDAP requests.

The default ports are 389 (non-secure) and 636 (secure).

IMPORTANT: The scripts that manage the common proxy user introduced in OES 2 SP3 
require port 636 for secure LDAP communications.

 The ports to use for providing access to the iMonitor application.

The default ports are 8028 (non-secure) and 8030 (secure).

6 Click Next and continue with “Specifying Synchronizing Server Time Options” on page 75.

Installing the Server into an Existing eDirectory Tree

1 On the eDirectory Configuration - New or Existing Tree page, select Existing Tree.

2 In the eDirectory Tree Name field, specify a name for the eDirectory tree you want to join.
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On OES servers, services that provide HTTPS connectivity are configured to use either of the 
following: 

 An eDirectory certificate issued by the Novell International Cryptographic Infrastructure 
(NICI)

 The YaST self-signed common server certificate created in Step 2 on page 69. 

Self-signed certificates provide minimal security and limited trust, we recommend that 
you use the eDirectory certificates instead.

By default, the Use eDirectory Certificates for HTTPS Services check box is selected. This 
means that the existing YaST server certificate and key files will be replaced with eDirectory 
server certificate and key files.

The default YaST server certificate and key files are:

 Key file: /etc/ssl/servercerts/serverkey.pem

 Certificate file: /etc/ssl/servercerts/servercert.pem

 The eDirectory server certificate and key files are:

 Key file: /etc/ssl/servercerts/eDirkey.pem

 Certificate file: /etc/ssl/servercerts/eDircert.pem

For more information on certificate management, see “Certificate Management” in the OES 2 
SP3: Planning and Implementation Guide.

3 On the eDirectory Configuration - Existing Tree Information page, specify the required 
information:

 The IP address of an existing eDirectory server with a replica

 The NCP port on the existing server

 The LDAP and secure LDAP port on the existing server.

 The fully distinguished name and context for the user Admin on the existing server

 The password for user Admin on the existing server.

4 Click Next. 

5 On the eDirectory Configuration - Local Server Configuration page, specify the following 
information:

 The context for the server object in the eDirectory tree.

 A location for the eDirectory database. 

The default path is /var/opt/novell/eDirectory/data/dib, but you can use this 
option to change the location if you expect to have a large number of objects in your tree  
and if the current file system does not have sufficient space.

 The ports to use for servicing LDAP requests.

The default ports are 389 (non-secure) and 636 (secure).

IMPORTANT: The scripts that manage the common proxy user introduced in OES 2 SP3 
require port 636 for secure LDAP communications.

 The ports to use for providing access to the iMonitor application.

The default ports are 8028 (non-secure) and 8030 (secure).

6 Click Next and continue with “Specifying Synchronizing Server Time Options” on page 75.
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Specifying Synchronizing Server Time Options

eDirectory requires that all OES and NetWare servers are time-synchronized. 

1 On the eDirectory Configuration - NTP & SLP page, in the Network Time Protocol (NTP) 
Server field, specify the IP address or DNS hostname of an NTP server. 

For the first server in a tree, we recommend specifying a reliable external time source.

When you install multiple servers into the same eDirectory tree, make sure that all servers point 
to the same time source and not to the server holding the master replica.

For servers joining a tree, specify the same external NTP time source that the tree is using, or 
specify the IP address of a configured time source in the tree. A time source in the tree should 
be running time services for 15 minutes or more before connecting to it, or the time 
synchronization request for the installation fails.

If the time source server is NetWare 5.0 or earlier, you must specify an alternate NTP time 
source, or the time synchronization request fails.

2 If you want to use the server’s hardware clock, select Use Local Clock.

For servers joining a tree, the installation does not let you proceed if you select this option. You 
must specify the same external NTP time source that the tree is using, or specify the IP address 
of a configured time source in the tree that has been running time services for 15 minutes or 
more.

3 Continue with “Specifying SLP Configuration Options” on page 75.

For more information on time synchronization, see Implementing Time Synchronization in the OES 
2 SP3: Planning and Implementation Guide.

Specifying SLP Configuration Options

1 On the eDirectory Configuration - NTP & SLP page, specify the SLP options as desired.

You have the following options for configuring SLP:

 Do Not Configure SLP: This option is good for eDirectory trees with three or fewer 
eDirectory servers.

Without SLP, users can’t see a tree list, but they should still be able to attach to a tree by 
name. Users can configure the Novell Client to use DNS, or they can configure the local 
host file (%SystemDrive%\windows\system32\drivers\etc\hosts on WinXP) to 
resolve tree and server names. Users can also specify preferred tree and context 
information in the DHCP Settings page of the Novell Client.

 Use Multicast to Access SLP: This option allows the server to request SLP information 
by using multicast packets. Use this in environments that have not established SLP DAs 
(Directory Agents).

IMPORTANT: If you select this option, you must disable the firewall for SLP to work 
correctly. Multicast creates a significant amount of network traffic and can reduce network 
throughput.

 Configure SLP to use an existing Directory Agent: This option configures SLP to use 
an existing Directory Agent (DA) in your network. Use this in environments that have 
established SLP DAs. When you select this option, you configure the servers to use by 
adding or removing them from the SLP Directory Agent list.
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 Configure as Directory Agent: This option configures this server as a Directory Agent 
(DA). This is useful if you plan to have more than three servers in the tree and want to set 
up SLP during the installation.

 DASyncReg: This option causes SLP, when it starts, to query the Directory Agents 
listed under Configured SLP Directory Agents for their current lists of registered 
services. It also causes the DA to share service registrations that it receives with the 
other DAs in the SLP Directory Agent list.

 Backup SLP Registrations: This option causes SLP to back up the list of services 
that are registered with this Directory Agent on the local disk.

 Backup Interval in Seconds: This specifies how often the list of registered services 
is backed up.

 Service Location Protocols and Scope: This option configures the scopes that a user 
agent (UA) or service agent (SA) is allowed when making requests or when registering 
services, or specifies the scopes a directory agent (DA) must support. The default value is 
DEFAULT. Use commas to separate each scope. For example, net.slp.useScopes = 
myScope1,myScope2,myScope3.

 Configured SLP Directory Agents: This option lets you manage the list of hostname or 
IP addresses of one or more external servers on which an SLP Directory Agent is running.

2 Click Next and confirm your selection if necessary, then continue with Selecting the Novell 
Modular Authentication Services (NMAS) Login Method.

Selecting the Novell Modular Authentication Services (NMAS) Login Method

1 On the Novell Modular Authentication Services page, select all the login methods you want to 
install.

IMPORTANT: The NMAS client software must be installed on each client workstation where 
you want to use the NMAS login methods. The NMAS client software is included with the 
Novell Client software.

The following methods are available:

 CertMutual: The Certificate Mutual login method implements the Simple Authentication 
and Security Layer (SASL) EXTERNAL mechanism, which uses SSL certificates to 
provide client authentication to eDirectory through LDAP.

 Challenge Response: The Challenge-Response login method works with the Identity 
Manager password self-service process. This method allows either an administrator or a 
user to define a password challenge question and a response, which are saved in the 
password policy. Then, when users forget their passwords, they can reset their own 
passwords by providing the correct response to the challenge question.

 DIGEST-MD5: The Digest MD5 login method implements the Simple Authentication 
and Security Layer (SASL) DIGEST-MD5 mechanism as a means of authenticating the 
user to eDirectory through LDAP.

 NDS: The NDS login method provides secure password challenge-response user 
authentication to eDirectory. This method is installed by default and supports the 
traditional NDS password when the NMAS client is in use. Reinstallation is necessary 
only if the NDS login method object has been removed from the directory.
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 Simple Password: The Simple Password NMAS login method provides password 
authentication to eDirectory. The Simple Password is a more flexible but less secure 
alternative to the NDS password. Simple Passwords are stored in a secret store on the user 
object.

 SASL GSSAPI: The SASL GSSAPI login method implements the Generic Security 
Services Application Program Interface (GSSAPI) authentication. It uses the Simple 
Authentication and Security Layer (SASL), which enables users to authenticate to 
eDirectory through LDAP by using a Kerberos ticket.

For more information about installing and configuring eDirectory, see “Installing or Upgrading 
Novell eDirectory on Linux in Novell eDirectory 8.8 Installation Guide.

For more information on these login methods, see the online help and “Managing Login and 
Post-Login Methods and Sequences” in the Novell Modular Authentication Services 3.3.1 
Administration Guide.

2 Click Next, then continue with “Specifying OES Common Proxy User Information” on 
page 77.

Specifying OES Common Proxy User Information

For information about this option introduced with OES 2 SP3, see “Common Proxy User - New in 
SP3” in the OES 2 SP3: Planning and Implementation Guide.

1 On the OES Common Proxy User Information page, specify the configuration settings for this 
user.
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 Use Common Proxy User as Default for OES Products:  Selecting this option 
configures the specified common proxy user for the following services: CIFS, DNS, 
DHCP, iFolder, NetStorage, and NCS. Optionally, you can specify that LUM uses it. 

 OES Common Proxy User Name:  By default, the common proxy user’s name is 
OESCommonProxy_hostname, but you can specify any name that fits your naming 
methodology. For more information, see “Can I Change the Common Proxy User Name 
and Context?” in the OES 2 SP3: Planning and Implementation Guide.

IMPORTANT: Do not change the context of the common proxy user object until you 
read and understand the information in “New Container Creation Not Possible During a 
New Install” in the OES 2 SP3 Readme.

 OES Common Proxy User Password: You can accept the default system-generated 
password or specify a new password for the common proxy user. 

IMPORTANT: Unless you have specific requirements to know the password of this 
system user, we recommend that you leverage the automatic password functionality that is 
newly introduced in SP3.

 Verify OES Common Proxy User Password: If you specified a different password, type 
the same password in this field. Otherwise, the system-generated is automatically 
included.
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 Assign Common Proxy Password Policy to Proxy User: The initial common proxy 
password policy is a simple password policy created with default rules. If desired, you can 
modify this policy after the installation to enforce stricter rules regarding password length, 
characters supported, expiration intervals, etc.

2 Continue with “Configuring OES Services” on page 79.

3.6.10  Configuring OES Services

After you complete the LDAP configuration or the eDirectory configuration, the Novell Open 
Enterprise Server Configuration summary page is displayed, showing all the OES components you 
installed and their configuration settings. 

1 Review the setting for each component and click the component heading to change any 
settings. 

For help with specifying the configuration information for OES services, see the information in 
“Configuration Guidelines for OES Services” on page 80.

2 When you are satisfied with the settings for each component, click Next.

3 When you confirm the OES component configurations, you might receive the following error:

The proposal contains an error that must be resolved before continuing.

If this error is displayed, check the summary list of configured products for any messages 
immediately below each product heading. These messages indicate products or services that 
need to be configured. If you are running the YaST graphical interface, the messages are red 
text. If you are using  the YaST text-based interface, they are not red.

For example, if you selected Linux User Management in connection with other OES products 
or services, you might see a message similar to the following:

Linux User Management needs to be configured before you can continue or 
disable the configuration.

If you see a message like this, do the following:

3a On the summary page, click the heading for the component.

3b Supply the missing information in each configuration page.

When you specify the configuration information for OES services, see the information in 
“Configuration Guidelines for OES Services” on page 80; or, if you are reading online, 
click a link below:

 AFP

 Archive andVersion Servies

 Backup/Storage Management Services (SMS)

 CIFS

 Clustering (NCS)

 DHCP

 DNS

 Domain Servies for Windows (DSfW)

 eDirectory

 FTP
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 iFolder

 iManager

 iPrint

 Linux User Mangement (LUM)

 NCP Server/Dynamic Storage Technology

 NetStorage

 Pre-Migration Server

 QuickFinder

 Novell Remote Manger (NRM)

 Novell Samba

 Novell Storage Services

When you have finished the configuration of a component, you are returned to the Novell 
Open Enterprise Server Configuration summary page.

3c If you want to skip the configuration of a specific component and configure it later, click 
Enabled in the Configuration is enabled status to change the status to Configuration is 
disabled. 

If you change the status to Configuration is disabled, you need to configure the OES 
components after the installation is complete. See “Installing or Configuring OES 2 SP3 
on an Existing Server” on page 113.

4 After resolving all product configuration problems, click Next to proceed with the 
configuration of all components.

5 When the configuration is complete, continue with Section 3.7, “Finishing the Installation,” on 
page 110.

3.6.11  Configuration Guidelines for OES Services

 “Service Configuration Caveats” on page 81

 “LDAP Configuration for Open Enterprise Services” on page 82

 “Novell AFP Services” on page 83

 “Novell Archive and Version Services” on page 83

 “Novell Backup/Storage Management Services (SMS)” on page 84

 “Novell CIFS for Linux” on page 84

 “Novell Cluster Services” on page 86

 “Novell DHCP Services” on page 87

 “Novell DNS Services” on page 90

 “Novell Domain Services for Windows” on page 92

 “Novell eDirectory Services” on page 92

 “Novell FTP Services” on page 98

 “Novell iFolder” on page 98

 “Novell iManager” on page 103

 “Novell iPrint” on page 104
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 “Novell Linux User Management” on page 104

 “Novell NCP Server / Dynamic Storage Technology” on page 106

 “Novell NetStorage” on page 107

 “Novell Pre-Migration Server” on page 107

 “Novell QuickFinder” on page 107

 “Novell Remote Manager” on page 108

 “Novell Samba” on page 108

 “Novell Storage Services (NSS)” on page 109

Service Configuration Caveats

Keep the following items in mind as you configure the OES 2 SP3:

Table 3-3   Caveats for Configuring OES Services

Issue Guideline

Software 
Selections When 
Using Text-Based 
YaST

Some older machines, such as a Dell 1300, use the text mode install by default 
when the video card does not meet SLES 10 specifications. When you go to the 
Software Selection, and then to the details of the OES software selections, YaST 
doesn’t bring up the OES selections like it does when you use the graphical YaST 
(YaST2). 

To view the Software Selection and System Task screen, select Filter > Pattern (or 
press Alt+F > Alt+I).

Specifying a State 
identifier for a 
Locality Class 
object

If you to specify a state identifier, such as California, Utah, or Karnataka, as a 
Locality Class object in your eDirectory tree hierarchy, you must make sure to use 
the correct abbreviation in your LDAP (comma-delimited) or NDAP (period-
delimited) syntax.

When using LDAP syntax, use “st” to specify a state. For example:

ou=example_organization,o=example_company,st=utah,c=us

When using NDAP syntax, use “s” to specify a state. For example:

ou=example_organization.o=example_company.s=utah.c=us

Specifying Typeful 
Admin Names

When you install OES, you must specify a fully distinguished admin name by using 
the typeful, LDAP syntax that includes object type abbreviations (cn=, ou=, o=, 
etc.). For example, you might specify the following:

cn=admin,ou=example_organization,o=example_company
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LDAP Configuration for Open Enterprise Services

Table 3-4   LDAP Configuration for Open Enterprise Services Values

Using Dot-
Delimited or 
Comma-Delimited 
Input for All 
Products

For all parameters requiring full contexts, you can separate the names by using 
comma-delimited syntax; you must be consistent in your usage within the field.

The OES installation routine displays all input in the comma-delimited (LDAP) 
format. However, it converts the name separators to dots when this is required by 
individual product components.

IMPORTANT: After the OES components are installed, be sure to follow the 
conventions specified in the documentation for each product. Some contexts must 
be specified using periods (.) and others using commas (,). However, eDirectory 
supports names like cn=juan\.garcia.ou=users.o=novell. The period (.) inside a 
name component must be escaped.

When using NDAP format (dot), you must escape all embedded dots. For 
example:cn=admin.o=novell\.provo

When using LDAP format (commas), you must escape all embedded commas. For 
example:cn=admin,o=novell\,provo

The installation disallows a backslash and period (\.) in the CN portion of the admin 
name. 

For example, these names are supported:

cn=admin.o=novell
cn=admin.o=novell\.provo
cn=admin.ou=deployment\.linux.o=novell\.provo

These names are not supported:

cn=admin\.first.o=novell
cn=admin\.root.o=novell

Before LUM-enabling users whose cn contains a period (.), you must remove the 
backslash (\) from the unique_id field of the User object container.

For example, cn=juan.garcia has a unique_id attribute = juan\.garcia. Before such a 
user can be LUM-enabled, the backslash (\) must be removed from the unique_id 
attribute.

Page and Parameters

Configured LDAP Servers 

 eDirectory Tree Name: The eDirectory tree name that you specified when configuring 
eDirectory. The tree you are installing this server into.

 Admin Name and Context: The eDirectory Admin name you specified when configuring 
eDirectory.

 Admin Password: The password of the eDirectory Admin user. 

Issue Guideline
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Novell AFP Services

Table 3-5   Novell Apple Filing Protocol Parameters and Values

For additional configuration instructions, see “Installing and Setting Up AFP” in the OES 2 SP3: 
Novell AFP For Linux Administration Guide.

Novell Archive and Version Services

Table 3-6   Novell Archive and Version Services Parameters and Values

 Configured LDAP Servers: You can specify a list of servers that can be used to configure 
other OES services on this server. 

Each added server must have either the master or a read/write replica of the eDirectory tree. 
The first server added to the list becomes the default server for the installed and configured 
OES services to use.

For each server you must specify an IP Address, LDAP Port, Secure LDAP Port, and Server 
Type.

For information about specifying multiple LDAP servers for Linux User Management (LUM), 
see “Configuring a Failover Mechanism” in the OES 2 SP3: Novell Linux User Management 
Administration Guide.

Default: The eDirectory server you specified when configuring eDirectory.

Page and Parameters

AFP Configuration - Mac Client Access to NSS Volumes 

 eDirectory Contexts: Specify the FQDN of the eDirectory containers that contain AFP 
users, for example ou=afp_users.o=novell.

Page and Parameters

Archive and Version Services Configuration 

 Database Port Number: Specify a port number to use for the archive database 
communications.

Default: 5432

 Database Username: Specify a username for the administrator of the archive database 
(the PostgreSQL database for the archived data). 

IMPORTANT: The Postgres user must be an unprivileged user, not the root user.

Default: arkuser

 Database Password: Specify and validate a password for the database user. 

Default:  The password for the eDirectory Admin user.

Page and Parameters
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For additional configuration instructions, see “Setting Up Archive and Version Services ” in the OES 
2 SP3: Novell Archive and Version Services 2.1 Administration Guide.

Novell Backup/Storage Management Services (SMS)

Table 3-7   Novell Backup/Storage Management Services Parameters and Values

For additional configuration instructions, see “Installing and Configuring SMS” in the Installing and 
Configuring SMS.

Novell CIFS for Linux

Table 3-8   Novell CIFS Parameters and Values

Page and Parameters

SMS Configuration 

 Directory Server Address: If you do not want to use the default shown, select a different 
LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services dialog box.

Default: The first server selected in the LDAP Configuration list of servers.

Page and Parameters

Novell CIFS Service Configuration 

 eDirectory server address or host name: Leave the default or select from the drop-down 
list to change to a different server. 

 LDAP port for CIFS Server: Displays the port value.

 Local NCP Server context: Displays the NCP Server context.
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For additional configuration instructions, see “Installing and Setting Up CIFS” in the OES 2 SP3: 
Novell CIFS for Linux Administration Guide and the OES 2 SP3: Novell AFP For Linux 
Administration Guide

 CIFS Proxy User 

 Use existing user as CIFS Proxy User: Select this option to use an existing proxy 
user for the CIFS service.

If you specified the server’s common proxy user, this option is selected. 

 Create a new CIFS Proxy User: Select this option to create a new proxy user for the 
CIFS service.

 CIFS Proxy User Name: Specify the FQDN (fully qualified distinguished name) of the 
CIFS proxy user. 

For example: cn=user, o=novell

NOTE: This user is granted rights to read the passwords of any users, including non-
CIFS users, that are governed by any of the password policies you select in the Novell 
CIFS Service Configuration page.

 CIFS Proxy User Password: Specify a password for the CIFS proxy user to use when 
authenticating to the CIFS server, and verify the password if you are specifying an 
existing proxy user.

For more information on proxy user and password management, see “Planning Your 
Proxy Users” in the OES 2 SP3: Planning and Implementation Guide.

 Credential Storage Location: Accept CASA or specify the Local File option. 

The CIFS proxy user password is encrypted and encoded in the credential storage location.

Default: CASA

Novell CIFS Service Configuration (2) 

 eDirectory Contexts: Provide a list of contexts that are searched when the CIFS User 
enters a username. The server searches each context in the list until it finds the correct user 
object.

Novell CIFS Service Configuration (3) 

 Select the Password Policies Assigned to CIFS Users: The specified CIFS Proxy User 
is granted rights to read the passwords of all users assigned to the password policies you 
select.

If you are installing in a new tree, the list is blank. The install creates a policy named CIFS 
Default Policy for you.

For more information about proxy users and password policies, see “System User and 
Group Management in OES 2 SP3” and “Coordinating Password Policies Among Multiple 
File Services” in the OES 2 SP3: Planning and Implementation Guide.

Page and Parameters
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Novell Cluster Services

Table 3-9   Novell Cluster Services Parameters and Values

Page and Parameters

Novell Cluster Services (NCS) Configuration 

 New or Existing Cluster: Specify whether the server is part of a new cluster or is joining an 
existing cluster. 

Default: New Cluster

 Directory Server Address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services dialog box.

Default: The first server selected in the LDAP Configuration list of servers.

 Cluster FDN: Specify or browse to the fully distinguished name (FDN) of the cluster. Use the 
comma format illustrated in the example. Do not use dots.

If you are creating a new cluster, this is the name of the new cluster and the eDirectory 
context where the new cluster object will reside. You must specify an existing context. 
Specifying a new context does not create a new context.

If you are adding a server to an existing cluster, this is the name and eDirectory context of 
the cluster that you are adding this server to.

Cluster names must be unique. You cannot create two clusters with the same name in the 
same eDirectory tree. Cluster names are case sensitive on Linux.

 Cluster IP Address: If you are creating a new cluster, specify a unique IP address for the 
cluster.

The cluster IP address is separate from the server IP address and is required to be on the 
same IP subnet as the other servers in the cluster.

 Storage Device With Shared Media: If you are creating a new cluster, select the device 
where the Split Brain Detector (SBD) partition will be created.

If you have a shared disk system attached to your cluster servers, Novell Cluster Services 
creates a small cluster partition on that shared disk system. This small cluster partition is 
referred to as the Split Brain Detector (SBD) partition. Specify the drive or device where you 
want the small cluster partition created.

You must have at least 20 MB of free space on one of the shared disk drives to create the 
cluster partition. If no free space is available, the shared disk drives cannot be used by Novell 
Cluster Services.

If you do not have a shared disk system connected to your cluster servers, accept the default 
(none). You must create the SBD manually before adding a second server to the cluster.

Default: none
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For additional instructions, see the OES 2 SP3: Novell Cluster Services 1.8.8 Administration Guide 
for Linux.

Novell DHCP Services

Table 3-10   Novell DHCP Services Parameters and Values

 Optional Device for Mirrored Partitions: If you want to mirror the SBD partition for greater 
fault tolerance, select the device where you want the mirror to be.

You can also mirror SBD partitions after installing Novell Cluster Services.

Novell Cluster Services (NCS) Configuration (2) 

 IP Address of this Node: This field contains the IP address of this node. If this server has 
multiple IP addresses, you can change the default address to another value if desired.

 Start Cluster Services Now: Select this box if you want clustering to start now. If you want 
clustering to start after rebooting, or if you want to manually start it later, deselect this box.

This option applies only to installing Novell Cluster Services after the OES installation 
because it starts automatically when the server initializes during the installation. 

If you choose to not start Novell Cluster Services software, you need to either manually start 
it after the installation, or reboot the cluster server to automatically start it.

You can manually start Novell Cluster Services by going to the /etc/init.d directory and 
entering ./novell-ncs start at the server console of the cluster server.

Default: Selected

Proxy User Configuration 

Specify one of the following users as the NCS Proxy user.

 OES Common Proxy User: If the OES common proxy User is enabled in eDirectory, the 
Use OES Common Proxy User check box is automatically selected and the NCS Proxy User 
Name and Specify NCS Proxy User Password fields are populated with the credentials of the 
OES common proxy User.

 LDAP Admin User: If the OES common proxy User is disabled in eDirectory, the Use OES 
Common Proxy User check box is automatically deselected and the NCS Proxy User Name 
and Specify NCS Proxy User Password fields are populated with the credentials of the LDAP 
Admin user. The fields are also automatically populated with the LDAP Admin credentials if 
you deselect the Use OES Common Proxy User check box.

 Another Administrator User: Deselect the Use OES Common Proxy User check box, then 
specify the credentials of an administrator user.

Page and Parameters

Novell DHCP Services Configuration 

 DHCP Server Context: Specify a context for the DHCP Server object.

Default: o=example

Page and Parameters
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 DHCP Server Object Name: Specify the name of the Server object that these DHCP 
services will be running on.

This is the DHCP server object that contains a list of DHCP Services (configuration) served 
by the DHCP Server.

Default: DHCP_example_server

 Common DHCP Configuration Object Contexts 

 DHCP Locator Object: Specify the context for the DHCP Locator object.

The DHCP Locator object has references to dhcpServer and dhcpService objects.

 Group Context: Specify the context for the DHCP Group object.

This object is used to grant the necessary rights to the eDirectory user used by the 
DHCP server to access the DHCP objects.

Default: o=example

 Log File Location: Specify the path and filename for the DHCP Services log file. You can 
type the path manually or click Browse to locate the log. 

Default: Usually /var/log/

 LDAP Method 

 Static: Select this option if you do not want the DHCP server to query the LDAP server 
for host details.

 Dynamic: Select this option if you want the DHCP server to query the LDAP server on 
every request for host details.

Selecting the dynamic LDAP method ensures that the responses you receive to queries 
are accurate, but the server takes a longer time to respond.

Default: Static

 Referrals 

A referral is a message that the LDAP server sends to the LDAP client informing it that the 
server cannot provide complete results and that more data might be on another LDAP server.

 Chase Referral: Select this option if you want the DHCP server to follow referrals. 

 Do Not Chase Referral: Select this option to ignore LDAP referrals.

Novell DHCP LDAP and Secure Channel Configuration 

 eDirectory Server Address or Host Name: The IP address shown is the default LDAP 
server for this service. If you do not want to use the default, select a different LDAP server in 
the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services dialog box.

Default: The first server selected in the LDAP Configuration list of servers.
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 Use Secure Channel for Configuration:  Leaving this option selected causes DHCP 
configuration information to be transferred over a secure channel.

Deselecting the option lets a user with fewer privileges configure LDAP services and allows 
configuration information to be transferred over a non-secure channel.

Default: Selected

 LDAP User Name with Context: Specify a typeful, distinguished name and context for an 
LDAP user. 

This user should be an eDirectory user that can access the DHCP server.

Default: If you specified a common proxy user, it is used by default. If you didn’t specify a 
common proxy user, the eDirectory Admin name and context that you specified when 
configuring eDirectory is specified.

 LDAP User Password: Type a password for the LDAP user.

 LDAP Port for DHCP Server: Select a port for the LDAP operations to use.

IMPORTANT: The scripts that manage the common proxy user introduced in OES 2 SP3 
require port 636 for secure LDAP communications.

Default: 636

 Use Secure LDAP Channel: Selecting this option ensures that the data transferred between 
the DHCP server and the LDAP server is secure and private. 

If you deselect this option, the data transferred is in clear text format.

Default: Selected

 Certificates (optional) 

 Request Certificate: Specifies what checks to perform on a server certificate in a SSL/
TLS session. Select one of the following options:

 Never: The server does not ask the client for a certificate. This is the default

 Allow: The server requests a client certificate, but if a certificate is not provided or 
a wrong certificate is provided, the session still proceeds normally.

 Try: The server requests the certificate. If none is provided, the session proceeds 
normally. If a certificate is provided and it cannot be verified, the session is 
immediately terminated

 Hard: The server requests a certificate. A valid certificate must be provided, or the 
session is immediately terminated.

 Paths to Certificate Files: Specify or browse the path for the certificate files. 

 The LDAP CA file contains CA certificates

 The LDAP client certificate contains the client certificate. 

 The LDAP client key file contains the key file for the client certificate.

Novell DHCP Services Interface Selection 

 Network Boards for the Novell DHCP Server: From the available interfaces, select the 
network interfaces that the Novell DHCP server should listen to.

Page and Parameters
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For additional configuration instructions, see “Installing and Configuring DHCP ” in the OES 2 
SP3: Novell DNS/DHCP Administration Guide.

Novell DNS Services

Table 3-11   Novell DNS Services Parameters and Values

Page and Parameters

Novell DNS Configuration 

 Directory server address: If you have specified multiple LDAP servers by using the LDAP 
Configuration for Open Enterprise Services dialog box, you can select a different LDAP 
server than the first one in the list.

If you are installing into an existing tree, you must ensure that the selected server has a 
master or read/write replica of eDirectory.

Default: The first LDAP server in the LDAP Server Configuration dialog box.
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 Common DNS Configuration Object and User Contexts: 

 Get Context and Proxy User Information from Existing DNS Server: Select this 
option if you are configuring DNS in an existing tree where DNS is already configured, 
and you want to use the existing Locator, Root Server Info, Group and Proxy User 
contexts.

 Existing Novell DNS Server Address: If you have enabled the previous option, you 
can type the IP address of an NCP server (must be up and running) that is hosting the 
existing DNS server. 

To automatically retrieve the contexts of the objects that follow, click Retrieve. 

If you do not want to use the retrieved contexts, you can change them manually.

 Novell DNS Services Locator Object Context: Specify the context for the DNS 
Locator object.

The Locator object contains global defaults, DHCP options, and a list of all DNS and 
DHCP servers, subnets, and zones in the tree.

Default: The context you specified for the OES server you are installing.

 Novell DNS Services Root Server Info Context: Specify the context for the DNS 
Services root server.

The RootSrvrInfo Zone is an eDirectory container object that contains resource records 
for the DNS root servers.

Default: The context you specified for the OES server you are installing.

 Novell DNS Services Group Object Context: Specify the context for the DNS Group 
object.

This object is used to grant DNS servers the necessary rights to other data within the 
eDirectory tree.

Default: The context you specified for the OES server you are installing.

 Proxy User for DNS Management: Specify the FDN of the DNS proxy user. 

An existing user must have eDirectory read, write, and browse rights under the 
specified context. If the user doesn’t exist, it is created in the context specified.

Default: If you specified a common proxy user, it is used by default. If you didn’t specify 
a common proxy user, the eDirectory Admin name and context that you specified when 
configuring eDirectory is specified.

 Specify Password for eDirectory User: Specify the password for the DNS proxy user.

For more information on proxy user and password management, see “Planning Your 
Proxy Users” in the OES 2 SP3: Planning and Implementation Guide.

Default: The password that you specified for the OES server you are installing.

 Local NCP Server Context: Specify a context for the local NCP Server object.

Default: The eDirectory context specified for this OES server.

 Use Secure LDAP Port: Selecting this option ensures that the data transferred by this 
service is secure and private. 

If you deselect this option, the transferred data is in clear text format.

Default: Selected

Page and Parameters
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For additional configuration instructions, see “Installing and Configuring DNS ” in the OES 2 SP3: 
Novell DNS/DHCP Administration Guide.

Novell Domain Services for Windows

There are multiple configuration scenarios, depending on your deployment. For information, see 
“Installing Domain Services for Windows” in the OES 2 SP3: Domain Services for Windows 
Administration Guide.

Novell eDirectory Services

IMPORTANT: You specified the eDirectory configuration for this server in either “Specifying 
LDAP Configuration Settings” on page 70 or “Specifying eDirectory Configuration Settings” on 
page 72, and the settings you specified were extended to your OES service configurations by the 
OES install.

If you change the eDirectory configuration at this point in the install, your modifications might or 
might not extend to the other OES services. For example, if you change the server context from 
o=example to ou=servers.o=example, the other service configurations might or might not reflect the 
change.

Be sure to carefully check all of the service configuration summaries on the Novell Open Enterprise 
Server Configuration summary screen. If any of the services don’t show the eDirectory change you 
made, click the service link and modify the configuration manually. Otherwise your installation will 
fail.

Table 3-12   Novell eDirectory Parameters and Values

 Credential Storage Location: Specify where the DNS proxy user’s credentials are to be 
stored. 

Default: For security reasons, the default and recommended method of credential storage is 
CASA.

Page and Parameters

eDirectory Configuration - New or Existing Tree 
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 New or Existing Tree 

 New Tree: Creates a new tree. 

Use this option if this is the first server to go into the tree or if this server requires a 
separate tree. Keep in mind that this server will have the master replica for the new 
tree, and that users must log into this new tree to access its resources.

 Existing Tree: Incorporates this server into an existing eDirectory tree. 

This server might not have a replica copied to it, depending on the tree configuration. 
For details, see the “Guidelines for Replicating Your Tree (http://www.novell.com/
documentation/edir88/edir88/data/a2iiie1.html#a2iiie1)” in the Novell eDirectory 8.8 
Administration Guide (http://www.novell.com/documentation/edir88/edir88/data/
a2iii88.html#a2iii88).

Default: New Tree

 eDirectory Tree Name: Specify a unique name for the eDirectory tree you want to create or 
the name of the tree you want to install this server into. 

 Use eDirectory Certificates for HTTPS Services: Selecting this option causes 
eDirectory to automatically back up the currently installed certificate and key files and 
replace them with files created by the eDirectory Organizational CA (or Tree CA).

Most OES services that provide HTTPS connectivity are configured by default to use 
the self-signed common server certificate created by YaST. Self-signed certificates 
provide minimal security and limited trust, so you should consider using eDirectory 
certificates instead.

For all server installations, this option is enabled by default and is recommended for the 
increased security it provides.

To prevent third-party CA certificates from being accidentally backed up and 
overwritten, deselect this option.

For more information on certificate management and this option, see “Security” in the 
OES 2 SP3: Planning and Implementation Guide. 

 Require TLS for Simple Binds with Password: Select this option to make 
connections encrypted in the Session layer.

 Install SecretStore: Select this option to install Novell SecretStore (SS), an 
eDirectory-based security product.

eDirectory Configuration - New/Existing Tree Information 

 IP Address of an Existing eDirectory Server with a Replica: Specify the IP address of a 
server with an eDirectory replica.

This option appears only if you are joining an existing tree.

 NCP Port on the Existing Server: Specify the NCP port used by the eDirectory server you 
specified.

This option appears only if you are joining an existing tree.

Default: 524
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 LDAP and Secure LDAP Ports on the Existing Server: Specify the LDAP ports used by 
the eDirectory server you specified.

This option appears only if you are joining an existing tree.

IMPORTANT: The scripts that manage the common proxy user introduced in OES 2 SP3 
require port 636 for secure LDAP communications.

Default: 389 (LDAP), 636 (Secure LDAP)

 FDN Admin Name with Context: Specify the name of the administrative user for the new 
tree. 

This is the fully distinguished name of a User object that will be created with full 
administrative rights in the new directory.

Default: The eDirectory Admin name and context that you specified when initially 
configuring eDirectory.

 Admin Password: Specify the eDirectory administrator's password. 

This is the password of the user specified in the prior field.

 Verify Admin Password: Retype the password to verify it.

This option only appears if you are creating a new tree.

eDirectory Configuration - Local Server Configuration 

 Enter Server Context: Specify the location of the new server object in the eDirectory tree.

 Enter Directory Information Base (DIB) Location: Specify a location for the eDirectory 
database. 

Default: The default path is /var/opt/novell/eDirectory/data/dib, but you can 
use this option to change the location if you expect the number of objects in your tree to be 
large and the current file system does not have sufficient space.

 Enter LDAP Port: Specify the LDAP port number this server will use to service LDAP 
requests.

Default: 389

 Enter Secure LDAP Port: Specify secure LDAP port number this server will use to service 
LDAP requests.

IMPORTANT: The scripts that manage the common proxy user introduced in OES 2 SP3 
require port 636 for secure LDAP communications.

Default: 636

 Enter iMonitor Port: Specify the port this server will use to provide access to the iMonitor 
application. 

iMonitor lets you monitor and diagnose all servers in your eDirectory tree from any location 
on your network where a Web browser is available.

Default: 8028
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 Enter Secure iMonitor Port: Specify the secure port this server will use to provide access 
to the iMonitor application. 

Default: 8030

eDirectory Configuration - NTP and SLP 

 Network Time Protocol (NTP) Server: Specify the IP address or DNS hostname of an NTP 
server. 

 For the first server in a tree, we recommend specifying a reliable external time source.

 For servers joining a tree, specify the same external NTP time source that the tree is 
using, or specify the IP address of a configured time source in the tree. A time source 
in the tree should be running time services for 15 minutes or more before connecting to 
it, or the time synchronization request for the installation fails.

If the time source server is NetWare 5.0 or earlier, you must specify an alternate NTP 
time source, or the time synchronization request fails. For more information, see “Time 
Services” in the OES 2 SP3: Planning and Implementation Guide.

 Use Local Clock: Alternatively, you can select Use Local Clock to designate the server’s 
hardware clock as the time source for your eDirectory tree. 

This is not recommended if there is a reliable external time source available.
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 (SLP Options) 

 Do Not Configure SLP: Is sufficient for eDirectory trees with three or fewer eDirectory 
servers.

Without SLP, users can’t see a tree list, but they should still be able to attach to a tree 
by name. Users can configure the Novell Client to use DNS, or they can configure the 
local host file (%SystemDrive%\windows\system32\drivers\etc\hosts on 
WinXP) to resolve tree and server names. Users can also specify preferred tree and 
context information in the DHCP Settings page of the Novell Client.

IMPORTANT: If the tree where you are installing this server has or will have more than 
three servers, you must configure SLP.

 Use Multicast to Access SLP: Allows the server to request SLP information by using 
multicast packets. Use this in environments that have not established SLP DAs 
(Directory Agents).

IMPORTANT: If you select this option, you must disable the firewall for SLP to work 
correctly. Multicast creates a significant amount of network traffic and can reduce 
network throughput.

 Configure as Directory Agent: Configures this server as a Directory Agent (DA). This 
is useful if you plan to have more than three servers in the tree and want to set up SLP 
during the installation.

 DASyncReg: Causes SLP, when it starts, to query the Directory Agents listed 
under Configured SLP Directory Agents for their current lists of registered 
services. It also causes the DA to share service registrations that it receives with 
the other DAs in the SLP Directory Agent list.

 Backup SLP Registrations: Causes SLP to back up the list of services that are 
registered with this Directory Agent on the local disk.

 Backup Interval in Seconds: Specifies how often the list of registered services 
is backed up.

 Configure SLP to use an existing Directory Agent: Configures SLP to use an 
existing Directory Agent (DA) in your network. Use this in environments that have 
established SLP DAs. When you select this option, you configure the servers to use by 
adding or removing them from the SLP Directory Agent list.

 Service Location Protocols and Scope: Configures the scopes that a user agent (UA) or 
service agent (SA) is allowed when making requests or when registering services, or 
specifies the scopes a directory agent (DA) must support. The default value is DEFAULT. 
Use commas to separate each scope. For example, net.slp.useScopes = 
myScope1,myScope2,myScope3.

This information is required when selecting the Use Multicast to Access SLP or Configure 
SLP to Use an Existing Directory Agent option is selected.

Default: Default

 Configured SLP Directory Agents: Lets you manage the list of hostname or IP addresses 
of one or more external servers on which a SLP Directory Agent is running.

It is enabled for input only when you configure SLP to use an existing Directory Agent.

Novell Modular Authentication Services 
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IMPORTANT: NMAS client software (included with Novell Client software) must be installed on 
each client workstation where you want to use the NMAS login methods.

 CertMutual: The Certificate Mutual login method implements the Simple Authentication and 
Security Layer (SASL) EXTERNAL mechanism, which uses SSL certificates to provide client 
authentication to eDirectory through LDAP.

 Challenge Response: The Challenge-Response login method works with the Identity 
Manager password self-service process. This method allows either an administrator or a 
user to define a password challenge question and a response, which are saved in the 
password policy. Then, when users forget their passwords, they can reset their own 
passwords by providing the correct response to the challenge question.

 DIGEST-MD5: The Digest MD5 login method implements the Simple Authentication and 
Security Layer (SASL) DIGEST-MD5 mechanism as a means of authenticating the user to 
eDirectory through LDAP.

 NDS: The NDS login method provides secure password challenge-response user 
authentication to eDirectory. This method supports the traditional NDS password when the 
NMAS client is in use. Reinstallation is necessary only if the NDS login method object has 
been removed from the directory.

 Simple Password: The Simple Password NMAS login method provides password 
authentication to eDirectory. The Simple Password is a more flexible but less secure 
alternative to the NDS password. Simple Passwords are stored in a secret store on the user 
object.

 SASL GSSAPI: The SASL GSSAPI login method implements the Generic Security Services 
Application Program Interface (GSSAPI) authentication by using the Simple Authentication 
and Security Layer (SASL) that enables users to authenticate to eDirectory through LDAP 
by using a Kerberos ticket. 

If you want to install all of the login methods into eDirectory, click Select All. 

If you want to clear all selections, click Deselect All.

For more information on these login methods, see “Managing Login and Post-Login Methods and 
Sequences” in the Novell Modular Authentication Services 3.3.1 Administration Guide. 

Defaults: Challenge Response and NDS

OES Common Proxy User Information 
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For additional configuration instructions, see “Installing or Upgrading Novell eDirectory on Linux” 
in the Novell eDirectory 8.8 Installation Guide.

Novell FTP Services

No additional configuration is required.

Novell iFolder

When you configure iFolder as part of the OES install and configuration, you can specify only an 
EXT3 or ReiserFS volume location for the System Store Path, which is where you store iFolder data 
for all your users. You cannot create NSS volumes during the system install.

If you want to use an NSS volume to store iFolder data, you must reconfigure iFolder after the initial 
OES installation. To reconfigure, use Novell iManager to create an NSS volume, then go to YaST > 
Open Enterprise Server > Install and Configure Open Enterprise Services and select iFolder 3.8 to 
enter new information. All previous configuration information is removed and replaced. 

 Use Common Proxy User as Default for OES Products: Selecting this option configures 
the specified common proxy user for the following services: CIFS, DNS, DHCP, iFolder, 
NetStorage, and NCS. Optionally, you can specify that LUM use it. 

 OES Common Proxy User Name: By default, the common proxy user’s name is 
OESCommonProxy_hostname, but you can specify any name that fits your naming 
methodology. 

By default, the common proxy user is created in the container that you specify for the server 
object. 

You can specify a different container, but it must meet one of the following qualifications:

 New Tree Installation: The container must be included in either the path specified for 
the eDirectory Admin user or the path for Server object. 

 Existing Tree Installation: The container must already exist in eDirectory. 

IMPORTANT: You cannot create a new container by specifying a non-qualifying path. If you 
attempt this, the installation program will appear to proceed normally until the eDirectory 
Configuration (ndsconfig) runs. At that point the installation will fail with an Error 
creating Common Proxy User: 32 error, and you will need to install the server again.

 OES Common Proxy User Password: You can accept the default system-generated 
password or specify a new password for the common proxy user. 

 Verify OES Common Proxy User Password: If you specified a different password, type 
the same password in this field. Otherwise, the system-generated password is automatically 
included.

 Assign Common Proxy Password Policy to Proxy User: The initial common proxy 
password policy is a simple password policy created with default rules. You can modify this 
policy after the installation to enforce stricter rules regarding password length, characters 
supported, expiration intervals, etc.
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Table 3-13   Novell iFolder 3.8 Parameters and Values

Page and Parameters

Novell iFolder System Configuration Options 

 iFolder Component to Be Configured 

 iFolder Server: Lets you configure the settings for the iFolder server that is the central 
repository for storing user iFolders and synchronizing files for enterprise users.

 iFolder Web Admin: Lets you create and configure settings for the administrator user. 

The iFolder Admin user is the primary administrator of the iFolder Enterprise Server. 
The Web Admin server does not need to be configured on the iFolder Enterprise 
Server. Devoting a separate server to the Web Admin application improves the 
performance of the iFolder Enterprise Server by reducing the admin traffic.

 iFolder Web Access: Lets you configure the Web Access server, which is an interface 
that lets users have remote access to iFolders on the enterprise server. 

The Web Access server lets users perform all the operations equivalent to those of the 
iFolder client through using a standard Web browser. 

The Web Access server does not need to be configured in the same iFolder Enterprise 
Server. Directing the user tasks to a separate server and thereby reducing the HTTP 
requests helps to improve the performance of the iFolder Enterprise Server.

Default: All three items are selected.

Novell iFolder System Configuration 

 Name Used to Identify the iFolder System to Users: Specify a unique name to identify 
your iFolder Enterprise Server.

Default: iFolder

 System Description (optional): Specify a descriptive label for your iFolder Enterprise 
Server to identify it to the users.

Default: iFolder Enterprise System

 Path to Server's Data Files: Specify the case-sensitive address of the location where the 
iFolder Enterprise Server stores iFolder application files as well as the user iFolders and 
files.

IMPORTANT: This location cannot be modified after iFolder is installed.

Default: /var/simias/data/

 Path to the Recovery Agent Certificates (optional): Specify the path to the recovery 
agent certificates that are used for recovering the encryption key.

Default: /var/simias/data/simias

Novell iFolder System Configuration (2) 

 Name of iFolder Server: Specify a unique name to identify your iFolder Enterprise Server. 
For example: Host1.

Default: The name of the OES server
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 iFolder Public URL: Specify the public URL for users to reach the iFolder Enterprise 
Server.

Default: The OES server’s IP address

 iFolder Private URL: Specify the private URL corresponding to the iFolder Enterprise 
Server to allow communication between the servers within the iFolder domain. The private 
URL and the public URL can be the same.

Default: The OES server’s IP address

 Select SSL Option for iFolder: Select the SSL option you want to set up a secure 
connection between the iFolder server and the iFolder clients. 

There are three options for the channel for data transfer: SSL, Non SSL, and Both. However, 
authentication is always over SSL (not optional). 

 Both: (default) This option lets you select a secure or a non-secure channel for 
communication among the iFolder server, Web Admin server, Web Access server and 
the clients. By default, these components use the HTTPS (secure) communication 
channel. However, all components can also be configured to use HTTP. 

 Non SSL: Select this option to enable non-secure communication between the iFolder 
server, Web Admin server, Web Access server and the clients. The iFolder uses the 
HTTP channel for communication. 

 SSL: Select this option to enable a secure connection among the iFolder server, 
iFolder Web Admin server, iFolder Web Access server, and the iFolder clients. The 
iFolder uses the HTTPS channel for communication.

Default: Both

 iFolder Port to Listen On: Specify the port for the iFolder to listen on.

Default: 443

 Install into Existing iFolder Domain: Select this option when you want to attach to an 
existing iFolder domain. 

If this option is not selected, this server becomes the Master iFolder server.

Default: Deselected

 Private URL of the Master Server: Specify the private URL of the Master iFolder server 
that holds the master iFolder data for synchronization to the current iFolder Enterprise 
Server.

 Configure LDAP Groups Plugin: Select this option to configure the LDAP Groups plug-in. 

If this option is left unselected, iFolder does not have LDAP Group support enabled.

Novell iFolder LDAP Configuration 
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 Directory server address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you need to add another eDirectory LDAP server to the list, use the LDAP Configuration 
for Open Enterprise Services dialog box.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. 

If you are installing into an existing tree, you must enter the password of an admin user in 
the tree.

Default: The first server selected in the LDAP Configuration list of servers

 Use Alternate LDAP server: If you need to add another LDAP server to the list, select this 
option and enter the following information:

 Alternate Directory Server Address: Specify the host or IP address of the alternate 
LDAP server that iFolder will use. 

 LDAP Port: Specify the LDAP port to use for this alternate server.

 LDAP Secure Port: Specify the LDAP secure port to use for this alternate server.

 Admin Name and Context: Specify the administrator name and context for the 
alternate LDAP server.

 Admin Password: Type the specified administrator’s password.

Novell iFolder System Configuration 

 The iFolder Default Administrator: Specify the username for the default iFolder 
administrative user. Use the full distinguished name of the iFolder administrative user.

Default: The eDirectory Admin user you specified while configuring eDirectory.

 iFolder Admin Password: Specify a password for the iFolder administrative user.

 Verify iFolder Admin Password: Type the password for the iFolder administrative user 
again.

 LDAP Proxy User: Specify the full distinguished name of the LDAP Proxy user. 

This user must have the Read right to the LDAP service. This user is used to provision the 
users between iFolder Enterprise Server and the LDAP server. If it does not already exist, 
this user is created and granted the Read right to the root of the tree. The LDAP proxy user's 
domain name (DN) and password are stored by iFolder.

Default: If you specified a common proxy user, it is used by default if possible. If you didn’t 
specify the common proxy user, a user object named iFolderProxy is created in the server 
context you specified. 

The common proxy user cannot be used if iFolder is running on a cluster node. If the NCS 
pattern is selected along with iFolder, this field will be populated with the iFolderProxy by 
default.

 LDAP Proxy User Password: Specify a password for the LDAP Proxy user.

For more information on proxy user and password management, see “Planning Your Proxy 
Users” in the OES 2 SP3: Planning and Implementation Guide.

Default: A system-generated password
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 Verify LDAP Proxy User Password: Type the password for the LDAP Proxy user again.

 LDAP Search Context: Click Add, then specify an LDAP tree context to be searched for 
users to provision them in iFolder. For example, o=acme, o=acme2, or o=acme3

If no context is specified, only the iFolder administrative user is provisioned for services 
during the install.

Default: The server context you specified while configuring eDirectory.

 LDAP Naming Attribute: Select which LDAP attribute of the User account to apply when 
authenticating users. This setting cannot be changed after the install.

Each user enters a username in this specified format at login time. Common Name (CN) is 
the default, and an e-mail address (email) is the other option.

For example, if a user named John Smith has a common name of jsmith and e-mail of 
john.smith@example.com, this field determines whether the user enters jsmith or 
john.smith@example.com as the username when logging in to the iFolder Enterprise 
Server.

Default: Common Name (CN)

 Require a Secure Connection Between the LDAP server and the iFolder Server: If the 
LDAP server co-exists on the same computer as the iFolder Enterprise Server, you can 
deselect this option, which increases the performance of LDAP authentications.

Default: Selected

Novell iFolder Web Access Configuration 

 An Apache Alias That Will Point to the iFolder Web Access Application: This is a user-
friendly pointer for the Apache service.

Default: /ifolder

 The Host or IP Address of the iFolder Server That Will Be Used by the iFolder Web 
Access Application: This Web Access application performs all the user-specific iFolder 
operations on the host that runs the iFolder Enterprise Server.

Default: The IP address of the OES server you are installing

 Redirect URL for iChain/Access Gateway (optional): Specify the redirect URL for iChain/
Access Gateway that will be used by the iFolder Web Access application. This URL is used 
for the proper logout of iChain/Access Gateway sessions along with the iFolder session.

 Connect to the iFolder Server Using SSL: Select the check box to establish a secure 
connection between the iFolder enterprise server and the iFolder Web Admin application.

Default: Selected

 iFolder Server Port to Connect on: Specify the port for the iFolder server to connect to the 
Web Acess application. 

Default: 443 (SSL communications), 80 (non-SSL communication)

 Require a secure connection between the Web browser and the iFolder Web Access 
application: Select the check box to establish a secure connection between the Web 
browser and the iFolder Web Access application.

Default: Selected
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For additional configuration instructions, see “Installing and Configuring iFolder Services” in the 
Novell iFolder 3.8.1 Administration Guide.

Novell iManager

Table 3-14   Novell iManager Parameters and Values

For additional configuration instructions, see “Installing iManager” in the Novell iManager 2.7 
Installation Guide.

Novell iFolder Web Admin Configuration 

 An Apache Alias That Will Point to the iFolder Web Admin Application: This is an 
admin-friendly pointer for the Apache service.

Default: /admin

 The Host or IP Address of the iFolder Server That Will Be Used by the iFolder Web 
Application: The iFolder Web admin application manages this host.

Default: The IP address of the OES server you are installing

 Redirect URL for iChain/Access Gateway (optional): Specify the redirect URL for iChain/
Access Gateway that will be used by the iFolder Web Admin application. This URL is used 
for the proper logout of iChain/Access Gateway sessions along with the iFolder session.

 Connect to the iFolder Server Using SSL: Select the check box to establish a secure 
connection between the iFolder Enterprise Server and the iFolder Web Admin application.

 iFolder Server Port to Connect on: Specify the port for the iFolder server to connect to the 
Web Admin application. Port 443 is the default. Port 80 is the default value for non-SSL 
communication.

 Require a secure connection between the Web browser and the iFolder Web Access 
application: Select the check box to establish a secure connection between the Web 
browser and the iFolder Web Admin application.
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iManager Configuration 

 eDirectory Tree: Shows the name of a valid eDirectory tree that you specified when 
configuring eDirectory.

To change this configuration, you must change the eDirectory configuration.

 FDN Admin Name with Contextt: Shows the eDirectory Admin name and context that 
you specified when configuring eDirectory. This is the user that has full administrative rights 
to perform operations in iManager.

To change this configuration, you must change the eDirectory configuration.
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Novell iPrint

Table 3-15   Novell iPrint Parameters and Values

For additional configuration instructions, see “Installing and Setting Up iPrint on Your Server” in 
the OES 2 SP3: iPrint for Linux Administration Guide.

Novell Linux User Management

Table 3-16   Novell Linux User Management Parameters and Values

Page and Parameters

iPrint Configuration 

 Directory server address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the 
list, add it by using the LDAP Configuration for Open Enterprise Services dialog box.

 Top-Most Container of eDirectory Tree: iPrint uses LDAP to verify rights to perform 
various iPrint operations, including authenticating users for printing and performing 
management tasks such as uploading drivers. 

During the installation of the iPrint software, iPrint attempts to identify the topmost container 
of the eDirectory tree and sets the base dn to this container for the AuthLDAPURL entry in 
/etc/opt/novell/iprint/httpd/conf/iprint_ssl.conf.

For most installations, this is adequate because users are often distributed across 
containers. 

IMPORTANT: If you have mutliple peer containers at the top of your eDirectory tree, leave 
this field blank so that the LDAP search begins at the root of the tree.

Page and Parameters

Linux User Management Configuration 

 Directory Server Address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the 
list, add it by using the LDAP Configuration for Open Enterprise Services dialog box.

For information about specifying multiple LDAP servers for Linux User Management 
(LUM), see “Configuring a Failover Mechanism” in the OES 2 SP3: Novell Linux User 
Management Administration Guide.

Default: The first server selected in the LDAP Configuration list of servers
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 Unix Config Context: The UNIX Config object holds a list of the locations (contexts) of 
UNIX Workstation objects in eDirectory. It also controls the range of numbers to be 
assigned as UIDs and GIDs when User objects and Group objects are created.

Specify the eDirectory context (existing or created here) where the UNIX Config object will 
be created. An LDAP search for a LUM User, a LUM Group, or a LUM Workstation object 
begins here, so the context must be at the same level or higher than the LUM objects 
searched for.

If the UNIX Config Object is placed below the location of the User objects, the /etc/
nam.conf file on the target computer must include the support-outside-base-context=yes 
parameter.

Geographically dispersed networks might require multiple UNIX Config objects in a single 
tree, but most networks need only one UNIX Config object in eDirectory.

Default: The Organization object you specified in the eDirectory configuration

 Unix Workstation Context: Computers running Linux User Management (LUM) are 
represented by UNIX Workstation objects in eDirectory. The object holds the set of 
properties and information associated with the target computer, such as the target 
workstation name or a list of eDirectory groups that have access to the target workstation.

Specify the eDirectory context (existing or created here) for the UNIX Workstation object 
created by the install for this server. The context should be the same as or below the UNIX 
Config Context specified above.

Default: The context you specified for this OES server in the eDirectory configuration

 Proxy User Name with Context (Optional): If you specified a common proxy user, and 
you select the Use OES Common Proxy User option (below) it is used by default. If you 
didn’t specify a common proxy user, you can specify a user (existing or created here) with 
rights to search the LDAP tree for LUM objects.

 Proxy User Password: If you are using the common proxy user, the password is 
automatically entered for you. Otherwise, you can specify a password (existing or created 
here) for the Proxy user.

For more information on proxy user and password management, see “Planning Your Proxy 
Users” in the OES 2 SP3: Planning and Implementation Guide.

 Use OES Common Proxy User: Check this option if you specified a common proxy user 
and want to use it as the proxy user for LUM.

 Restrict Access to the Home Directories of Other Users: This option is selected by 
default to restrict read and write access for users other than the owner to home directories.

Using the default selection changes the umask setting in /etc/login.defs from 022 to 
077.

Default: Selected

Linux User Management Configuration (2) 
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For additional configuration instructions, see “Setting Up Linux User Management” in the OES 2 
SP3: Novell Linux User Management Administration Guide.

Novell NCP Server / Dynamic Storage Technology

Table 3-17   Novell NCP Server Parameters and Values

For additional configuration instructions, see “Installing and Configuring NCP Server for Linux” in 
the OES 2 SP3: NCP Server for Linux Administration Guide.

IMPORTANT: Before you change the PAM-enabled service settings, be sure you understand the 
security implications explained in “User Restrictions: Some OES 2 Limitations” in the OES 2 
SP3: Planning and Implementation Guide.

 Services to LUM-enable for authentication via eDirectory: Select the services to LUM-
enable on this server. The services marked yes are available to authenticated LUM users.

 login: no

 ftp: no

 sshd: no

If you want to use the SSH protocol to define a NetStorage storage location object, 
you must select SSHD as a LUM-enabled service.

If do not select SSHD, users cannot to log in to NetStorage through SSH to access 
their files.

 su: no

 rsh: no

 rlogin: no

 xdm: no

 openwbem: yes

This is selected by default because it is used by many of the OES services such as 
iPrint, NSS, SMS, Novell Remote Manager, and Samba. To access iManager, you 
must enable OpenWBEM.

 gdm: no

 gdm-autologin: no

 gnome-passwd: no

 gnome-screensaver: no

 gnomesu-pam: no
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NCP Server Configuration 

 Admin Name with Context: The eDirectory Admin user you specified in the eDirectory 
configuration.
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Novell NetStorage

Table 3-18   Novell NetStorage Parameters and Values

For additional configuration instructions, see “Installing NetStorage” in the OES 2 SP3: NetStorage 
Administration Guide.

Novell Pre-Migration Server

No additional configuration is required. For information, see “Preparing the Source Server for 
Migration” the OES 2 SP3: Migration Tool Administration Guide.

Novell QuickFinder

Table 3-19   Novell QuickFinder Parameters and Values

Page and Parameters

NetStorage Configuration 

 Authentication Domain Host: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services page.

Default: The first server selected in the LDAP Configuration list of servers.

 Proxy User Name with Context: Specify the proxy user name including the context, or 
accept the default.

This user performs LDAP searches for users logging into NetStorage.

Default: If you specified a common proxy user, it is used by default. If you didn’t specify a 
common proxy user, the eDirectory Admin name and context that you specified when 
configuring eDirectory is specified.

 Proxy User Password: Specify a password for the proxy user.

For more information on proxy user and password management, see “Planning Your Proxy 
Users” in the OES 2 SP3: Planning and Implementation Guide.

 User Context: Specify the NetStorage user context, or accept the default.

This is the eDirectory context for the users that will use NetStorage. NetStorage searches 
the eDirectory tree down from the specified context for User objects. If you want NetStorage 
to search the entire eDirectory tree, specify the root context.

Default: The Organization object you specified while configuring eDirectory

Page and Parameters
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For additional configuration instructions, see “Installing QuickFinder Server” in the OES 2 SP3: 
Novell QuickFinder Server 5.0 Administration Guide.

Novell Remote Manager

No additional configuration for the installation is required. To change the configuration after the 
installation, see “Changing the Configuration” in the OES 2 SP3: Novell Remote Manager for Linux 
Administration Guide.

Novell Samba

Table 3-20   Novell Samba Parameters and Values

 Novell QuickFinder Admin User Type: Make the QuickFinder administrator a LUM-
enabled eDirectory user or a local Linux user.

 Local: Select this option to give QuickFinder Server administration rights to a local 
Linux user (the default is the root user if no other local users exist).

 Directory LUM Enabled: Gives QuickFinder Server administration rights to an 
eDirectory user.

Default: Directory LUM enabled

 QuickFinder Admin Name: Specify the QuickFinder administrator name. 

If you selected Directory LUM enabled as the user type, include the full context (such as 
cn=admin,o=novell). 

If you selected Local as the user type, specify only the admin name (such as root). If the user 
does not already exist, it is created.

Default: The eDirectory Admin user you specified while configuring eDirectory

 Add novlwww User to the Shadow Group: If only LUM-enabled eDirectory users will use 
QuickFinder, this option does not need to be set.

QuickFinder uses Pluggable Authentication Modules (PAM) to authenticate users for both 
administration and rights-based searching. Because QuickFinder is a servlet under Tomcat, 
it has the same rights to the system as the Tomcat user (wwwrun). 

For QuickFinder to verify user credentials for local users (including root), the wwwrun user 
must be added to the local shadow group. 

Default: Yes

Novell QuickFinder Admin Password 

 eDirectory Admin Name: Specified on the previous page. 

 Novell QuickFinder Admin User Type: If a different admin user was created, specify a 
password.

Page and Parameters
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For additional configuration instructions, see “Installing the Novell Samba Components” in the 
OES2 SP3: Samba Administration Guide.

Novell Storage Services (NSS)

Table 3-21   Novell Storage Services Parameters and Values

 Directory server address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services dialog box.

This is the primary IP address of the LDAP server to which CIFS client users (such as 
Windows users) authenticate, to use LDAP for access to the directories and files on this OES 
server.

Default The first server selected in the LDAP Configuration list of servers.

 Base Context for Samba Users: The eDirectory context (existing or created here) where 
the default Samba group is created. 

Default: The Organization object you specified for your tree. Do not change the default 
unless you are altering the standard Samba configuration.

 Proxy User Name with Context: A user on the specified LDAP server that has rights to 
search the LDAP tree for Samba users.

The name and context must be specified by using typeful syntax. 
(cn=name,ou=organizational_unit,o=organization)

Default: cn=servername-sambaProxy.o=organization

 Proxy User Password: The password of the Proxy User specified above.

For more information on proxy user and password management, see “Planning Your Proxy 
Users” in the OES 2 SP3: Planning and Implementation Guide.

Page and Parameters
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 Directory Server Address: The IP address shown is the default LDAP server for this 
service. If you do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you select has a master 
replica or read/write replica of eDirectory. If you need to add another LDAP server to the list, 
add it by using the LDAP Configuration for Open Enterprise Services dialog box.

Default The first server selected in the LDAP Configuration list of servers.
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For additional configuration instructions, see “Installing and Configuring Novell Storage Services” 
in the OES 2 SP3: NSS File System Administration Guide for Linux.

3.7  Finishing the Installation
The installation concludes with the following steps:

1. User Authentication Method

2. Clean Up

3. Release Notes 

4. Hardware Configuration

After a successful configuration, YaST shows the Installation Completed dialog box. Do the 
following:

1 (Optional) Select whether to clone your newly installed system for AutoYaST. To clone your 
system, select Clone This System for AutoYaST. 

The profile of the current system is stored in /root/autoinst.xml. Cloning is selected by 
default.

AutoYaST is a system for automatically installing one or more SUSE Linux Enterprise systems 
without user intervention. AutoYaST installations are performed by using a control file with 
installation and configuration data. For detailed information, see Chapter 8, “Using AutoYaST 
to Install and Configure Multiple OES Servers,” on page 179.

2 Finish the installation by clicking Finish in the Installation Completed page.

3 After the server reboots, continue with Section 3.8, “Verifying That the Installation Was 
Successful,” on page 110.

3.8  Verifying That the Installation Was 
Successful
One way to verify that your OES server installation was successful and that the components are 
loading properly is to watch the server reboot. As each component is loaded, the boot logger 
provides a status next to it indicating if the component is loading properly. 

You can also quickly verify a successful installation by accessing the server from your Web browser.

1 In the Address field of your Web browser, enter the following URL:

 FD NSS Admin Name with Context: Specify the NSS Admin name and context or accept 
the default. 

This is the fully distinguished name of a User object with administrative rights to NSS. You 
must have a unique NSS admin name for each server that uses NSS. 

For more information, see “Planning Your Proxy Users” in the OES 2 SP3: Planning and 
Implementation Guide.

Default: The server hostname concatenated with the LDAP Admin Name you entered for this 
server,. cn=myserveradmin,o=organization.
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http://IP_or_DNS

Replace IP_or_DNS with the IP address or DNS name of your OES server.

You should see a Web page similar to the following:

IMPORTANT: If you see the statement “It Works!” instead of the OES Welcome Page, that 
means that the Web and LAMP Server option was selected and installed as a SLES component 
on the server. The default OES behavior can be restored by deleting the /srv/www/htdocs/
index.html file from the server. 

You can also view the OES Welcome Page by using http://IP_or_DNS/welcome to access the 
server.

2 (Optional) If you want to look at the eDirectory tree and begin to see how iManager works, go 
to the OES Information and Management Web page, click Management Tools > iManager, then 
log in as user Admin (the user you created during product installation).

You can also access iManager by typing the following URL in a browser window and logging 
in as user Admin:

http://IP_or_DNS_name/nps/iManager.html

3 Continue with “What's Next” on page 112.
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3.9  What's Next
After you complete the initial installation, complete any additional tasks you might need to perform. 
See “Completing OES Installation or Upgrade Tasks” on page 153 and “Updating (Patching) an 
OES 2 SP3 Server” on page 157.
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4Installing or Configuring OES 2 
SP3 on an Existing Server

After installing or upgrading to Novell Open Enterprise Server (OES 2 SP3), you can also install 
additional products or services and configure them to work in the new environment. If you have 
installed or upgraded a server to SUSE Linux Enterprise Server (SLES) 10 SP4, you can also add 
OES 2 SP3 services to the server.

 Section 4.1, “Before You Install OES Services on an Existing Server,” on page 113

 Section 4.2, “Adding/Configuring OES Services on an Existing Server,” on page 114

 Section 4.3, “Adding/Configuring OES Services on a Server That Another Administrator 
Installed,” on page 118

 Section 4.4, “What's Next,” on page 118

IMPORTANT: If you have updated a server with a Support Pack, make sure the installation source 
is pointing to the latest Support Pack media. 

4.1  Before You Install OES Services on an 
Existing Server
In addition to the information in “Planning Your OES 2 Implementation” in the OES 2 SP3: 
Planning and Implementation Guide, the following apply when you install OES on an existing 
server. 

 Section 4.1.1, “Always Use YaST to Install and Initially Configure OES Services,” on page 113

 Section 4.1.2, “Don’t Install OES While Running the Xen Kernel,” on page 114

 Section 4.1.3, “If You Want eDirectory to Use a Local Database on the Server,” on page 114

4.1.1  Always Use YaST to Install and Initially Configure OES 
Services

Linux administrators sometimes wrongly assume that OES services can be installed or uninstalled 
by simply installing the associated RPMs. OES services require additional configuration that is only 
supported as an add-on product installation in YaST.

IMPORTANT: You must always install OES as an add-on product using the YaST install. For more 
information, see Section 2.11, “Always Install OES as an Add-On Product,” on page 45.
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4.1.2  Don’t Install OES While Running the Xen Kernel

If you are adding supported OES 2 components to a server that is running the Xen kernel, you must 
reset the boot loader to boot the standard kernel before adding the OES 2 SP3 components.

1 In YaST, select System > Boot Loader  > SuSE Linux Enterprise Server 10 SP4 > Set As 
Default > Finish. 

2 Reboot the server.

After adding the supported OES 2 components, reset the boot loader option to Xen. 

1 In YaST, select System > Boot Loader > XEN > Set As Default > Finish.

2 Reboot the server.

Be sure to add only those OES 2 SP3 components that are supported on a VM host server. For more 
information, see Step 3 on page 187.

4.1.3  If You Want eDirectory to Use a Local Database on the 
Server

If you want the OES components to use a local eDirectory database, you should install eDirectory 
by itself first, then rerun the installation for the other OES components.

4.2  Adding/Configuring OES Services on an 
Existing Server

IMPORTANT: If you are not using the administrator account that originally installed the OES 
server you are adding services to, see Section 2.5, “Installing and Configuring OES as a 
Subcontainer Administrator,” on page 21 and then follow the instructions in Section 4.3, “Adding/
Configuring OES Services on a Server That Another Administrator Installed,” on page 118.

To add/configure OES 2 SP3 services on an existing OES 2 SP3 server or SLES 10 SP4 server:

1 Open YaST.

2 If an OES 2 SP3 installation source has not been added to the server, continue with this step. 
Otherwise, skip to Step 3.

2a Click Software > Add-on Product.

2b Click Add.

2c In the Add-On Product Media dialog box, click CD > Next.

If you are using an alternate installation source, click the appropriate option that matches 
your installation source selection.

2d In the Insert the Add-On Product CD dialog box, select the appropriate drive where you 
want to insert the CD labeled Open Enterprise Server 2 SP3 CD 1.

2e Click Eject.

2f Insert the CD labeled Open Enterprise Server 2 SP3 CD 1, then click Continue.

2g Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.
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2h Confirm that the Add-On Product Installation page shows the correct path to the OES 
media, then click Next.

2i Skip to Step 4.

3 If an OES installation source has already been added to the server, click Open Enterprise 
Server > OES Install and Configuration.

4 On the Software Selection page, select the OES components that you want to install or 
configure. 

Services that you have already installed are indicated by a blue check mark in the status check 
box next to the service.

IMPORTANT: You cannot uninstall an OES service by deselecting it. For more information 
about removing service functionality from the server, see Chapter 13, “Disabling OES 2 
Services,” on page 221.

5 If you are only configuring or reconfiguring services that are already installed, click Accept, 
then skip to Step 9.

Not all OES components require eDirectory to be installed on the local server. Components that 
have a dependency on eDirectory being installed locally will prompt you to install eDirectory if 
it is not already installed. 

IMPORTANT: If you need to reconfigure eDirectory, we recommend that you use tools 
provided by eDirectory, such as iMonitor or iManager, rather than using YaST to change the 
configuration. The configuration provided in YaST is only for the initial eDirectory installation 
and configuration.
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If you need to reconfigure eDirectory and OES services due to database corruption, go to 
Chapter 14, “Reconfiguring eDirectory and OES Services,” on page 223 and follow the 
instructions there.

6 After selecting the services to install, click Accept. 

7 If package changes are required for your selections, select Continue.

8 Insert any media required to install the new packages.

9 Change the default configuration information as required.

In most cases, the default configuration is acceptable. You need to change the configuration at 
the following times:

 When the installation displays the following message to indicate that more information 
(often the administrator password) is required:

service_name service requires additional configuration information 
before continuing or disable the configuration.

 When you want to change the default configuration settings, such as enabling services for 
LUM.

 When you want to reconfigure a service that has already been configured.

9a To change the configuration of a newly installed service or a service that has already been 
configured, change its configuration status to Enabled, then click the service heading link 
to access the configuration dialog box for that service.

Newly installed services that have not been configured have the status of Configure is 
enabled.

Services that have already been configured have a status of Reconfigure is disabled.
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9b To enable the configuration status of any disabled service configuration, click the 
Disabled link to change the status to Enabled.

9c To delay the configuration of newly installed services to a later time, click the Enabled 
link to change the status to Configure is disabled.

For configuration guidelines, see Section 3.6.11, “Configuration Guidelines for OES 
Services,” on page 80; or, if you are reading online, click a link below:

 AFP

 Archive andVersion Servies

 Backup/Storage Management Services (SMS)

 CIFS

 Clustering (NCS)

 DHCP

 DNS

 Domain Servies for Windows (DSfW)

 eDirectory

 FTP

 iFolder

 iManager

 iPrint

 Linux User Mangement (LUM)

 NCP Server/Dynamic Storage Technology

 NetStorage

 Pre-Migration Server

 QuickFinder

 Novell Remote Manger (NRM)

 Novell Samba

 Novell Storage Services

10 When all the services have complete configuration information and the configuration or 
reconfiguration status is set to Enabled for the services that you want to configure, click Next to 
continue with the configuration process.

11 After the service configuration process has run and is finalized, click Finish.

12 If you are installing on an existing OES server, you can quit the installation at this point.

If you are installing OES services for the first time on this server, see Section 3.6.5, 
“Specifying Novell Customer Center Configuration Settings,” on page 63 for help with 
registering OES and updating the software.
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4.3  Adding/Configuring OES Services on a 
Server That Another Administrator Installed
To add or configure OES services on an OES server that another administrator installed, you must 
have the rights described in “Rights Required for Subcontainer Administrators” on page 21.

1 On the OES server, launch YaST. Then click Open Enterprise Server > OES Install and 
Configuration. 

2 On the Software Selection page, select the additional OES services you want to install, then 
click Accept.

The required packages are installed.

3 When the Novell Open Enterprise Server Configuration summary screen appears, click the 
disabled link under LDAP Configuration for Open Enterprise Services.

The link changes to enabled.

4 Click LDAP Configuration for Open Enterprise Services.

5 Change the Admin Name and Context. 

IMPORTANT: Make sure all field delimiters are consistent. For example, if you are adding to 
the context already displayed, either use comma-delimited syntax or change all other delimiters 
to periods.

6 Type the subcontainer admin password in the Admin Password field, then click Next.

7 Go to Step 9 on page 116 and continue from there.

4.4  What's Next
After you complete the configuration process, complete any additional tasks you might need to 
perform. See “Completing OES Installation or Upgrade Tasks” on page 153 and “Updating 
(Patching) an OES 2 SP3 Server” on page 157.
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5Upgrading to OES 2 SP3

Novell Open Enterprise Server (OES) 2 provides the option of updating an existing system to the 
new version without completely reinstalling it. No new installation is needed. Existing data such as 
home directories and system configuration is kept intact. During the life cycle of the product, you 
can apply Service Packs to increase system security and correct software defects.

NOTE: To upgrade an OES 2 VM guest running on Xen, see the additional instructions and 
information in Section 10.5, “Upgrading an OES 2 VM Guest to OES 2 SP3,” on page 196.

 Section 5.1, “Supported Upgrade Paths,” on page 119

 Section 5.2, “Planning for the Upgrade to OES 2 SP3,” on page 120

 Section 5.3, “Meeting the Upgrade Requirements,” on page 121

 Section 5.4, “Upgrading to OES 2 SP3,” on page 125

 Section 5.5, “Finishing the Upgrade,” on page 150

 Section 5.6, “Post-Migration iManager Configuration,” on page 151

 Section 5.7, “Verifying That the Upgrade Was Successful,” on page 151

 Section 5.8, “What's Next,” on page 152

5.1  Supported Upgrade Paths
Table 5-1 outlines the supported paths for upgrading to OES 2 SP3. 

All other OES releases can be upgraded by installing the interim support packs in order. For 
example, you can upgrade from OES 2 to OES 2 SP1, then from OES 2 SP1 to OES 2 SP2, and 
finally from OES 2 SP2 to OES 2 SP3. Cross-architecture upgrades (32-bit to 64-bit and 64-bit to 
32-bit) are not supported.

Table 5-1   Supported OES 2 SP3 Upgrade Paths

IMPORTANT: Source servers must have all patches applied from the appropriate SUSE Linux 
Enterprise Server (SLES) and OES patch channels prior to an upgrade.

Source Destination Upgrade Methods Suppported

OES 1 SP2 (32-bit) OES 2 SP3 (32-bit) Network-based media (offline)

Physical media (offline)

OES 2 SP2 (32-bit) OES 2 SP3 (32-bit) Network-based media (offline)

Physical media (offline)

Update Channel (online)

OES 2 SP2 (64-bit) OES 2 SP3 (64-bit) Network-based media (offline)

Physical media (offline)

Update Channel (online)
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5.2  Planning for the Upgrade to OES 2 SP3
 Section 5.2.1, “Be Sure to Check the Readme,” on page 120

 Section 5.2.2, “Always Upgrade SLES and OES at the Same Time,” on page 120

 Section 5.2.3, “Understanding the Implications for Other Products Currently Installed on the 
Server,” on page 120

5.2.1  Be Sure to Check the Readme

The “Common Proxy Install Issues” section documents issues that Novell plans to address in a 
future release.

5.2.2  Always Upgrade SLES and OES at the Same Time

You must upgrade SLES 10 and OES 2 at the same time.

5.2.3  Understanding the Implications for Other Products 
Currently Installed on the Server

 “OES 1 Server Upgrades: Non-OES 2 Packages Are Deleted by Default” on page 120

 “OES 2 Server Upgrades: Non-OES 2 Packages Are Retained but Might Not Work After 
Upgrading” on page 121

OES 1 Server Upgrades: Non-OES 2 Packages Are Deleted by Default

During the upgrade process from OES 1 to OES 2 SP3, packages that are not part of the SLES 10 
and OES 2 distributions are automatically selected for deletion. 

Examples include:

 OES 1 services not included in OES 2: This includes services such as iFolder 2, eGuide, and 
Virtual Office.

 Other Novell products: This includes services such as GroupWise, ZENworks, and Identity 
Manager.

For Information About This Novell Product See This Documentation

GroupWise GroupWise online documentation (http://
www.novell.com/documentation/groupwise.html)

ZENworks ZENworks online documentation (http://
www.novell.com/documentation/zenworks.html)

Identity Manager Identity Management online documentation 
(http://www.novell.com/documentation/
secure_identity_management.html)

Other Products All Novell online documentation (http://
www.novell.com/documentation/)
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 SLES 9 services not included in SLES 10: If you installed open source products that were 
included with the SLES 9 distribution, it is possible although unlikely that they have been 
removed in SLES 10.

 Third-party products: If you have installed third-party products, be sure to check that a 
product is supported on SLES 10 and follow the upgrade instructions that should be included 
with it.

IMPORTANT: To manually retain packages, you must follow the steps outlined in Section 5.4.9, 
“Reviewing the Delete Unmaintained Packages Notification,” on page 136.

There is no guarantee that packages you have manually retained will run on the SLES 10 kernel. For 
specific compatibility information, see the documentation for the impacted product.

OES 2 Server Upgrades: Non-OES 2 Packages Are Retained but Might Not Work 
After Upgrading

During the upgrade process from earlier OES 2 releases to OES 2 SP3, packages that are not part of 
the SLES 10 SP4 and OES 2 SP3 distributions are automatically retained unless you select them for 
deletion.

This includes third-party products you have installed, as well as other Novell products such as  
GroupWise, ZENworks, and Identity Manager.

There is no guarantee that these products will continue to work after you upgrade. Therefore, it is 
critical that you check the product documentation for compatibility information before you upgrade 
servers with any Novell product installed.

If you have installed a third-party product, be sure to check that it is supported on SLES 10 SP4 and 
follow the upgrade instructions that should be included with it.

5.3  Meeting the Upgrade Requirements 
Meet the following requirements before you upgrade and install any OES 2 components:

 Section 5.3.1, “Securing Current Data,” on page 122

 Section 5.3.2, “Ensuring That There Is Adequate Storage Space on the Root Partition,” on 
page 122

 Section 5.3.3, “Preparing the Server You Are Ugrading,” on page 122

For Information About This Novell Product See This Documentation

GroupWise GroupWise online documentation (http://
www.novell.com/documentation/groupwise.html)

ZENworks ZENworks online documentation (http://
www.novell.com/documentation/zenworks.html)

Identity Manager Identity Management online documentation (http://
www.novell.com/documentation/
secure_identity_management.html)

Other products All Novell online documentation (http://
www.novell.com/documentation/)
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 Section 5.3.4, “Checking the Server’s IP Address,” on page 124

 Section 5.3.5, “Checking the Server’s DNS Name,” on page 124

 Section 5.3.6, “Ensuring That the Server Has a Server Certificate,” on page 124

 Section 5.3.7, “Preparing an Installation Source,” on page 125

5.3.1  Securing Current Data

Before upgrading, secure the current data on the server. For example, make a backup copy of the 
data, so you can restore the data volumes later if needed.

Save your configuration files. Copy all configuration files to a separate medium, such as a streamer, 
removable hard disk, or USB stick, to secure the data. This primarily applies to files stored in /etc 
as well as some of the directories and files in /var and /opt. You might also want to write the user 
data in /home (the Home directories) to a backup medium. Back up this data as root. Only root has 
read permission for all local files.

5.3.2  Ensuring That There Is Adequate Storage Space on the 
Root Partition

Before starting your upgrade, make note of the root partition and space available.

If you suspect you are running short of disk space, secure your data before updating, and repartition 
your system. There is no general rule regarding how much space each partition should have. Space 
requirements depend on your particular partitioning profile and the software selected.

WARNING: If your root partition resides in an EVMS container, you might not be able to 
repartition or expand the size of the root partition without destroying data elsewhere on the device.

The df -h command lists the device name of the root partition. In the following example, the root 
partition to write down is /dev/hdb2 (mounted as /) with 183 GB available.

5.3.3  Preparing the Server You Are Ugrading

Complete the steps in Table 5-2 for your target server.
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Table 5-2   Preparing the Server You Are Upgrading

If the Server Is 
Running

Do This Before Upgrading the Server

SLES 10 SP1 1. Ensure that the products and services you have running on the server can 
run on the new SLES 10 SP4 kernel.

2. Make sure the server meets the hardware requirements for SLES 10 SP4. 
See “System Requirements for Operating Linux” in the Architecture-Specific 
Information Guide (http://www.novell.com/documentation/sles10/
book_x86_prep/data/book_x86_prep.html).

Itanium is not a supported platform for OES 2 SP3.

3. Upgrade the server to SLES 10 SP2 first and then to SLES 10 SP4. 

4. See the SLES 10 SP4 entry.

SLES 10 SP2 1. Ensure that the products and services you have running on the server can 
run on the new SLES 10 SP4 kernel.

2. Make sure the server meets the hardware requirements for SLES 10 SP4. 
See “System Requirements for Operating Linux” in the Architecture-Specific 
Information Guide (http://www.novell.com/documentation/sles10/
book_x86_prep/data/cha_sysreqs.html).

Itanium is not a supported platform for OES 2 SP3.

3. Upgrade the server to SLES 10 SP4.

4. See Chapter 4, “Installing or Configuring OES 2 SP3 on an Existing Server,” 
on page 113.

SLES 10 SP4 1. See Chapter 4, “Installing or Configuring OES 2 SP3 on an Existing Server,” 
on page 113.

OES 1 or OES 1 SP1 1. Upgrade your server to OES 1 SP2 first then see the instructions in OES 1 
SP2. 

For assistance, see the OES 1 Documentation on the Web (http://
www.novell.com/documentation/oes).

OES 1 SP2 1. Verify the OES 1 server version by using the following command at a 
terminal prompt:

cat /etc/novell-release

2. Patch the OES 1 SP2 server to the latest patch level and ensure that the 
server and services are still running as desired. For procedures, see 
“Patching an OES Server” in the OES 1 Linux Installation Guide. (http://
www.novell.com/documentation/oes/install_linux/data/
bxlu3xc.html#bxlu3xc).

3. Upgrade the server to OES 2 SP3 by following the instructions in this 
section.
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5.3.4  Checking the Server’s IP Address

Make sure the server has a static IP address.

5.3.5  Checking the Server’s DNS Name

Make sure that DNS returns the correct static IP address when you ping the server's full DNS name. 
For example

ping myserver.example.com

5.3.6  Ensuring That the Server Has a Server Certificate

IMPORTANT: Most OES servers have either an eDirectory certificate or a third-party certificate 
installed. 

These instructions only apply when that is not the case.

OES 2 1. Run YaST > Software > Online Update to patch the OES 2 server to the 
latest patch level. 

TIP: Documentation for earlier OES 2 releases is available for downloading 
from the OES 2 Online Documentation Previous Releases page (http://
www.novell.com/documentation/oes2/previous-releases.html#previous-
releases).

2. Ensure that the server and services are still running as desired. 

3. Upgrade to OES 2 SP1, apply all patches, and verify services.

4. Upgrade to OES 2 SP2, apply all patches, and verify services.

5. See the instructions in OES 2 SP2.

OES 2 SP1 1. Run YaST > Software > Online Update to patch the OES 2 SP1 server to 
the latest patch level. 

TIP: Documentation for earlier OES 2 releases is available for downloading 
from the OES 2 Online Documentation Previous Releases page (http://
www.novell.com/documentation/oes2/previous-releases.html#previous-
releases).

2. Ensure that the server and services are still running as desired. 

3. Upgrade to OES 2 SP2, apply all patches, and verify services.

4. See the instructions in OES 2 SP2.

OES 2 SP2 1. Run YaST > Software > Online Update to patch the OES 2 SP2 server to 
the latest patch level. 

2. Ensure that the server and services are still running as desired. 

3. Upgrade to OES 2 SP3 using the instructions in this section, then apply all 
patches and verify services.

If the Server Is 
Running

Do This Before Upgrading the Server
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Ensure that the server has a server certificate that has been generated and exported as a Common 
Server certificate.

To check for or add a certificate:

1 Launch YaST.

2 Click Security and Users > CA Management.

3 If no certificate authorities (CAs) are listed, create one by clicking Create Root CA.

If a CA is listed, you can use it by selecting the CA and clicking Enter CA.

4 If you are using a listed CA, you must provide the CA password (generally the root password).

5 Click Certificates > Add.

6 Fill out the forms required for a server certificate. After the last form is complete, a server 
certificate is created and listed in the certificate list.

7 Select the certificate you just created.

8 Click the Export button, then select Export as Common Server Certificate.

5.3.7  Preparing an Installation Source

Review and complete the instructions for “Setting Up a Network Installation Source” on page 41. 
We recommend using the network installation option, especially if you are upgrading multiple 
servers.

5.4  Upgrading to OES 2 SP3
Use the following instructions to complete the upgrade applicable to the installation source you are 
using:

 Section 5.4.1, “For Servers with EVMS and NSS on the System Device,” on page 126

 Section 5.4.2, “To Upgrade Using a Network Installation Source with DHCP (Offline),” on 
page 126

 Section 5.4.3, “Upgrading Using a Network Installation Source without DHCP (Offline),” on 
page 127

 Section 5.4.4, “Using Physical Media to Upgrade (Offline),” on page 129

 Section 5.4.5, “Using the Patch Channel to Upgrade (Online),” on page 130

 Section 5.4.6, “Selecting the Installation Mode Options,” on page 132

 Section 5.4.7, “Specifying the Partition to Update,” on page 133

 Section 5.4.8, “Specifying the Add-On Product Installation Information,” on page 135

 Section 5.4.9, “Reviewing the Delete Unmaintained Packages Notification,” on page 136

 Section 5.4.10, “Verifying and Customizing the Update Options in Installation Settings,” on 
page 137

 Section 5.4.11, “Accepting the Installation Settings,” on page 140

 Section 5.4.12, “Specifying Configuration Information,” on page 141
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5.4.1  For Servers with EVMS and NSS on the System Device

NOTE: This section doesn’t apply if you are upgrading through the patch channel as explained in 
“Using the Patch Channel to Upgrade (Online)” on page 130.

If you are upgrading a server that has EVMS as the volume manager for the system device, you need 
to enable boot.lvm and boot.md. (The system device contains the /boot, swap, and / (root) 
partitions) and might also have Novell Storage Services (NSS) pools and volumes.)

Do the following just before you begin the upgrade:

1 In YaST, click System > System Services (Runlevel).

2 Select Expert Mode.

3 Select boot.lvm.

4 If the boot level (column B) is not marked with a B, then click Set/Reset > Enable the Service.

5 Select boot.md.

6 If the boot level (column B) is not marked with a B, then click Set/Reset > Enable the Service.

7 Click Finish, then click Yes.

5.4.2  To Upgrade Using a Network Installation Source with 
DHCP (Offline)

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 121.

2 Insert the SUSE Linux Enterprise Server 10 SP4 CD 1 into the CD-ROM drive (or the SP4 
DVD in a compatible drive) of the server you want to upgrade to OES 2 SP3, then reboot the 
server.

3 From the boot menu, select the following Installation option that matches your environment, 
but do not press Enter.

 Installation: The normal installation mode. All modern hardware functions are enabled.

 Installation—ACPI Disabled: If the normal installation fails, it might be because the 
system hardware does not support ACPI (advanced configuration and power interface). If 
this seems to be the case, use this option to install without ACPI support.

 Installation—Local APIC Disabled: If the normal installation fails, it might be because  
the system hardware does not support local APIC (advanced programmable interrupt 
controllers). If this seems to be the case, use this option to install without local APIC 
support.

If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.

 Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

4 Specify the network installation source.

Because your network has DHCP, you don’t need to specify an IP address for the server. 
However, you do need to specify the path to your network installation source. 
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Do one of the following:

 Press F4. Select the network installation type (NFS, FTP, HTTP). Type the server name 
and installation path of your network installation source, then click OK. 

For information on setting up a network installation source, see “Setting Up a Network 
Installation Source” on page 41.

or

 Specify the network installation type and path using the Boot Options line (see “Using 
Custom Boot Options” in the SUSE Linux Enterprise Server Installation and 
Administration Guide (http://www.novell.com/documentation/sles10/book_sle_reference/
data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom
)).

5 Press Enter to begin the upgrade.

6 Select a language, then click Next.

7 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.

8 Follow the prompts, using the information contained in the following sections:

8a “Selecting the Installation Mode Options” on page 132.

8b “Specifying the Partition to Update” on page 133.

8c “Specifying the Add-On Product Installation Information” on page 135.

8d “Verifying and Customizing the Update Options in Installation Settings” on page 137.

8e “Accepting the Installation Settings” on page 140.

8f “Specifying Configuration Information” on page 141.

8g “Finishing the Upgrade” on page 150.

9 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 110.

10 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

5.4.3  Upgrading Using a Network Installation Source without 
DHCP (Offline)

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 121.

2 Insert SUSE Linux Enterprise Server 10 SP4 CD 1 into the CD-ROM drive (or the SP4 DVD in 
a compatible drive) of the server that you are upgrading to OES 2 SP3, then reboot the 
machine.

3 From the CD boot menu, select one of the following Installation options that matches your 
environment, but do not press Enter.

 Installation: The normal installation mode. All modern hardware functions are enabled.

 Installation—ACPI Disabled: If the normal installation fails, it might be because the 
system hardware does not support ACPI (advanced configuration and power interface). If 
this seems to be the case, use this option to install without ACPI support.
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 Installation—Local APIC Disabled: If the normal installation fails, this might be 
because the system hardware does not support local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.

If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.

 Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

4 To proceed with the upgrade, your server must have the following:

 An IP address assigned.

 The location of your network installation source. 

To specify this information on the Boot Options line, proceed with  Step 5.

To supply the information in a series of dialog boxes, skip to Step 7.

5 Specify the server’s IP address information and the path to the installation source on the Boot 
Options line (see “Using Custom Boot Options” in the SUSE Linux Enterprise Server 
Installation and Administration Guide (http://www.novell.com/documentation/sles10/
book_sle_reference/data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom)). 

6 Press Enter and continue with Step 24.

7 Continuing from Step 4, press Enter. 

The following error displays.

Could not find the SUSE Linux Enterprise Server 10 Installation source. 
Activating manual set up program.

8 Press Enter.

9 Select the language, then select OK and press Enter.

10 Select a keyboard map, then select OK and press Enter.

11 Select Start Installation or System, then select OK and press Enter.

12 Select Start Installation or Update, then select OK and press Enter.

13 Select Network, then select OK and press Enter.

14 Select the network protocol that matches the configured protocol on your network installation 
server, then press Enter.

15 (Conditional) If you have more than one network interface card, select one of the cards, then 
press Enter.

We recommend eth0, if it is connected to the subnet for the primary static IP address used by 
the server you are upgrading.

16 When you are prompted whether you want to use DHCP, select No, then press Enter.

17 Specify the static IP address of the server you are upgrading, then press Enter.

18 Specify the subnet mask, then press Enter.

19 Specify the gateway, then press Enter.

20 Specify the IP addresses of a name server, then press Enter.

21 Specify the IP address of the network installation server, then press Enter.
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22 (Conditional) Depending on the protocol you specified, you might see additional screens for 
FTP or HTTP. Select the options that are appropriate for your network, then continue with 
Step 23.

23 Specify the path to your installation source on the network installation server, then press Enter.

The installation system loads and the YaST install starts.

24 Select the language, then click Next.

25 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.

26 Follow the prompts, using the information contained in the following sections:

26a “Selecting the Installation Mode Options” on page 132.

26b “Specifying the Partition to Update” on page 133.

26c “Specifying the Add-On Product Installation Information” on page 135.

26d “Verifying and Customizing the Update Options in Installation Settings” on page 137.

26e “Accepting the Installation Settings” on page 140.

26f “Specifying Configuration Information” on page 141.

26g “Finishing the Upgrade” on page 150.

27 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 110.

28 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

5.4.4  Using Physical Media to Upgrade (Offline)

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 121.

2 Insert the SUSE Linux Enterprise Server 10 SP4 CD 1 or SUSE Linux Enterprise Server 10 SP4 
DVD 1 into the CD-ROM or DVD drive of the server that you are upgrading to OES 2 SP3, 
then reboot the machine.

3 From the CD boot menu, select the Installation option that best fits your environment, then 
press Enter.

4 Select the language that you want to use.

5 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.

6 Follow the prompts, using the information contained in the following sections:

6a “Selecting the Installation Mode Options” on page 132.

6b “Specifying the Partition to Update” on page 133.

6c “Specifying the Add-On Product Installation Information” on page 135.

6d “Verifying and Customizing the Update Options in Installation Settings” on page 137.

6e “Accepting the Installation Settings” on page 140.

6f “Specifying Configuration Information” on page 141.

6g “Finishing the Upgrade” on page 150.
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7 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 110.

8 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

5.4.5  Using the Patch Channel to Upgrade (Online)

NOTE: If you want to use ZENworks Linux Management to upgrade your OES 2 SP2 servers, see 
Section C.1, “Using a ZLM Server and the Patch Channel to Upgrade,” on page 245.

 “Before You Start the Upgrade” on page 130

 “Creating a Password Answer File” on page 130

 “Performing the Upgrade” on page 131

Before You Start the Upgrade

 You might notice that the SLES documentation refers to this upgrade method as an “online 
migration.” In OES, “migration” implies moving to a new architecture or platform. 

Don’t be confused by the SLES terminology when, for example, you add “migration” products 
to your upgrade channels.

 The SLES “move-to-sles10-sp4” patch cannot be used to migrate OES 2 SP3.

 The OES server being upgraded must be running OES 2 SP2 with the latest patches applied. 
For help, refer to the patching instructions for SP3 in Chapter 7, “Updating (Patching) an OES 
2 SP3 Server,” on page 157. The patching process is fundamentally the same for both versions.

 You can perform a “silent” patch channel upgrade by creating an answer file that contains the 
LDAP (eDirectory) Admin user password and, if you are installing Domain Services for 
Windows, the optional Domain Administrator password. Instructions for doing this are in 
“Creating a Password Answer File” on page 130. 

If you prefer to enter the passwords manually after the software has been updated, skip to 
“Performing the Upgrade” on page 131.

Creating a Password Answer File

If you want the upgrade process to run without user intervention after the software is updated, you 
can create an answer file for the YaST install.

IMPORTANT: The answer file can only be created on an OES 2 SP2 or later server.

1 As root, open a terminal prompt.

2 Enter the following command:

sudo yast2 create-answer-file ldap_password optional_domain_admin_password

Replace ldap_password with the LDAP (eDirectory) Admin password and 
optional_domain_admin_password with the DSfW Domain Administrator’s password (if 
applicable). 
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If your password contains special characters, such as !, $, #, etc., be aware of the following:

 In most cases you can surround the password with single quotes. For example, if the 
password is pa$$word, enter it as ‘pa$$word’.

 Alternatively, you can escape each special character, for example pa\$\$word. 

 If your password contains a single quote, use the second method.

For more information, see the man page for your shell. Enter man bash at a terminal prompt.

3 Copy the resulting answer file from the current working directory to /opt/novell/oes-
install. 

4 Continue with Performing the Upgrade.

Performing the Upgrade

Prerequisites 

 Ensure you have enough disk space in /var/cache/zmd where the update process downloads 
all the updates to.

 Register the SLES 10 SP 3 server in the Novell Customer Center.

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 121.

2 Install the move-to-oes2-sp3 patch on the server. This is an optional patch and will never be 
installed automatically.

 If you are using rug, enter the following command at a terminal prompt:

rug in -t patch move-to-oes2-sp3 && rug ping -a

NOTE: If you get the error Dependency resolution failure, follow these steps to 
resolve it, but SPident tool will not work. 

1. Remove all the OES2-SP2 installation source in YaST. 

2. Remove the migration product marker from /var/lib/zybb/db/products.

NOTE: The marker starts with 321.

3. Stop rug using rczmd stop.

4. Delete the rug database using rm /var/lib/zmd/zmd.db.

5. Start the rug using rczmd start.

NOTE: Run rug ca to make sure there are no SP2 catalogs present, and OES2SP3 
(update and pool) and SLES-10-SP4 (update, pool and online) catalogs are 
subscribed. If they are not subscribed, use the following command rug sub 
<catalog name> and subscribe them one by one. 

 If you are using the GUI Software Updater, click the Software Updater, select the move-
to-oes2-sp3 patch, then click Update.

NOTE: If you get the error Dependency resolution failure, click Resolve conflicts 
via YaST, and the dependency will be resolved and the upgradation will be completed. 

3 Answer all of the prompts in the affirmative until the move-to-oes2-sp3 patch is installed. 
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4 Verify that the Novell-Open-Enterprise-Server-SP3-migration, 
OPEN_ENTERPRISE_SERVER_SP2 and SUSE_SLES_SP3 packages are installed along 
with their associated channels by entering the following command at a terminal prompt:

rug pd -i

5 Install the recommended patches that are in the channels using rug up -t patch -g 
recommended  && rug ping -a.

6 Repeat Step 5, answering all of the prompts in the affirmative until you are prompted to reboot 
the server.

7 (Optional) Create an answer file. See “Creating a Password Answer File” on page 130.

8 Reboot the server.

9 If you did not provide a password answer file (“Creating a Password Answer File” on 
page 130), you must enter the passwords for the LDAP (eDirectory) Admin user and (if 
applicable) the DSfW Domain Administrator to start the configuration process. 

If you provided an answer file, the service configuration process continues automatically. 

If an error occurs, for example if the wrong password is entered, you can rerun the 
configuration phase again by either 

 Rebooting the server

or 

 Entering the following command at a terminal prompt:

sudo yast2 channel-upgrade-oes

10 Various messages indicate the services that are being configured. When the Login prompt 
appears, verify that the upgrade was successful. See the procedures in “Verifying That the 
Installation Was Successful” on page 110.

11 Verify that the base has changed to SLES 10 SP4 by using the SPident --vv command.  
Ensure that the output does not throw up any conflicts. 

NOTE: If the message NOT upto date is displayed when you run the SPident (Service Pack 
Identification) tool, then install the latest rpms of fuse, libfuse2, and ruby using the following 
commands:

1. rug in fuse  

2. rug in libfuse2

3. rug in ruby

12 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

5.4.6  Selecting the Installation Mode Options

1 When the Installation Mode page displays, select the following menu options:

1. Update

2. Include Add-On Products from Separate Media
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IMPORTANT: To upgrade previously installed OES services and install any additional 
OES services, you must select the Include Add-On Products from Separate Media option. 
If you don’t, only SLES is updated (if necessary). None of the OES services are upgraded.

2 Click Next.

3 Continue with “Specifying the Partition to Update” on page 133 or “Specifying the Add-On 
Product Installation Information” on page 135, depending on which matches your installation.

5.4.7  Specifying the Partition to Update

YaST tries to determine the correct root (/) partition. If there are several possibilities, or if YaST 
can’t definitely determine the correct root partition, the Select for Update page displays. 

IMPORTANT: If no partitions are listed, you are attempting to upgrade an i386 installation using 
x86_64 media. Mixing architectures in an upgrade is not permitted. See Section 5.1, “Supported 
Upgrade Paths,” on page 119. You must start the upgrade again, using i386 installation media.

1 If there is only one partition listed, click Next.

2 If there are several partitions, select the partition with /evms in the path. 

For example, make sure you select the /dev/evms/lvm/... partition rather than the /dev/
lvm/... partition. 

3 Click Next. 

YaST reads the old fstab on this partition to analyze and mount the file systems listed there.
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Next, YaST tries to mount the boot (/boot) partition. 

4 If no error displays, skip to “Specifying the Add-On Product Installation Information” on 
page 135. 

If you have EVMS on your system disk, you might get an error stating that the partition could 
not be mounted:

5 If this error displays, click Specify Mount Options. 

The Mount Options dialog box appears.
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6 Remove /evms from the Device path.

7 Click OK.

TIP: In rare cases, the same disks are reported as hard disk devices (hda, etc.) on SLES 9 and 
SCSI disk devices (sda, etc.) on SLES 10. 

If you remove /evms from the device path, and you still see the error in Step 5, try changing the 
path to use sda instead of hda.

8 Continue with “Specifying the Add-On Product Installation Information” on page 135.

5.4.8  Specifying the Add-On Product Installation Information

1 When the Add-On Product Installation page displays, click Add.

2 In the Add-On Product Media page, if you are installing from physical media, click CD > Next. 
Otherwise, skip to Step 3.

2a In the Insert the Add-On Product CD dialog box, select the drive where you want to insert 
the CD labeled Novell Open Enterprise Server 2 SP3 CD 1 if there is more than one drive.
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2b Click Eject.

2c Insert the CD labeled Novell Open Enterprise Server 2 SP3 CD 1, click Continue, then 
skip to Step 4.

3 If you are using an alternate installation source, such as a network location, click the 
appropriate option, such as the network protocol that matches your installation source, then 
click Next and specify the information for the source you have specified.

4 Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.

5 Confirm that the Add-On Product Installation page shows the correct path to the OES media, 
then click Next.

6 If you are upgrading from OES 1 SP2, continue with “Reviewing the Delete Unmaintained 
Packages Notification” on page 136. Otherwise, skip to “Verifying and Customizing the 
Update Options in Installation Settings” on page 137.

5.4.9  Reviewing the Delete Unmaintained Packages 
Notification

After the OES 2 SP3 installation source has been added, if you are upgrading from OES 1 SP2, the 
following notification is displayed:

1 Carefully read the notification.

2 Decide how you want to proceed. For more information, see “OES 1 Server Upgrades: Non-
OES 2 Packages Are Deleted by Default” on page 120.

3 Click OK, then continue with Verifying and Customizing the Update Options in Installation 
Settings.
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5.4.10  Verifying and Customizing the Update Options in 
Installation Settings

IMPORTANT: To verify that previously installed services are selected for installation and to install 
any additional OES services during the upgrade, you must customize the Update Options on the 
Installation Settings page.

To verify or customize the software packages that are installed on the server:

1 On the Installation Settings page, make sure Novell Open Enterprise Server 2 SP3 is listed 
under the Add-On Products link. If it is, proceed with Step 3.

2 If Novell Open Enterprise Server is not listed, click the Add-On Products link and follow the 
steps in “Specifying the Add-On Product Installation Information” on page 135. When the 
Installation Settings page shows Novell Open Enterprise Server 2 SP3 as an installation setting, 
proceed with Step 3.

3 If you see package conflict errors (red text under the Packages link), refer to the OES 2 SP3 
Readme for resolution instructions.

4 On the Installation Settings page, click Update Options.

5 In the Update Options page, click Update with Installation of New Software and Features 
Based on the Selection > Select Patterns.
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6 All of the OES Services patterns that were previously installed are selected by default.

Ensure that the patterns for the services you are upgrading are selected, and select the patterns 
for any new OES Services patterns that you might want to also install.

A description displays to the right of a pattern when the pattern is selected. For a description of 
OES Services patterns and the components selected with each pattern, see Table 2-4 on 
page 31.

Some OES services, such as Novell CIFS and Novell Samba, are not supported together on the 
same server. For more information, see “Unsupported Service Combinations” in the OES 2 
SP3: Planning and Implementation Guide.

IMPORTANT: If you deselect a pattern after selecting it, you are instructing the installation 
program to not install that pattern and all of it dependent patterns. Rather than deselecting a 
pattern, click Cancel to cancel your software selections, then click the Select Patterns heading 
again to choose your selections again.

Selecting only the patterns that you want to install ensures that the patterns and their dependent 
patterns and packages are installed.

If you click Accept, then return to software pattern selection page, the selections that you made 
become your base selections and must be deselected if you want to remove them from the 
installation proposal.

Attempting to uninstall a service by deselecting its pattern is not recommended. For more 
information, see Chapter 13, “Disabling OES 2 Services,” on page 221.

Selecting a pattern automatically selects the other patterns that it depends on to complete the 
installation.
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7 If you want to see the details of your selections, click Details. 
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8 When you have the software components selected that you want to install, click Accept.

9 When the notification about deleting unmaintained packages appears, click OK.

10 (Conditional) If the prompt for the AGFA Fonts license displays, read the agreement, then click 
Accept.

11 (Conditional) If the prompt for Automatic Changes displays, click Continue.

12 (Conditional) If you are prompted, resolve any dependency conflicts.

13 If the Update Options page displays again, click Accept.

14 Continue with “Accepting the Installation Settings” on page 140.

5.4.11  Accepting the Installation Settings

1 Review the final Installation Settings page to ensure that you have all the Installation settings 
you desire. Make sure that the page shows all the OES Services that you want to update and 
install.

2 After you have changed all the installation settings as desired, click Accept. 

3 In the Confirm Update dialog box, click Start Update.

The base installation settings are applied and the packages are installed.

4 While the server is updating the files, do one of the following:

 For installations using a network installation source, remove the boot CD 
(SUSE Linux Enterprise Server 10 SP4 CD 1) from the CD drive. 

 For installations using a CD or DVD installation source, leave the CD or DVD in the CD-
ROM or DVD drive. When the installation process prompts you for each CD at the 
appropriate time, insert the CD. The progress status at the bottom of the screen indicates 
which CD will be prompted for next.

5 After the server reboots, continue with “Specifying Configuration Information” on page 59.

TIP: If you have the disk driver situation mentioned in Step 8 on page 135, your server boots 
to a prompt for the root password. Specify the password, and then use an editor such as VI to 
modify the /etc/fstab file so that the path to the boot partition uses sda instead of hda. Then 
reboot the server. The upgrade should continue normally.
 SP3: Installation Guide



5.4.12  Specifying Configuration Information

When the server reboots, you are required to complete the following configuration information:

 “Testing the Connection to the Internet” on page 141

 “Specifying Novell Customer Center Configuration Settings” on page 141

 “Updating the Server Software During the Upgrade” on page 144

 “Upgrading eDirectory” on page 147

 “Specifying LDAP Configuration Settings” on page 147

 “Configuring Novell Open Enterprise Server Services” on page 148

Testing the Connection to the Internet

On the Test Internet Connection page:

1 Select Yes, Test Connection to the Internet, click Next.

2 Obtaining the latest SUSE release notes might fail at this point. If it does, view the log to verify 
that the network configuration is correct, then click Next.

3 If the network configuration is not correct, click Back > Back and fix your network 
configuration. See “Network Interface” on page 60. The most common problem is that an 
invalid DNS server is specified.

or 

Skip this test by clicking No, Skip This Test, then continue with Step 4. 

IMPORTANT: Most OES services configurations require a connection to the Internet.

Skipping this test also skips downloading release notes, configuring the Novell Customer 
Center, and updating online.

4 If you skipped the customer center test, continue with “Upgrading eDirectory” on page 147. 
Otherwise, continue with “Specifying Novell Customer Center Configuration Settings” on 
page 141. 

Specifying Novell Customer Center Configuration Settings

To receive support and updates for your OES 2 SP3 server, you need to register it in the Novell 
Customer Center. When the Novell Customer Center Configuration page is displayed, you have 
three options:

 “Updating a Registered Server (Recommended)” on page 141

 “Registering the Server Later / Skipping a Registered Server Update” on page 142

 “Registering the Server During the Upgrade” on page 142

Updating a Registered Server (Recommended)

1 If you have already registered your OES 2 server and you want to download the available 
patches, leave Configure Now selected and click Next. 

YaST contacts the server (which might take a few minutes) and then downloads the available 
patches. 

2 Go to Step 8 on page 143.
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Registering the Server Later / Skipping a Registered Server Update

1 Click Configure Later. 

2 Continue with “Upgrading eDirectory” on page 147.

3 Register the server after the installation is complete by using the procedures in Section 7.3, 
“Registering the Server in the Novell Customer Center,” on page 159.

Registering the Server During the Upgrade

1 On the Novell Customer Center Configuration configuration page, select all of the following 
options, then click Next.

2 After you click Next, the following message is displayed. Wait until this message disappears 
and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields:

 Email Address: The e-mail address for your Novell Login account.

 Confirm Email Address: The same e-mail address for your Novell Login account

 Activation Code for SLES Components (optional): Specify your purchased or 60-day 
evaluation registration code for the SLES 10 product.

If you don’t specify a code, the server cannot receive any updates or patches. 

 Activation Code for OES Components (optional): Specify your purchased or 60-day 
evaluation registration code for the OES 2 product.

If you don’t specify a code, the server cannot receive any updates or patches. 

Option What it Does

Configure Now Proceeds with registering this server and the SLES 10 SP4 and OES 
product in the Novell Customer Center.

Hardware Profile Sends information to the Novell Customer Center about the hardware that 
you are installing SLES 10 SP4 and OES 2 on.

Optional Information Sends optional information to the Novell Customer Center for your 
registration. For this release, this option doesn’t send any additional 
information.

Registration Code Makes the registration with activation codes mandatory.

Regularly Synchronize 
with the Customer 
Center

Keeps the installation sources for this server valid. It does not remove any 
installation sources that were manually added.
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 System Name or Description (optional): The hostname for the system is specified by 
default. 

If you want to change this to a description, for the Novell Customer Center, specify a 
description to identify this server.

5 Click Submit.

6 When the message to complete the registration displays, click Continue.

7 After you click Continue, the following message is displayed with the Manual Interaction 
Required page. Wait until this message disappears and Novell Customer Center Configuration 
page displays with the message that Your configuration was successful.

8 When you see the message Your configuration was successful on the Novell Customer 
Center Configuration, click OK.
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9 Continue with “Updating the Server Software” on page 65.

Updating the Server Software During the Upgrade

If you have a successful connection to the Internet and have registered the server in the Novell 
Customer Center, the server displays the Online Update page. You can run the online update now or 
skip it and get updates later.

To skip getting updates during the upgrade:

1 On the Online Update page, click Skip Update.

2 Continue with “Upgrading eDirectory” on page 147.

To get updates during the upgrade: 

1 On the Online Update page, click Run Update.

2 On the page that shows that updates are available, select the updates that you want to install, 
then click Accept. 

The check marks that are shown in the summary column of the patches list are the patches that 
have already been installed on your system.
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3 When you see the message, Installation finished on the Patch Download and Installation 
page, click Next. 

4 If the update makes changes to YaST, the following message displays. If so, click OK to restart 
YaST.
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5 If the installation was interrupted, the following message might display. If so, click Yes to 
continue with the installation, and enter the root password.

The online update displays again with additional updates. If a patch has changes to the kernel, 
you might want to deselect it and install it later after the installation is complete. For 
procedures, see “Updating (Patching) an OES 2 SP3 Server” on page 157.

6 If you do install patches that have changes to the kernel, click OK when you see the following 
message.

7 After all the patches are installed, continue with “Upgrading eDirectory” on page 147.
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Upgrading eDirectory

OES 2 SP3 includes eDirectory 8.8.6. 

1 When the following dialog box appears, click Upgrade.

2 On the eDirectory Upgrade - Existing Server Information page, type the Admin password.

3 (Conditional) If you are upgrading from OES 1 SP2 and you have installed a third-party CA 
certificate on the server, consider deselecting the Use eDirectory Certificates for HTTPS 
services. Otherwise, your HTTPS services will be configured to use the eDirectory certificate. 

For more information, see “Certificate Management” in the OES 2 SP3: Planning and 
Implementation Guide.

4 Click Next.

5 On the Novell Modular Authentication Service page, click Next.

6 Continue with with  “Specifying LDAP Configuration Settings” on page 147.

Specifying LDAP Configuration Settings

Many of the OES services require eDirectory. If eDirectory was not selected as a product to upgrade 
or install but other OES services that do require LDAP services were installed, the LDAP 
Configuration service displays so that you can complete the required information.

1 In the eDirectory Tree Name field, specify the name for the existing eDirectory tree that you are 
installing this server into.

2 In the Admin Name and Context field, specify the name and context for user Admin on the 
existing tree.

3 In the Admin Password Name field, specify a password for user for user Admin on the existing 
tree.

4 Add the LDAP servers that you want the services on this server to use. The servers that you add 
should hold the master or a read/write replica of eDirectory. Do the following for each server 
you want to add.

4a Click Add.

4b In the next dialog box, specify the following information for the server to add, then click 
Add.

 Server IP Address

 LDAP port 
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 Secure LDAP port

4c Click Add.

4d (Optional) Repeat Step 4a through Step 4c to add additional servers.

5 When all the LDAP servers that you want to specify are listed, click Next.

6 Continue with “Configuring Novell Open Enterprise Server Services” on page 148.

Configuring Novell Open Enterprise Server Services

After you complete the LDAP configuration or eDirectory configuration, the Novell Open 
Enterprise Server Configuration summary page is displayed, showing all the OES components you 
updated and installed and their configuration settings. 

1 Review the setting for each component and click the component heading to change any 
settings.
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When you specify the configuration information for OES services, see the information in 
“Configuration Guidelines for OES Services” on page 80; or, if you are reading online, click a 
link below:

 AFP

 Archive andVersion Servies

 Backup/Storage Management Services (SMS)

 CIFS

 Clustering (NCS)

 DHCP

 DNS

 Domain Servies for Windows (DSfW)

 eDirectory

 FTP

 iFolder

 iManager

 iPrint

 Linux User Mangement (LUM)

 NCP Server/Dynamic Storage Technology

 NetStorage
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 Pre-Migration Server

 QuickFinder

 Novell Remote Manger (NRM)

 Novell Samba

 Novell Storage Services

2 When you are satisfied with the settings for each component, click Next.

3 When you confirm the OES component configurations, you might receive the following error:

The proposal contains an error that must be resolved before continuing.

If this error is displayed, check the summary list of configured products for any messages 
immediately below each product heading. These messages indicate products or services that 
need to be configured. If you are running the YaST graphical interface, the messages are red 
text. If you are using the YaST text-based interface, they are not red.

For example, if you selected Linux User Management in connection with other OES products 
or services, you might see a message similar to the following:

Linux User Management needs to be configured before you can continue or 
disable the configuration.

If you see a message like this, do the following:

3a On the summary page, click the heading for the component.

3b Supply the missing information in each configuration page.

When you specify the configuration information for OES services during the upgrade, see 
the information in “Configuration Guidelines for OES Services” on page 80.

When you have finished the configuration of that component, you are returned to the 
Novell Open Enterprise Server Configuration summary page.

3c If you want to skip the configuration of a specific component and configure it later, click 
Enabled in the Configuration is enabled status to change the status to Configuration is 
disabled. 

If you change the status to Configuration is disabled, you must configure the OES 
components after the installation is complete. See “Installing or Configuring OES 2 SP3 
on an Existing Server” on page 113.

4 After resolving all product configuration problems, click Next to proceed with the 
configuration of all services and installation of iManager plug-ins.

5 When the Readme page displays, click Next and continue with Section 5.5, “Finishing the 
Upgrade,” on page 150.

5.5  Finishing the Upgrade
After a successful configuration, YaST shows the Installation Completed page.

1 Deselect Clone This System for AutoYaST. Cloning is selected by default.

This increases the speed of finishing the installation update. 

AutoYaST is a system for automatically installing one or more SUSE Linux Enterprise systems 
without user intervention. Although you can create a profile from a system that has been 
upgraded, it does not work to upgrade a similar system.

2 Finish the upgrade by clicking Finish on the Installation Completed page.
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3 If you have upgraded a server that has NSS pools and volumes on the system device (the device 
that contains the root (/), /boot, and swap partitions), you must do the following:

3a Verify that the /etc/fstab file is correct. For example, make sure that the path to /boot 
is complete; that is /dev/evms/sda1 (or hda1) and not just /dev/evms. If the path to the 
/boot partition is incomplete or doesn’t contain /evms, change it and save the fstab file.

3b Open a terminal and run the following command to ensure that the initrd file is correctly 
created:

mkinitrd -f evms

3c Reboot the server before continuing with “Verifying That the Upgrade Was Successful” on 
page 151.

A script runs automatically during the OES 2 SP3 upgrade to install and enable 
boot.evms.

These changes are applied when you reboot your system after the upgrade is completed. 
Make sure that you reboot after the upgrade and before you do anything that would alter 
the changes made in this step.

4 After the server completes the upgrade, continue with “Verifying That the Upgrade Was 
Successful” on page 151. 

5.6  Post-Migration iManager Configuration
If Role-Based Services are configured in iManager, the Driver tab in iManager is missing after 
upgrading iPrint to OES 2 SP3. This is because support was added for Windows 7. To display the 
new Driver tab, see the instructions in TID 7004921 (http://www.novell.com/support/php/
search.do?cmd=displayKC&docType=kc&externalId=7004921&sliceId=2&docTypeID=DT_TID_
1_1&dialogID=66652408&stateId=1%200%2066654011).

5.7  Verifying That the Upgrade Was Successful
One way to verify that your OES server upgrade was successful and that the components are loading 
properly is to watch as the server boots. As each component is loaded, the boot logger provides a 
status next to it indicating if the component is loading properly. 

You can also quickly verify a successful installation by accessing the server from your Web browser.

1 In the Address field of your Web browser, enter the following URLs:

http://IP_or_DNS

Replace IP_or_DNS with the IP address or DNS name of your OES server.

You should see a Web page similar to the following:
Upgrading to OES 2 SP3 151

http://www.novell.com/support/php/search.do?cmd=displayKC&docType=kc&externalId=7004921&sliceId=2&docTypeID=DT_TID_1_1&dialogID=66652408&stateId=1%200%2066654011


152 OES 2
2 If you want to look at the eDirectory tree and begin to see how iManager works, click the 
Management Services home page, click Management Tools > iManager, and then log in as user 
Admin (the user you created during product installation).

You can also access iManager by typing the following URL in a browser window and logging 
in as user Admin:

http://IP_or_DNS_name/nps/iManager.html

3 Continue with “What's Next” on page 152.

5.8  What's Next
After you complete the upgrade and verify that it was successful, see “Completing OES Installation 
or Upgrade Tasks” on page 153 and “Updating (Patching) an OES 2 SP3 Server” on page 157.
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6Completing OES Installation or 
Upgrade Tasks

This section provides information for completing the following tasks:

 Section 6.1, “Determining Which Services Need Additional Configuration,” on page 153

 Section 6.2, “Rebooting the Server after Installing NSS,” on page 155

 Section 6.3, “Restarting Tomcat,” on page 155

 Section 6.4, “Launching and Configuring Firefox for Linux,” on page 155

6.1  Determining Which Services Need Additional 
Configuration

NOTE: For information on configuring OES services as a different administrator than the one who 
originally installed the OES server, see Section 2.5.3, “Adding/Configuring OES Services as a 
Different Administrator,” on page 24.

Depending on the products you have installed, there might be some tasks that you must complete 
before you can use individual service components.

For more information, see “Caveats for Implementing OES 2 Services” in the OES 2 SP3: Planning 
and Implementation Guide.

If a component requires additional configuration that is not part of the Novell Open Enterprise 
Server (OES) 2 Linux installation, see the component's administration guide for more information. 
The following table include links to the installation and configuration information for most OES 2 
SP3 services.

Table 6-1   OES 2 SP3 Services Additional Installation and Configuration Instructions

OES 2 SP3 Service For Additional Installation and Configuration Information

Domain Services for Windows See “Installing Domain Services for Windows” in the OES 2 SP3: 
Domain Services for Windows Administration Guide.

Novell AFP See “Installing and Setting Up AFP” in the  OES 2 SP3: Novell AFP For 
Linux Administration Guide.

Novell Archive and Version 
Services

See “Setting Up Archive and Version Services ” in the OES 2 SP3: 
Novell Archive and Version Services 2.1 Administration Guide.

Novell Backup/Storage 
Management Services (SMS)

See “Installing and Configuring SMS” in the OES 2 SP3: Storage 
Management Services Administration Guide.

Novell CIFS See “Installing and Setting Up AFPInstalling and Setting Up CIFS” in the 
OES 2 SP3: Novell CIFS for Linux Administration Guide.
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Novell Cluster Services See “Installing and Configuring Novell Cluster Services on OES 2 Linux” 
in the OES 2 SP3: Novell Cluster Services 1.8.8 Administration Guide 
for Linux.

Novell DHCP See “Installing and Configuring DHCP ” in the OES 2 SP3: Novell DNS/
DHCP Administration Guide.

Novell DNS See  “Installing and Configuring DNS ” in the OES 2 SP3: Novell DNS/
DHCP Administration Guide.

Novell eDirectory 8.8 See “Installing or Upgrading Novell eDirectory on Linux” in the Novell 
eDirectory 8.8 Installation Guide.

Novell iFolder 3.8 When you configure iFolder as part of the OES install and configuration, 
you can specify only an EXT3 or ReiserFS volume location for the 
System Store Path, which is where you are storing iFolder data for all 
your users. You cannot create NSS volumes during the system install.

If you want to use an NSS volume to store iFolder data, you must 
reconfigure iFolder after the initial OES installation. To reconfigure, use 
Novell iManager to create an NSS volume, then go to YaST > Open 
Enterprise Server > Install and Configure Open Enterprise Services and 
select iFolder 3.8 to enter new information. All previous configuration 
information is removed and replaced. 

See “Installing and Configuring iFolder Services” in the Novell iFolder 
3.8.1 Administration Guide.

Novell iManager 2.7.3 See “Installing iManager” in the Novell iManager 2.7 Installation Guide.

Novell iPrint See “Installing and Setting Up iPrint on Your Server” in the OES 2 SP3: 
iPrint for Linux Administration Guide.

Novell Linux User 
Management

See “Setting Up Linux User Management” in the OES 2 SP3: Novell 
Linux User Management Administration Guide.

Novell NCP Server See “Installing and Configuring NCP Server for Linux” in the OES 2 SP3: 
NCP Server for Linux Administration Guide.

Novell NetStorage See “Installing NetStorage” in the OES 2 SP3: NetStorage 
Administration Guide.

Novell QuickFinder See “Installing QuickFinder Server” in the OES 2 SP3: Novell 
QuickFinder Server 5.0 Administration Guide.

Novell Remote Manager See “Changing the Configuration” in the OES 2 SP3: Novell Remote 
Manager for Linux Administration Guide.

Novell Samba See “Installing the Novell Samba Components” in the OES2 SP3: 
Samba Administration Guide.

Novell Storage Services See “Installing and Configuring Novell Storage Services” in the OES 2 
SP3: NSS File System Administration Guide for Linux.

Pre-Migration Server See “Preparing for Transfer ID” in the OES 2 SP3: Migration Tool 
Administration Guide.

OES 2 SP3 Service For Additional Installation and Configuration Information
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6.2  Rebooting the Server after Installing NSS
If you install Novell Storage Services (NSS) on an existing OES server, enter rcnovell-smdrd 
restart at the command prompt or reboot the server before performing any backups, restores, or 
server consolidations on the NSS file system.

6.3  Restarting Tomcat
If you install iManager after the server has been installed, Tomcat is not running and you must 
restart it to run iManager.

To restart Tomcat, enter the following command at a command line prompt.

/etc/init.d/tomcat5 restart

6.4  Launching and Configuring Firefox for Linux
After upgrading from OES 2 to OES 2 SP3, you need to launch and configure Mozilla Firefox 
before accessing other applications via a URL.

For example, you cannot configure the Novell Customer Center from the YaST until Firefox is 
configured.

To configure Firefox: 

1 On the GNOME desktop, click Computer > Firefox.

or

On the KDE desktop, click the Main Menu icon > Browse > Web Browser > Firefox.

2 When Firefox opens, configure the browser by supplying all of the information that it requests. 
After Firefox is ready to browse the Internet, it is also ready to be used with OES.
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7
7Updating (Patching) an OES 2 SP3 
Server

Updating an Novell Open Enterprise Server (OES) 2 SP3 Linux server is essentially the same as 
updating a SUSE Linux Enterprise Server (SLES) 10 SP4 server except that you apply patches for 
both SLES 10 SP4 and OES 2 SP3.

To update your server with the patches released from Novell requires you to perform the following 
tasks during the installation or upgrade or after the installation or upgrade is complete. The 
instructions in this section are for patching the server after the installation or upgrade is complete.

 Section 7.1, “Overview of Updating (Patching),” on page 157

 Section 7.2, “Preparing the Server for Updating,” on page 158

 Section 7.3, “Registering the Server in the Novell Customer Center,” on page 159

 Section 7.4, “Updating the Server,” on page 163

 Section 7.5, “Verifying That Your Channel Subscriptions Are Up-to-Date,” on page 173

 Section 7.6, “Frequently Asked Questions about Updating,” on page 173

 Section 7.7, “Patching From Behind a Proxy Server,” on page 174

 Section 7.8, “Quick Path Updating,” on page 175

7.1  Overview of Updating (Patching)
 Section 7.1.1, “The Patch Process Briefly Explained,” on page 157

 Section 7.1.2, “Update Options,” on page 158

7.1.1  The Patch Process Briefly Explained

The OES 2 patch process consists of the following processes:

1. The patch tool (rug, Software Updater, or YaST Online Update [YOU]) checks for available 
patches on its configured patch channels and displays them for selection.

2. The patch administrator selects which patches to apply.

3. The patch tool checks cross-dependencies and displays any messages regarding situations or 
conflicts that require administrator input.

4. The patches are downloaded.

If any downloaded patches contain information or instructions, these are displayed for 
administrator acknowledgement. For example, administrators might be instructed to restart a 
service or run a configuration script file to complete the process after the patch process 
completes. 

5. After all of the messages have been acknowledged, the downloaded patches are installed.

6. If the kernel was updated, the administrator is prompted to restart the server.
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7.1.2  Update Options

OES 2 administrators have three options for updating servers with patches from Novell.

 ZENworks Linux Management: An enterprise-level product that requires a separate license. 
It provides updates for SUSE Linux Enterprise, OES, and Red Hat Enterprise Linux (RHEL) 
products. In addition to hosting updates for download, ZENworks Linux Management is also 
capable of pushing the updates to targeted devices through a single Web interface. For more 
information about ZENworks Linux Management, see its product page on Novell.com (http://
www.novell.com/products/zenworks/linuxmanagement/).

 Subscription Management Tool (SMT) for SUSE Linux Enterprise: This product doesn’t 
require a separate license. It lets you host patches from the Novell online update channel on an 
internal server, which provides more security and greatly reduces Web traffic related to server 
updates. SMT is available for download on the Novell Download Site (http://
download.novell.com/Download?buildid=5YxjWD8_ZZk~).

 Novell Online Update Servers: For those who don’t require an internal update source, OES 2 
servers can be easily configured to directly access the online patch channel. Instructions for 
doing this are included in the sections that follow.

7.2  Preparing the Server for Updating
1 Make sure you have installed all the services that you need on the server.

2 Before starting your update, make note of the root partition and available space.

If you suspect you are running short of disk space, secure your data before updating and 
repartition your system. There is no general rule regarding how much space each partition 
should have. Space requirements depend on your particular partitioning profile and the 
software selected.

The df -h command lists the device name of the root partition. In the following example, the 
root partition to write down is /dev/hdb2 (mounted as /).

Example: List with df -h.

In particular, ensure that you have enough space where the update process downloads all the 
updates to in /var/cache/zmd/.

Depending on the number of patches that you are going to apply, you might need about 3 GB 
for OES 2 SP3.

3 Before updating the server, secure the current data on the server.

Copy all configuration files to a separate medium, such as a streamer, removable hard disk, 
USB stick, or ZIP drive. This primarily applies to files stored in /etc as well as some of the 
directories and files in /var and /opt. You might also want to write the user data in /home (the 
HOME directories) to a backup medium. Back up this data as root. Only root has read 
permission for all local files.
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7.3  Registering the Server in the Novell 
Customer Center
Before you can patch an OES 2 SP3 server with updates from Novell, you must register the server 
either during installation or later by using the instructions in this section. 

If you register through evaluation codes, your server can receive patches for only 60 days, at which 
time the codes expire. 

You need to register each server with the Novell Customer Center only once. After you have 
registered the server, you can update the server at any time. This includes replacing evaluation codes 
with purchased codes. You can use the desktop interface (GUI) or the command line to accomplish 
this task.

This section contains the following information:

 Section 7.3.1, “Prerequisites,” on page 159

 Section 7.3.2, “Registering the Server in the Novell Customer Center (Command Line),” on 
page 159

 Section 7.3.3, “Registering the Server in the Novell Customer Center (GUI),” on page 160

7.3.1  Prerequisites

To complete these procedures, you must have the following:

 A Novell Customer Center account or access to an account.

For more information about creating a Novell Customer Center account, see “Creating an 
Account” in the Novell Customer Center User Guide (http://www.novell.com/documentation/
ncc/ncc/data/b5exp8k.html#b5exj2f). (This is the same account that you use for Bugzilla.)

 The activation codes for SLES and OES 2 SP3 that you received when you purchased your 
product.

 An established connection to the Internet. 

7.3.2  Registering the Server in the Novell Customer Center 
(Command Line)

To register a new server or to replace evaluation activation codes with standard codes.  

1 Log in to the server as root or su to root

2 At the command line, enter

suse_register -a email=email_address -a regcode-sles=SLES_registration_code -a 
regcode-oes=oes2_registration_code 

For example:

suse_register -a email=joe@example.com -a regcode-sles=4adab769abc68 -a 
regcode-oes=30a74ebb94fa

IMPORTANT: If you are replacing evaluation codes with purchased codes, simply enter the  
codes. No further action is required.
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3 Verify that the server is registered by checking whether you have the service types and catalogs 
needed for updates:

3a To verify the service type, enter

rug sl

The results should be similar to the following:

The URIs you see for the ZYPP type differ based on your installation source.

3b To verify the catalogs, enter

rug ca

The results should be similar to the following:

7.3.3  Registering the Server in the Novell Customer Center 
(GUI)

1 In the YaST Control Center, click Software > Novell Customer Center Configuration.

2 On the Novell Customer Center Configuration configuration page, select all of the following 
options, then click Next.

 Configure Now: Proceeds with registering this server and the OES product with the 
Novell Customer Center.

 Hardware Profile: Sends information to the Novell Customer Center about the hardware 
that you are installing SLES 10 SP4 and OES 2 on.

 Optional Information: Sends optional information to the Novell Customer Center for 
your registration. For this release, this option doesn’t send any additional information.

 Registration Code Makes the registration with activation codes mandatory.
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 Regularly Synchronize with the Customer Center: Keeps the installation sources for 
this server valid. It does not remove any installation sources that were manually added.

After you click Next, the following message is displayed. Wait until this message disappears 
and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields:

 Email Address: The e-mail address for your Novell Login account.

 Confirm Email Address: The same e-mail address for your Novell Login account

 Activation Code for SLES Components (optional): Specify your purchased or 60-day 
evaluation registration code for the SLES SP4 product.

If you don’t specify a code, the server cannot receive any updates or patches. 

 Activation Code for OES Components (optional): Specify your purchased or 60-day 
evaluation registration code for the OES product.

If you don’t specify a code, the server cannot receive any updates or patches. 

 System Name or Description (optional): The hostname for the system is specified by 
default. If you want to change this to a description for the Novell Customer Center, specify 
a description to identify this server.

5 Click Submit.

6 When the message to complete the registration displays, click Continue.
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After you click Continue, the following message is displayed with the Manual Interaction 
Required page. Wait until this message disappears and the Novell Customer Center 
Configuration Was Successful page displays.

7 When you see the message that the Novell Customer Center was successful, click OK.

When the registration is successful, the server is registered in the Novell Customer Center and the 
installation sources for patches are configured on the server.
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7.4  Updating the Server
After the server has been registered in the Novell Customer Center, you can apply updates via 
packages and patches. The default GNOME desktop indicates when there are updates available to 
the server. You can update the server from any of the following interfaces.

 Section 7.4.1, “Updating the Server Base from SLES 10SP3 to SLES10 SP4,” on page 163

 Section 7.4.2, “Updating the Server by Using the Command Line,” on page 164

 Section 7.4.3, “Updating the Server from the GNOME or KDE Desktop,” on page 171

7.4.1  Updating the Server Base from SLES 10SP3 to SLES10 
SP4

Prerequisites 

 Ensure you have enough disk space in /var/cache/zmd where the update process downloads 
all the updates to.

 Register the SLES 10 SP 3 server in the Novell Customer Center.

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 121.

2 Install the move-to-sles10-sp4 patch on the server. This is an optional patch and will never 
be installed automatically.

 If you are using rug, enter the following command at a terminal prompt:

rug in -t patch move-to-sles10-sp4 && rug ping -a

 If you are using the GUI Software Updater, click Software Updater, then select the move-
to-sles10-sp4 patch, and click Update.

3 Answer all of the prompts in the affirmative until the move-to-sles10-sp4 patch is installed. 

4 Verify that the SUSE-Linux-Enterprise-Server-SP4-migration, 
OPEN_ENTERPRISE_SERVER_SP3 and SUSE_SLES_SP3 products are installed along with 
their associated channels by entering the following command at a terminal prompt:

rug pd -i

5 Install the recommended patches that are in the channels using  rug up -t patch -g 
recommended  && rug ping -a

6 Repeat Step 5, answering all of the prompts in the affirmative until you are prompted to reboot 
server.

7 (Optional) Create an answer file. See “Creating a Password Answer File” on page 130.

8 Reboot the server.

9 If you did not provide a password answer file (“Creating a Password Answer File” on 
page 130), you must enter the passwords for the LDAP (eDirectory) Admin user and (if 
applicable) the DSfW Domain Administrator to start the configuration process. 

If you provided an answer file, the service configuration process continues automatically. 
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IMPORTANT: If an error occurs, for example if the wrong password is entered, you can rerun 
the configuration phase again by either 

Rebooting the server

or 

Entering the following command at a terminal prompt:

sudo yast2 channel-upgrade-oes

10 Various messages indicate the services being configured. When the Login prompt appears, 
verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 110.

11 Verify that the base has changed to SLES 10 SP4 by using the SPident --vv command.  
Ensure that the output does not throw up any conflicts. 

NOTE: If the message NOT upto date is displayed when you run the SPident (Service Pack 
Identification) tool, then install the latest rpms of fuse, libfuse2, and ruby using the following 
commands:

1. rug in fuse  

2. rug in libfuse2

3. rug in ruby

12 Complete the server setup by following the procedures in “Completing OES Installation or 
Upgrade Tasks” on page 153.

7.4.2  Updating the Server by Using the Command Line

After you have registered the server in the Novell Customer Center, you can update the server by 
using commands at the command line. The following procedure specifies steps for updating the 
server with all available patches for SLES 10 SP4 and OES 2 SP3.

1 Log in to the server as root or su to root.

2 At the command line, enter the following commands. The screen shots show example output.

2a Refresh all services:

rug ref

2b See whether updates are available for SLES 10 SP4 and OES 2 SP3:

rug lu catolog1 catalog2

For example:

rug lu SLES10-SP4-Updates OES2-SP3-Updates

 No updates available:
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 Updates available:

2c Update the server with all available SLES10 SP4 and OES 2 SP3 patches:

rug up -t patch SLES10-SP4-Updates OES2-SP3-Updates
Updating (Patching) an OES 2 SP3 Server 165



166 OES 2
2d Repeat Step 2b and Step 2c until no more updates are available.

2e To finish the update, reboot the server.

Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.

You can also update your server with specific maintenance patches by using commands at the 
command line:

1 Log into the server as root or su to root.

In the steps that follow, screen shots show example output.

2 Refresh all services

rug ref

3 See whether updates are available, see a list of patches and their status, or see information for a 
specific patch: 

 See whether patches are available:

rug lu catalog1 catalog2

 No updates available in the specified catalogs:
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 Updates available in the specified catalogs:

 See a list of patches from all catalogs and their status:

rug pch
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 See a list of all installed patches:

rug pch -i

 Before patches are installed:

 After two patches are installed:

 After all patches have been installed:

 See a list of all installed patches:

rug pch -i

 Before patches are installed:

 After two patches are installed:
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 After all patches have been installed:

 See information for a specific patch:

rug patch-info patch_name

For example:

rug patch-info oes2-oes-SPident

4 Update the server with specific patches:

 Install all patches from the one or more catalogs of a particular category, such as:

 security
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 recommended

 optional

rug up -t patch catalog1 catalog2 -g category_name

For example:

rug up -t patch SLES10-SP4-Updates OES2-SP3-Updates -g security

 Install one version of a patch without confirmation:

rug in -t patch -y patchname-version

For example:

rug in -t patch -y oes2-CASA-3904-0

 Install all versions of a patch with confirmation:

rug in -t patch patch_name*

For example:

rug in -t patch oes2-oes-SPident*
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5 To finish the update, reboot the server.

Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.

The following table shows some additional commands you might want to use:

Table 7-1   Additional Rug Commands

7.4.3  Updating the Server from the GNOME or KDE Desktop

1 Log into the server as root or su to root.

2 Click the Novell Updater icon , which indicates that updates are available

On the GNOME Desktop, the icon is on the taskbar.

On the KDE Desktop, click G > System > Novell Updater icon 

If no updates are available, the Novell Updater icon changes appearance to a globe. 

3 On the Software Available for Updates page, select the updates that you want to install, then 
click Update. 

Updates that have a Security or Recommended status are usually preselected.

Task Command

 Halts the ZLM daemon. Accepts the following option flags:

  -f, --force: Force the shutdown.

 -n, --no-wait: Don’t wait for confirmation that the daemon was shut 
down.

rug shutdown [options]

Restarts the ZLM daemon. Accepts the following option flags:

  -f, --force: Forc

 -n, --no-wait: Does not wait for confirmation that the daemon has 
restarted.

  --clean: Cleans up at restart

rug restart [options]

Access help for all the rug commands rug

Access the rug man page man rug
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4 When the Software Updater Information status indicates that the update was successful, click 
Close.

5 If necessary, rerun the updater until all the desired patches have been installed.

6 To finish the update, reboot the server.

Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.
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7.5  Verifying That Your Channel Subscriptions 
Are Up-to-Date
When an OES 2 server is updated properly, the update channel list is refreshed to include Updates 
entries for your OES 2 and SLES 10 versions. 

To verify that you have updates from both update channels:

1 At a terminal prompt on the server you have updated, enter the following command:

rug ca

The list of channels should include Updates channels for your OES 2 and SLES 10 versions. 
For example, after updating an OES 2 SP3 server, the channel listing should include both 
SLES10-SP4-Updates and OES2-SP3-Updates as subscribed channels.

2 If the channel listing on your server doesn’t include the updates channels for your OES 2 and 
SLES 10 versions, follow the instructions in TID 3150078 (http://www.novell.com/support/
php/
search.do?cmd=displayKC&docType=kc&externalId=3150078&sliceId=2&docTypeID=DT_
TID_1_1&dialogID=76715112&stateId=0%200%2076711680) to resolve the issues. 

3 After the channel list contains the correct entries, update your server by repeating the pertinent 
instructions in Section 7.4, “Updating the Server,” on page 163.

7.6  Frequently Asked Questions about Updating
This section contains the following information:

 Section 7.6.1, “Do I apply all the patches in the catalogs? How do I know which patches to 
apply?,” on page 173

 Section 7.6.2, “How do I re-add the catalogs for OES 2 in my ZENworks Management 
Daemon configuration after removing one or more of them?,” on page 174

 Section 7.6.3, “What about YaST Online Update?,” on page 174

7.6.1  Do I apply all the patches in the catalogs? How do I know 
which patches to apply?

In OES 1, we recommended that all the patches in the channel be applied. However, in OES 2 the 
dependency checking has been improved to help you understand more about each patch listed in the 
catalogs.

Each patch has a category and a status associated with it. The categories state whether the patch is a 
security patch, a recommended patch, or an optional patch. The rug pch command shows whether 
the patch is needed or not needed and whether it has been applied. When you are using the Novell 
Updater, only the patches that are needed and have not been applied display in the list of patches.

Therefore, you can just apply all the security patches and wait to apply other patches that might 
change how a feature or product works.
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7.6.2  How do I re-add the catalogs for OES 2 in my ZENworks 
Management Daemon configuration after removing one or 
more of them?

To re-add the catalogs and services needed for updating your version of OES 2 to the ZENworks 
Management Daemon configuration:

1 Delete the /var/cache/SuseRegister/lastzmdconfig.cache file.:

rm /var/cache/SuseRegister/lastzmdconfig.cache

2 At the command line, enter

suse_register -a email=email_address -a regcode-sles=SLES_registration_code -a 
regcode-oes=oes2_registration_code 

For example,

suse_register -a email=joe@example.com -a regcode-sles=4adab769abc68 -a 
regcode-oes=30a74ebb94fa

Performing this procedure removes the complete ZENworks Management Daemon 
configuration, then registers the server in the Novell Customer Center again. When you register 
the server in the Novell Customer Center again, it adds all the catalogs and services that are 
need for updating your version of OES 2.

7.6.3  What about YaST Online Update?

 Novell supports two mechanisms for updating an OES 2 server:

 The rug utility from a terminal prompt.

 The Novell Updater from a GUI desktop.

However, some OES administrators prefer to use YaST Online Update (YOU) for updating OES 2 
servers. Although YOU is not tested by OES 2 product testers, the only customer problems reported 
to Novell occur when someone tries to use both the rug-based methods and the YOU method in 
combination on the same server.

IMPORTANT: Whichever method (YOU or rug-based) you choose for a given OES 2 SP3 server, 
that method must be used exclusively for the life of the server.

For more information about using YOU to update your servers, see “YaST Online Update” (http://
www.suse.com/documentation/sles10/book_sle_reference/?page=/documentation/sles10/
book_sle_reference/data/sec_yast2_sw.html) in the SLES 10 Administration Guide.

7.7  Patching From Behind a Proxy Server
See TID 3132246 (http://www.novell.com/support/
viewContent.do?externalId=3132246&sliceId=2).
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7.8  Quick Path Updating
This section contains the following Quick Path steps for patching an OES 2 server:

 Section 7.8.1, “Do Not Use rug up without the -t Option,” on page 175

 Section 7.8.2, “Command Line Quick Path for Updating OES 2,” on page 175

 Section 7.8.3, “GUI Quick Path for Updating OES 2 SP3,” on page 177

7.8.1  Do Not Use rug up without the -t Option

Do not use the rug up command by itself to update an OES server. Always use the -t patch option 
as described in Section 7.8.2, “Command Line Quick Path for Updating OES 2,” on page 175. 

If the -t patch option is omitted, rug includes SLES packages in the download that can cripple or 
completely break OES services.

The -t patch option also ensures that patch metadata (including script files, etc.) is downloaded so 
that SLES can correctly update the system.

7.8.2  Command Line Quick Path for Updating OES 2

1 Make sure you have the following:

 A Novell Customer Center account

If you don’t have one, create it at http://www.novell.com/register. This is the same account 
that you use for Bugzilla.

 Activation Codes for both SLES 10 and OES 2

 A valid installation source

 An established connection to the Internet

 All of the services installed that you need on the server.

 Enough disk space in /var/cache/zmd/ where the update process downloads all the 
updates to. 

Depending on the number of patches that you are going to apply, you might need about 3 
GB.

 A backup of the current data on the server.

2 Register the server in the Novell Customer Center (one time only).

2a Log in to the server as root or su to root.

2b At the command line, enter

suse_register -a email=email_address -a regcode-sles=SLES_registration_code -a 
regcode-oes=oes2_registration_code 

For example,

suse_register -a email=joe@example.com -a regcode-sles=4adab769abc68 -
a regcode-oes=30a74ebb94fa

2c Verify that the server is registered by checking to see whether you have the service types 
and catalogs needed for updates.

To verify the service types, enter:
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rug sl

To verify that you have the catalogs you need, enter:

rug ca

3 Update the server with all available updates:

3a Refresh all services by entering:

rug ref

3b See whether updates are available by entering:

rug lu SLES10-SP4-Updates OES2-SP3-Updates

3c Update the server with all available SLES 10 SP4 and OES 2 SP3 patches by entering:

rug up -t patch SLES10-SP4-Updates OES2-SP3-Updates

3d Repeat Step 3b and Step 3c until there are no more SLES 10 SP4 or OES 2 SP3 patches.

When there are no more patches, continue with Step 3e.

3e Reboot the server to finish the update.

Rebooting the server activates the new kernel and ensures that OES services that need 
restarting after patching are restarted.

You can also update your server with specific maintenance patches.

1 Log in to the server as root or su to root.

2 At the command line, enter the following commands:

2a To refresh all services, enter:

rug ref

2b To check for available updates, enter:

rug lu SLES10-SP4-Updates OES2-SP3-Updates

2c To list the patches and their status, enter:

rug pch SLES10-SP4-Updates OES2-SP3-Updates

2d To view specific patch information, enter:

rug patch-info patch_name

For example:

rug patch-info slesp1-xpdf

2e To list all installed patches, enter:

rug pch -i

2f To update the server with specific patches, choose from the following:

 To install all patches from one or more catalogs of a particular category:

rug up -t patch catalog1 catalog2 -g category_name

Replace category_name with security, recommended, or optional.

For example:

rug up -t patch SLES10-SP4-Updates OES2-SP3-Updates -g security 

 To install one version of a patch without confirmation, enter:
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rug in -t patch -y patch_name-version

For example:

rug in -t patch -y oes2-CASA-3904-0

 To install all versions of a patch, enter:

rug in -t patch patch_name*

For example:

rug in -t patch oes2-oes-SPident*

2g Reboot the server to ensure that any changes to the kernel are activated, and applicable 
OES 2 services are restarted.

The following table shows some additional commands you might want to use:

Table 7-2   Additional Rug Commands

7.8.3  GUI Quick Path for Updating OES 2 SP3

To update your server with the patches released from Novell after the server has been installed and 
configured:

1 Make sure you have the following:

 A Novell Customer Center account (If you don’t have one, create it at http://
www.novell.com/register. This is the same account that you use for Bugzilla.)

 Activation Code for SLES 10 and OES 2 SP3

 A valid installation source

 An established connection to the Internet

 Make sure you have installed all the services that you need on the server.

 Before starting your update, make note of the root partition and space available.

Task Command

 Halts the ZLM daemon. Accepts the following option flags:

  -f, --force: Force the shutdown.

 -n, --no-wait: Don’t wait for confirmation that the daemon was shut 
down.

rug shutdown [options]

Restarts the ZLM daemon. Accepts the following option flags:

  -f, --force: Forces the shutdown.

 -n, --no-wait: Does not wait for confirmation that the daemon has 
restarted.

  --clean: Cleans up at restart

rug restart [options]

Access help for all the rug commands rug

Access the rug man page man rug
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In particular, ensure you have enough space where the update process downloads all the 
updates to in /var/cache/zmd/. Depending on the amount of patches that you are going 
to upgrade, you might need about 3 GB.

 Before updating the server, secure the current data on the server.

2 Register the server in the Novell Customer Center. 

If the server is already registered in the Novell Customer Center, skip to Step 3.

2a In the YaST Control Center, click Software > Novell Customer Center Configuration.

2b On the Novell Customer Center Configuration configuration page, select all of the 
following options, then click Next.

 Configure Now

 Hardware Profile

 Optional Information

 Registration Code

 Regularly Synchronize with the Customer Center

After you click Next, a Contacting Server message is displayed. Wait until this message 
disappears and the Manual Interaction Required page displays.

2c On the Manual Interaction Required page, note the information that you will be required 
to specify, then click Continue.

2d On the Novell Customer Center Registration page, specify the required information in 
each field, then click Submit.

2e When the message to complete the registration displays, click Continue. After you click 
Continue, the Contacting Server message is displayed with the Manual Interaction 
Required message. Wait until this message disappears and Novell Customer Center 
Configuration Was Successful page displays.

2f When you see the message that the Novell Customer Center was successful, click OK.

2g Confirm that you get the registration e-mails from the Novell Customer Center. You can 
perform Step 3 before you receive these e-mails.

3 Update the server from GNOME Desktop or KDE desktop:

3a Log into the server as root.

3b Click the Novell Updater icon  that indicates that updates are available. If no updates are 
available, the Novell Updater icon  changes appearances to a globe. 

3c In the Software Available for Updates list of patches, select the updates that you want to 
install, then click Update.

3d When the Software Updater Information status indicates that the update was successful, 
click Close.

3e Repeat Step 3c and Step 3d until all available patches are applied.

3f Reboot the server to finish the update.

Rebooting the server activates the new kernel and ensures that OES services that need 
restarting after patching are restarted.
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8Using AutoYaST to Install and 
Configure Multiple OES Servers

If you need to install OES to multiple systems that perform similar tasks and that share the same 
environment and similar but not necessarily identical hardware, you might want to use AutoYaST to 
perform the installation. 

To use AutoYaST, first you use the Configuration Management tool (YaST > Miscellaneous > 
Autoinstallation) to generate an XML profile file (referred to as a control file) and use it to perform 
OES installations to multiple servers that share the same hardware and environments. You can also 
tailor this control file for any specific environment. You then provide this control file to the YaST2 
installation program.

This section does not provide complete AutoYaST instructions. It provides only the additional 
information you need when setting up AutoYaST to install multiple OES 2 SP3 servers.

For complete instructions on using AutoYaST2, see Automatic Linux Installation and Configuration 
with Yast2 (http://www.suse.de/~ug/autoyast_doc/index.html). You can also access the 
documentation locally on an OES server in /usr/share/doc/packages/autoyast2/html/
index.html or autoyast.pdf.

This section contains the following information:

 Section 8.1, “Security Considerations,” on page 179

 Section 8.2, “Prerequisites,” on page 179

 Section 8.3, “Setting Up a Control File with OES Components,” on page 180

 Section 8.4, “Setting Up an Installation Source,” on page 186

8.1  Security Considerations
See “Password for User Admin Written in Clear Text in control.xml” on page 231.

8.2  Prerequisites
You need at least the following components to install an OES 2 SP3 server by using AutoYaST:

 A server with OES 2 SP3 already installed.

 One or more target computers to install the server software to and the following information 
about each:

 Number of hard disks

 MAC address

 Monitor types and graphics hardware

 A control file.

For information on setting up a control file with OES components, see “Setting Up a Control 
File with OES Components” on page 180.
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 A boot scenario set up.

You can boot from media or from an installation source. For more information, see “Setting Up 
an Installation Source” on page 186.

 A source or server that contains the AutoYaST profile (control file).

For more information, see “Setting Up an Installation Source” on page 186.

8.3  Setting Up a Control File with OES 
Components
The control file is an XML file that contains an installation profile for the target computer. This 
installation profile contains all the information to complete software installation and configuration 
on the target computer.

To create a control file:

 You can create the control file manually in a text editor (not recommended).

 When you complete an installation, you can click Clone for AutoYaST. If you use this option, 
the resulting file is /root/autoinst.xml. This file must be edited manually before using it. 
See Section 8.3.1, “Fixing an Automatically Created Control File,” on page 180.

 You can create or modify a control file by using the AutoInstallation module in YaST. For 
procedures, see Section 8.3.2, “Using the AutoInstallation Module to Create the Control File,” 
on page 181.

This system depends on existing modules that are usually used to configure a computer after 
OES 2 SP3 is installed on a server.

8.3.1  Fixing an Automatically Created Control File

Review the following issues and solutions to fix the automatically created control file.

 Issue 1:  If you install all OES Services through AutoYaST, Apache does not run.

Solution:  Reboot the server when the installation is complete; or, when you create the profile 
or control file, deselect the Print Server pattern in the Primary Functions category. If you have 
already created the control file, remove the following section:

- <printer>
  <cups_installation config:type="symbol">server< cups_installation>
  <default />
  <printcap config:type="list" />
  <server_hostname />
  <spooler>cups</spooler>
  </printer>

 Issue 2:  The Certificate Authorities section of the control file is not created. 

Solution:  You must insert the CA section manually. 

To add this information to the control file:

1. Open YaST as root.

2. Click Miscellaneous > Autoinstallation.

3. Select Security and Users > CA Management, then click Configure.
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4. In the Common Name File field, specify a name for the certificate. For example 
YaST_Default_CA(hostname).

5. Specify an e-mail name in the Email field.

6. Specify a password in the Password field.

7. Click File > Save to save the file. Ignore any error messages that you receive.

8. Click View Source to ensure that the CA entry was entered.

It should look similar to the following:

<ca_mgm>
    <CAName>YaST_Default_CA</CAName>
    <ca_commonName>YaST_Default_CA(hostname)</ca_commonName>
    <country>US</country>
    <importCertificate config:type="boolean">false</importCertificate>
    <locality></locality>
    <organization></organization>
    <organizationUnit></organizationUnit>
    <password>actual_password</password>
    <server_email>name@example.com</server_email>
    <state></state>
    <takeLocalServerName config:type="boolean">true</takeLocalServerName>
  </ca_mgm>

 Issue 3:  If you install Novell Cluster Services, one package does not install correctly.

Solution:  Comment out the following line in the control file.

<package>novell-cluster-services-kmp-smp</package>

For example:

<!--<package>novell-cluster-services-kmp-smp</package>-->

 Issue 4:  If you did not patch the server during the installation, the OES product is not 
identified correctly in the control file.

Solution:  When creating the profile or control file, change the product line from:

<product>Novell Open Enterprise Server 2</product> 

to

<product>OPEN_ENTERPRISE_SERVER</product>

8.3.2  Using the AutoInstallation Module to Create the Control 
File

The following procedure contains a quick list of steps to create the control file by using the 
AutoInstallation module in YaST on a server running OES 2.

1 On a server that has OES 2 installed, Click Computer > YaST Administrator Settings.

2 Click Miscellaneous > Autoinstallation.

The AutoYaST Configuration Management System application window opens, referred to 
hereafter as the main window. 

3 Click Tools > Create Reference Profile.

4 In the Create a Reference Control File dialog box under Select Additional Resources, select the 
Network card check box, then click Create.
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AutoYaST probes the server it is running on for software, partitioning, boot loader, network 
card information, language settings, mouse, and other system settings. After the information 
has been collected, the status messages cease and only the main window is displayed.

5 Verify the package selections:

5a In the left frame of the main window, click Software, then under Available Modules, click 
Package Selection.

5b On the Package Selection page, make sure the items are the same as you previously 
installed on the server. For more information on the add-ons (software selections) that are 
selected in the base selections or patterns, see “Deciding What Patterns to Install” on 
page 30. If the configuration contains the packages and selections you need, skip to 
Step 7. If not, continue with Step 6.

6 If necessary, change the package selections for the target servers:

6a In the Package Selection dialog box, click Configure.

6b On the Software Selection page, click Patterns in the Filter field.

6c Select the specific software items that you want to be added, then click Accept.

6d If you are prompted to accept the AGFA Monotype Corporation End User License 
Agreement, click Accept.

6e Accept the automatic changes by clicking Continue in the Changed Packages dialog box.

7 Specify the Partitioning parameters for the target server:

7a In the left frame of the main window, click Hardware, under Available Modules, click 
Partitioning, then click the Configure button.

7b Set up partitioning on the first drive as desired, then click Finish. 

See the online help for details about limitations.

For more information on partitioning options, see “Partitioning” in Automatic Linux 
Installation and Configuration with Yast2 (http://www.suse.de/~ug/autoyast_doc/
index.html).

8 Specify the settings for the graphics card and monitor:

8a In the left frame of the main window, click Hardware, under Available Modules, click  
Graphics Card and Monitor, then click the Configure button.

8b In the General Options field of the X11 Configuration page, specify the settings that you 
want.

8c In the Desktop field of the X11 Configuration page, select the settings that you want for 
the Display Manager and Window Manager, then click Next.

8d On the Configure Monitor page, select the applicable monitor vendor and model, then 
click Next.

8e Verify the X11 settings. If they are not correct, repeat Step 8a and Step 8d.

If you skip this step, the server keyboard mappings might be German.

9 (Optional) Insert a script to perform a task that you want, such as a script for removing 
partitions:

For more information on custom user scripts, see “Custom User Scripts” (http://www.suse.de/
~ug/autoyast_doc/createprofile.scripts.html)in Automatic Linux Installation and Configuration 
with Yast2.

9a In the main window, click Miscellaneous > Custom Scripts > Configure.
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9b On the User Script Management page, click New.

9c In the File Name field, specify a descriptive name for the script, such as 
hello_world_script.

9d In the Script Source field, specify commands such as the following example script:

#!/bin/sh
‘echo "hello world" > /tmp/post-script-output'

9e Click the Type drop-down box, then select Post.

This script runs after the installation is complete. For additional options, see the online 
help for this dialog box.

9f Click Save.

9g Make sure your script appears in the Available Scripts section of the User Script 
Management page, then click Finish.

9h Make sure your script appears in the Post Scripts section of the Custom Scripts page.

10 Set the password for the root user:

10a From the main window, click Security and Users > User Management > Configure.

10b Click Set Filter, then select Select System Users from the drop-down menu.

10c Select user root, then click Edit.

10d Type a password for the root user in the Password and Verify Password fields, click 
Accept, then click Finish.

10e Verify that the root user appears in the Users section of the User Management dialog 
box.

11 Set a password for Certificate Authority management:

11a From the main window, click Security and Users > CA Management > Configure.

11b Type a password for the certificate in the Password and Confirm Password fields, then 
click Finish.

11c Verify that the Password status appears as Set on the CA Management page.

12 Configure OES Services:

12a From the main window, click Open Enterprise Server > module_name > Configure.

All OES services are in the Open Enterprise Server category. 

We recommend configuring eDirectory first. Although there are dependencies for some of 
the components, in this release AutoYaST does not verify whether one module is 
configured or not.

See the following table for category names and dependencies. You should configure all 
the modules that were selected for the software selections in Step 5 on page 182. For more 
information about which modules are in each pattern, see “Deciding What Patterns to 
Install” on page 30.
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Pattern Other Module Dependencies

Novell AFP  Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell Storage Services (NSS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Archive and 
Version Services

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

 Novell Storage Services (NSS)

Novell Backup/
Storage Management 
Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell CIFS  Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell Storage Services (NSS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Cluster 
Services (NCS)

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell DHCP  Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell DNS  Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Domain 
Services for Windows

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory

 Novell DNS

 Novell iManager

 Novell iPrint

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

 Novell Storage Services (NSS)

 Novell NCP Server
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Novell eDirectory  Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell FTP  Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell iFolder  Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell iManager  Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell iPrint  Novell Backup/Storage Management Services (SMS)

 Novell eDirectory 

 Novell iManager

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Linux User 
Management (LUM)

 Novell Backup/Storage Management Services (SMS)

 Novell Remote Manager (NRM)

Novell NCP Server / 
Dynamic Storage 
Technology

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell NetStorage  Novell Backup/Storage Management Services (SMS)

 Novell iManager

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Pre-Migration 
Server

 Novell Backup / Storage Management Services (SMS)

 Novell eDirectory (without a replica)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell QuickFinder  Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Pattern Other Module Dependencies
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12b Type or select the information for each field requested on each page, then click Next until 
a summary of settings is displayed for that service.

12c Verify that the settings for each module are what you want.

If not, click Reset Configuration and provide the corrected settings.

12d Repeat Step 12a through Step 12c until all the required modules have been configured, 
then continue with Step 13.

13 Save the file.:

13a Click File > Save.

13b Browse to a location that you want to save the file to.

13c Type filename.xml, then click Save.

Replace filename with an appropriate name to identify the control file for the installation 
you are performing.

By default, the file is saved in the /var/lib/autoinstall/repository/ directory.

For additional filename requirements and recommendations, see “The Auto-Installation 
Process” in Automatic Linux Installation and Configuration with Yast2 (http://
www.suse.de/~ug/autoyast_doc/Invoking.html).

14 Exit the configuration management tool by clicking File > Exit.

15 Proceed with “Setting Up an Installation Source” on page 186.

8.4  Setting Up an Installation Source
For OES 2, you must set up a separate directory for the SLES 10 software and the OES 2 software.

AutoYaST requires an installation source. You have several options. For an explanation of each, see 
“Network Based Installation” (http://www.suse.de/~ug/autoyast_doc/Bootmanagement.html) and 
“The Auto-Installation Process” in Automatic Linux Installation and Configuration with Yast2 
(http://www.suse.de/~ug/autoyast_doc/Invoking.html).

You can also set up an installation source on a NetWare server. See Section 2.10.2, “NetWare as a 
Network Installation Source Server,” on page 43.

Novell Remote 
Manager (NRM)

 Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

Novell Samba  Novell Backup/Storage Management Services (SMS)

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Novell Storage 
Services (NSS)

 Novell Backup/Storage Management Services (SMS)

 Novell eDirectory

 Novell NCP Server

 Novell Linux User Management (LUM)

 Novell Remote Manager (NRM)

Pattern Other Module Dependencies
 SP3: Installation Guide

http://www.suse.de/~ug/autoyast_doc/Invoking.html
http://www.suse.de/~ug/autoyast_doc/Invoking.html
http://www.suse.de/~ug/autoyast_doc/Invoking.html
http://www.suse.de/~ug/autoyast_doc/Bootmanagement.html
http://www.suse.de/~ug/autoyast_doc/Invoking.html
http://www.suse.de/~ug/autoyast_doc/Invoking.html


9
9Installing OES as a Xen VM Host 
Server

You can install Novell Open Enterprise Server (OES) 2 SP3 as a Xen VM host server. 

To understand why you might want your VM host server to have OES 2 SP3 installed, see “Why 
Install OES Services on Your VM Host?” in the OES 2 SP3: Planning and Implementation Guide.

To install OES 2 SP3 on your VM host server, add the following steps to the basic installation 
instructions found in “Setting Up a Virtual Machine Host” (http://www.novell.com/documentation/
sles10/book_virtualization_xen/data/cha_xen_virtualization_vhost_setup.html) in the Virtualization 
with Xen (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html) guide.

1 When you reach the Installation Mode page, select the Include Add-On Products from Separate 
Media option and complete the instructions in Section 3.3, “Specifying the Add-On Product 
Installation Information,” on page 51.

2 When you reach the Installation Settings page, click the Software heading.

3 Of the services listed in the OES Services category, only the following are supported on a Xen 
VM host server: 

 Novell Linux User Management (LUM)

 Novell Storage Management Services (SMS)

 Novell Cluster Services (NCS)

You can select any of these services that you want to be available on the host server, or you can 
leave all of the services deselected. In either case, the server will be configured as an OES 
server.

4 If you selected any of the supported OES services, Novell Remote Manager (NRM) is also 
selected. Click the green check mark by NRM to change it to a red symbol and prevent NRM 
from being installed. NRM is not a supported OES service on a Xen VM host server.

5 In the Primary Functions category, select Xen Virtual Machine Host Server.

Because you want the host server optimized to manage your virtual machines, do not choose 
any additional primary functions. Other services should be installed on an OES or SUSE Linux 
Enterprise Server (SLES) 10 VM guest server or physical server.

6 On the Configured LDAP Servers page, specify the tree name, admin name, and password for 
the eDirectory tree into which you are installing the host server.

IMPORTANT: If you didn’t select any OES services, the Novell Open Enterprise Server 
Configuration page appears instead. In that case, the Configured LDAP Servers page is 
accessible via the LDAP Configuration for Open Enterprise Services link.

7 Click Add and specify the IP address of a server in the tree that has eDirectory installed on it, 
then click Next.

8 On the Novell Open Enterprise Server Configuration page, click Next.

9 When you reach the User Authentication Method page, do not change the Authentication 
Method.
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10 On the New Local User page, do not create a local user.

11 After the server boots, make sure the GRUB boot loader is set to run the Xen kernel:

11a On the desktop, click Computer > YaST.

11b In YaST, click System > Boot Loader.

11c Make sure there is a check mark by the XEN label. If a different option is marked, select 
XEN and click the Set as Default button. 

11d Click Finish.

11e Close YaST and restart the server.

The server is now prepared to function as a Xen VM host server.
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10Installing, Upgrading, or Updating 
OES on a Xen-based VM

In Novell Open Enterprise Server (OES) 2 SP3, you can install OES 2 SP3 as a guest operating 
system on the following servers: 

 A SUSE Linux Enterprise Server (SLES) 10 Linux server 

See “Setting Up a Virtual Machine Host” (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/cha_xen_virtualization_vhost_setup.html) in the Virtualization 
with Xen (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html)guide.

 An OES 2 SP3 server that has been set up as a Xen-based host server

See Chapter 9, “Installing OES as a Xen VM Host Server,” on page 187.

For general information on the Xen virtualization technology in SLES 10 SP4, see the Virtualization 
with Xen guide (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

This section documents the system requirements, installation instructions, upgrade and migration 
instructions, and issues associated with setting up OES 2 on a Xen-based virtual machine. 

 Section 10.1, “System Requirements,” on page 189

 Section 10.2, “Prerequisites,” on page 191

 Section 10.3, “Preparing the Installation Software,” on page 191

 Section 10.4, “Installing an OES 2 SP3 VM Guest,” on page 192

 Section 10.5, “Upgrading an OES 2 VM Guest to OES 2 SP3,” on page 196

 Section 10.6, “Updating an OES 2 SP3 VM Guest,” on page 201

 Section 10.7, “Managing a Virtual Machine Running OES 2 SP3,” on page 201

 Section 10.8, “Setting Up an OES 2 SP3 VM Guest to Use Novell Storage Services (NSS),” on 
page 202

10.1  System Requirements
To create an OES 2 SP3 VM guest, you need a SLES 10 SP4 or OES 2 SP3 server that is set up as a 
Xen VM host server. 

 Section 10.1.1, “OES 2 SP3 VM Host Considerations,” on page 190

 Section 10.1.2, “Novell Storage Services Considerations,” on page 190

 Section 10.1.3, “Setup Instructions,” on page 190
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10.1.1  OES 2 SP3 VM Host Considerations

When you set up a virtual machine host for OES 2 SP3 VM guests, ensure that the host server has 
the following:

 Time synchronization: Set the server’s time configuration to the same reliable, external 
time source as the eDirectory tree that the virtual machines on that host will be joining. 

To set the time source, use Yast > Network Services > NTP Time Configuration.

The time source can be running NTP or Timesync with the NTP option selected. 

 RAM: Enough memory to support each virtual machine that you want to run concurrently 
on the host server.

For example, if you are installing one OES 2 SP3 virtual machine, you need a minimum of 
1 GB of memory (512 MB for the host plus 512 MB for the OES 2 Linux VM). 

If you are installing two virtual machines, and the first VM guest’s services need 1 GB and 
the second guest’s need 1.5 GB, you need 2.5 GB for the VM guests and 512 MB for the 
host—a total of 3 GB. 

 Disk Space: Enough disk space on the host for creating and running your VM guests.

The default disk space required for an OES 2 SP3 VM guest is 4 GB and the  default 
allocation for each VM guest in Xen is 10 GB, leaving approximately 6 GB for data files, 
etc. The space you need is dependent on what you plan to use the virtual server for and 
what other virtual storage devices, such as NSS volumes, that you plan to attach to it.

10.1.2  Novell Storage Services Considerations

If you want to set up Novell Storage Services (NSS) on the virtual machine, note the following: 

 NSS can recognize physical, logical, or virtual devices up to 2 TB in size (where 1 TB = 2E40 
bytes = 1,099,511,627,776 bytes).

 In a virtual environment, the devices that you want to use for the NSS file system on the guest 
operating system cannot exceed the 2 TB limit, even if the host operating system and guest 
operating system can handle larger devices.

For information, see “Device Size Limit” in the OES 2 SP3: NSS File System Administration 
Guide for Linux.

10.1.3  Setup Instructions

As mentioned in Section 10.1, “System Requirements,” on page 189, you can use either a SLES 10 
SP4 server or an OES 2 SP3 server as your VM host server. 

For setup procedures, see the following information:

 SLES 10 SP4: “Setting Up a Virtual Machine Host” (http://www.novell.com/documentation/
sles10/book_virtualization_xen/data/cha_xen_virtualization_vhost_setup.html) in the 
Virtualization with Xen (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/book_virtualization_xen.html) guide.

 OES 2 SP3: “Chapter 9, “Installing OES as a Xen VM Host Server,” on page 187.”
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10.2  Prerequisites
Before creating an OES 2 SP3 virtual machine, you need the following:

 If you want to use AutoYaST to specify the Installation settings, create an AutoYaST profile 
(control) file and download it to a directory on the host machine server or make it available on 
the network. For more information, see Chapter 8, “Using AutoYaST to Install and Configure 
Multiple OES Servers,” on page 179.

 A static IP address for each virtual server that you want to create.

10.3  Preparing the Installation Software
 Section 10.3.1, “Downloading the Installation Software,” on page 191

 Section 10.3.2, “Preparing the Installation Source Files,” on page 191

10.3.1  Downloading the Installation Software

For information on downloading the following ISO image files, see the Novell Open Enterprise 
Server 2 Download Instructions (http://www.novell.com/documentation/oes2/esd/
di_oes2_sp3.html).

Table 10-1   OES ISO Images and CD Labels for i386 (32-Bit Installations)

Table 10-2   OES ISO Images and CD Labels for x86_64 (64-Bit Installations)

10.3.2  Preparing the Installation Source Files

To create an OES 2 SP3 VM guest, you must make the installation software available in one of the 
following locations:

 A Local Installation Source: The 32-bit (Table 10-1) or 64-bit (Table 10-2) ISO files copied 
to the host server’s local drives. 

 A Network Installation Source:  The 32-bit (Table 10-1) or 64-bit (Table 10-2) ISO files used 
to create a network installation source. For instructions, see “Setting Up the Server Holding the 
Installation Sources” in the SUSE Linux Enterprise Server 10 Installation and Administration 
Guide (http://www.novell.com/documentation/sles10/book_sle_reference/data/
sec_deployment_remoteinst_instserver.html).

ISO Image File CD Label

OES2-SP3-i386-CD1.iso Novell Open Enterprise Server 2 SP3 CD 1

SLES-10-SP4-DVD-i386-GM-DVD1.iso SUSE Linux Enterprise Server 10 SP4 DVD

ISO Image File CD Label

OES2-SP3-x86_64-CD1.iso Novell Open Enterprise Server 2 SP3 CD 1

SLES-10-SP4-DVD-x86_64-GM-
DVD1.iso

SUSE Linux Enterprise Server 10 SP4 DVD
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10.4  Installing an OES 2 SP3 VM Guest
Creating an OES 2 SP3 virtual machine requires you to complete the following major tasks.

 Section 10.4.1, “Specifying Options for Creating an OES 2 SP3 VM Guest,” on page 192

 Section 10.4.2, “Specifying the Installation Mode,” on page 195

 Section 10.4.3, “Specifying the Add-On Product Installation Information,” on page 195

 Section 10.4.4, “Completing the OES 2 SP3 VM Guest Installation,” on page 196

10.4.1  Specifying Options for Creating an OES 2 SP3 VM Guest

The Create Virtual Machine Wizard helps you through the steps required to create a VM guest and 
install the desired operating system.

1 Launch the Create Virtual Machine Wizard by using one of the following methods:

 From the virtualization host server desktop, click YaST > Virtualization > Create Virtual 
Machines

 From within Virtual Machine Manager, click New.

 At the command line, enter vm-install. 

If the wizard does not appear or the vm-install command does not work, review the process 
of installing and starting the virtualization host server. The virtualization software might not be 
installed properly.

2 After specifying that you want to create a virtual machine, click Forward.

3 Click Forward.

The option to set up a virtual machine based on an existing disk or disk image is supported only 
if the existing disk or disk image was originally set up through the Create Virtual Machine 
Wizard.

4 On the Type of Operating System page, select Novell Open Enterprise Server 2 (Linux), then 
click Forward.

The Summary page appears.
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NOTE: Detailed explanations of the Summary page settings are available in “Virtualization: 
Configuration Options and Settings (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/cha_xen_config_options.html)” in the Virtualization with Xen 
guide (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

5 Click Name of Virtual Machine.

6 Specify a name for the virtual machine in the Name field, then click Apply.

For example, you might specify hostname_vm, where hostname is the DNS name of the server 
you are installing in the VM.

7 Click Hardware. 

7a Specify the amount of initial and maximum memory for the virtual machine to consume 
from the available memory. The initial memory should not be less than 1024 MB. 

7b Specify the number of processors that you want the virtual machine to use. 

7c Click Apply.

8 If you want to change the graphics adapter settings, click Graphics and select the type of 
graphic support desired, then click Apply.

9 Click Disks.

The Virtual Disk page lets you create the virtual disks that the OES 2 SP3 VM guest will have 
access to. This includes the installation media if you are installing from downloaded SLES and 
OES ISO image files. 
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Initially, a 10 GB file is specified for the partitions/volumes on the virtual server. The default 
location of the file is /var/lib/xen/images.

By default, this is a sparse file, meaning that although 10 GB is allocated, the size of the file on 
the disk is only as large as the actual data it contains. Sparse files conserve disk space, but they 
have a negative impact on performance.

The OES 2 SP3 installation guidelines recommend 10 GB for a server installation. Keep in 
mind, however, that you are defining the total local disk size for the server. You should allocate 
as much local space as you anticipate the server needing for data and other files after it is 
hosting user services.

9a Specify the hard disk space you want to be available to the virtual machine.

9b Click Apply.

10 If you are installing SLES 10 SP4 from a downloaded ISO image file, click CD-ROM, browse 
to the SLES 10 SP4 image file, then click Open > OK > Apply. 

11 If you are installing OES 2 SP3 from a downloaded ISO image file,  click CD-ROM, browse to 
the OES 2 SP3 image file, then click Open > OK > Apply.

12 If you want to change the network adapter settings, click Network Adapters, view the default 
setting, then edit the default settings.

or

Click New and specify the setting for another network board of your choice, then click Apply.

13 Click Operating System:

13a If you are installing from a downloaded ISO image, make sure that the SLES 10 SP4 
image is specified as the Virtual Disk installation source.

13b If you are installing from a network installation source, specify the URL for the SLES 10 
SP4 network installation source. 

You specify a network installation source for OES 2 SP3 during the install.

13c If you are using an AutoYaST control file to specify the settings for a virtual machine 
operating system, specify the path to the file in the AutoYaST File field or click the Find 
button to the right of the field to locate the file on the local host server. 

13d If necessary, use the Additional Arguments field to specify additional install or boot 
parameters to assist the installation. 

For example, if you wanted to specify the parameters for an IP address of 192.35.1.10, a 
netmask of 255.255.255.0, a gateway of 192.35.1.254 for the virtual server, and use ssh to 
access the installation from another workstation, you could enter the following parameters 
in the Additional Argument field:

hostip=192.35.1.10 netmask=255.255.255.0 gateway=192.35.1.254 usessh=1 
sshpassword=password

13e Click Apply.

14 Click OK to start the virtual machine and launch the operating system installation program.

15 Continue with Section 10.4.2, “Specifying the Installation Mode,” on page 195.
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10.4.2  Specifying the Installation Mode

1 When the Installation Mode screen displays, select the following menu options:

 New Installation 

 Include Add-On Products from Separate Media

2 Click Next.

3 Continue with Section 10.4.3, “Specifying the Add-On Product Installation Information,” on 
page 195.

10.4.3  Specifying the Add-On Product Installation Information

When the Add-On Product Installation page displays:

1 Click Add.

2 If you are installing OES 2 from an ISO image file:

2a On the Add-On Product Media page, click Specify URL, then click Next.

2b In the URL field, type

hd:///?device=/dev/xvdc/

2c Click OK.

2d Skip to Step 4.

3 If you are installing from a network installation source, click the appropriate protocol for your 
situation, then click Next and supply the required information.

4 Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.

5 Confirm that the Add-On Product Installation page shows the correct path to the OES media, 
then click Next.

6 Continue with “Completing the OES 2 SP3 VM Guest Installation.”
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10.4.4  Completing the OES 2 SP3 VM Guest Installation

1 Follow the on-screen prompts, using the information contained in the following sections:

1a Section 3.4, “Setting Up the Clock and Time Zone,” on page 52.

1b Section 3.5, “Specifying the Installation Settings for the SLES Base and OES 
Installation,” on page 52.

1c Section 3.6, “Specifying Configuration Information,” on page 59.

During the configuration portion of the installation, you might see additional prompts 
concerning hardware detection of the network cards, DSL, PPPoE DSL, ISDN cards, and 
modems.

When you specify the time source during the eDirectory configuration, use the same time 
source as the eDirectory tree you are installing the server into.

After the installation, enable the virtual machine’s Independent Wall Clock setting and 
reboot the virtual machine so it can synchronize its time correctly. For more information 
on this configuration issue, “Virtual Machine Clock Settings (http://www.novell.com/
documentation/sles10/book_virtualization_xen/data/sec_guest_suse.html#sec_xen_time)” 
in the Virtualization with Xen guide (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/book_virtualization_xen.html).

1d Section 3.7, “Finishing the Installation,” on page 110.

During the hardware configuration, graphics and sound cards are not recognized when 
installing OES 2 SP3 as a VM guest.

2 Complete the server setup by following the procedures in “Chapter 6, “Completing OES 
Installation or Upgrade Tasks,” on page 153.”

10.5  Upgrading an OES 2 VM Guest to OES 2 
SP3
 Section 10.5.1, “Upgrading an OES 2 VM Guest by Using the Update Channel,” on page 196

 Section 10.5.2, “Performing an Offline Upgrade,” on page 196

10.5.1  Upgrading an OES 2 VM Guest by Using the Update 
Channel

Patching or updating an OES 2 SP3 VM guest is essentially the same as updating an OES 2 SP3 
physical server. For instructions on updating a physical OES 2 SP3 server, see Section 5.4.5, “Using 
the Patch Channel to Upgrade (Online),” on page 130.

10.5.2  Performing an Offline Upgrade

You can perform an offline upgrade using either an ISO file or files on the network. Physical media 
upgrades are not supported for VM guests.

NOTE: The offline upgrade process is quite lengthy. If your guest VMs have access to a patch 
channel, we recommend that you upgrade by using the patch channel. See Section 5.4.5, “Using the 
Patch Channel to Upgrade (Online),” on page 130.
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Performing a down-server upgrade on an OES 2 VM guest is similar in many ways to upgrading a 
physical machine, but there are important differences as outlined in the following sections:

 “Before You Start the Upgrade Process” on page 197

 “A Brief Overview of the Upgrade Process” on page 197

 “Creating a Temporary Upgrade Directory on the VM Host” on page 198

 “Creating a Directory and Copying the ISO Files to the VM Host” on page 198

 “Checking the Kernel Type” on page 198

 “(Conditional) Obtaining the xenpae Kernel” on page 198

 “Shutting Down and Preparing the VM Guest” on page 199

 “Copying the Boot Files and Preparing the VM Guest Configuration Files” on page 199

 “Starting the Upgrade” on page 201

 “Resuming and Completing the Upgrade” on page 201

Before You Start the Upgrade Process

1 Make sure you follow all of the applicable instructions and guidelines in Section 5.2, “Planning 
for the Upgrade to OES 2 SP3,” on page 120 and Section 5.3, “Meeting the Upgrade 
Requirements,” on page 121.

A Brief Overview of the Upgrade Process

When you perform a down-server upgrade on a physical server to OES 2 SP3, you must first shut 
down the server and then reboot it, using the installation kernel and initial RAM disk (initrd) files on 
the SLES 10 SP4 installation media. This is accomplished by booting the server through a SLES CD 
or DVD, an ISO image file, or by accessing a SLES installation image on the network through a 
PXE or other remote connection.

Upgrading a VM guest also requires that you shut down the guest. However, when a Xen VM guest 
reboots, it doesn’t scan the local storage devices or attempt a network PXE connection. Rather, it 
uses its configuration information to locate the kernel and other needed files on the host’s file 
system. The only way to affect the boot process of a VM guest is to modify its configuration.

Therefore, to upgrade a Xen VM guest, you must do the following high-level tasks as detailed in the 
sections that follow.

1. Copy the installation/upgrade kernel and initial RAM disk (initrd) files to the VM host’s file 
system.

2. Create two copies of the VM guest configuration: 

 A Modified Version: You use this to start the upgrade process and run the first portion of 
the process.

 An Unmodified Version: You use this to restore the guest’s operating environment for 
the second portion of the upgrade process.

3. Remove the VM guest’s configuration information from the Xen database so that it can boot 
using configuration files you create above.
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Creating a Temporary Upgrade Directory on the VM Host

As explained in “A Brief Overview of the Upgrade Process” on page 197, the kernel and other files 
needed to run the upgrade must be accessible on the VM host’s file system. 

1 Create a directory on the VM host server for the following:

 The installation kernel

 The initial RAM disk (initrd) file

 The configuration files that you need during the upgrade process. 

The instructions that follow assume the directory is /tmp/upgrade, but you can use a different 
directory if you prefer.

Creating a Directory and Copying the ISO Files to the VM Host

NOTE: This is not required for an installation over the network.

If you plan to install from ISO image files on the VM host:

1 Create a directory for the files on your VM host server.

Because the images need to be available for future maintenance operations, they should be kept 
in a permanent location so that YaST knows where to find them.

2 Copy the ISO image files for your platform architectural type (32-bit or 64-bit).

Refer to the information on obtaining OES software in “Getting and Preparing OES 2 
Software” in the OES 2 SP3: Planning and Implementation Guide.

Checking the Kernel Type

If you are upgrading a 32-bit VM guest, and you don’t know whether it uses the non-PAE or PAE 
kernel:

1 Open a terminal on the VM guest.

2 Enter the following command:

uname -r

3 Note whether the kernel name ends in

 xen: Indicates the non-PAE kernel. 

or 

 xenpae: Indicates the PAE kernel.

This determines which version of the kernel you must copy to the temporary upgrade directory.

(Conditional) Obtaining the xenpae Kernel

The xenpae kernel was inadvertently left off the SLES 10 SP4 media. If your guest requires the 
xenpae kernel, refer to TID 7005079 (http://www.novell.com/support/
search.do?cmd=displayKC&docType=kc&externalId=7005079&sliceId=1&docTypeID=DT_TID_
1_1&dialogID=189462491&stateId=0%200%20189464454) for instructions on overcoming this 
limitation. If necessary, click the Login link to see the TID information.
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Shutting Down and Preparing the VM Guest

1 On the VM host server, open Virtual Machine Manager, right-click the OES 2 guest server you 
are upgrading, and select Shutdown.

2 If you are upgrading using ISO image files, in Virtual Machine Manager click View > Details > 
Hardware > Add > Storage Device, then browse to and select the SLES 10 SP4 ISO file.

3 Browse to and select the OES 2 SP3 ISO file.

Copying the Boot Files and Preparing the VM Guest Configuration Files

1 Copy the installation kernel and initrd files from your SLES 10 SP4 installation source > the /
boot/i386 or /boot/x86_64 directory (depending on which architectural version you are 
upgrading) to the temporary directory you created in Step 1 on page 198. 

If you are upgrading a 64-bit VM guest installation, the files are named vmlinuz-xen and 
initrd-xen.

If you are upgrading a 32-bit VM guest installation, choose the files that are appropriate for 
your hypervisor as determined in “Checking the Kernel Type” on page 198:

 vmlinuz-xen and initrd-xen

or

 vmlinuz-xenpae and initrd-xenpae

2 Capture the VM guest’s configuration in a file that you can modify to start the upgrade process.

At a terminal prompt, enter the following command:

xm list -l vm_name > /path/to/modify_config_file.sxp

Replace vm_name with the name of the VM guest that you are upgrading as listed in the Virtual 
Machine Manager, and the path with your temporary directory created in Step 1 on page 198 
and specifies a filename that indicates it is modified for starting the upgrade process. 

For example:

xm list -l myserver_vm > /tmp/upgrade/modify_myserver_vm.sxp

3 Before modifying the configuration file you just created, change to the directory containing the 
file and use the following commands to make a copy of it to preserve the unmodified 
configuration:

cd /path/to/upgrade_directory

cp modify_config_file.sxp unmodified_config_file.sxp

Replace modify_config_file.sxp with the name the configuration file you specified in Step 2 
and replace unmodified_config_file.sxp with the name of the new file you will use to restore the 
VM guest’s original configuration for the second phase of the upgrade process. 

For example:

cd /tmp/upgrade

cp modify_myserver_vm.sxp unmodified_myserver_vm.sxp

4 Verify that both of the configuration files are in your upgrade directory, then remove the VM 
guest’s configuration from the Xen VM database by using the following command:

xm delete vm_name
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Replace vm_name with the name of the VM guest that you are upgrading.

For example:

xm delete myserver_vm

The VM guest no longer appears in Virtual Machine Manager.

5 Using a text editor, open the configuration file that you created in Step 2 and change it as 
follows:

5a Remove the line that begins with (bootloader_args ….

5b Change the line that reads 

(on_reboot restart)

to

(on_reboot destroy)

5c Remove the line that contains

(bootloader /usr/lib/xen/boot/domUloader.py).

5d Find the following indented lines:

(image
(linux

(kernel ...)

5e In the kernel line, before the closing parenthesis “)”, modify the listed path (or insert a 
path if none is present) to point to the vmlinuz-xen or vmlinuz-xenpae file copied in 
Step 1.

For example, modify the kernel line so that it reads:

(kernel /tmp/upgrade/vmlinuz-xen)

or

(kernel /tmp/upgrade/vmlinuz-xenpae)

5f Insert a ramdisk line below the kernel line (or if a ramdisk line already exists, modify it) to 
point to the initrd file you copied in Step 1.

For example, insert or modify the line so that it reads:

(ramdisk /tmp/upgrade/initrd-xen)

or

(ramdisk /tmp/upgrade/initrd-xenpae)

5g In the args line, between the single quotes, insert the path to your SLES 10 SP4 
installation source.

For example, if you are upgrading a 64-bit installation from the network, you might 
modify the args line so that it reads:

(args ‘install=http://myserver.mycompany.com/sles10-SP4/x86_64’)

Or, if you are upgrading a 64-bit installation from ISO files, you might modify the args 
line so that it reads:

(args ‘install=hd:///?device=/dev/xvdx’)

Replace x with the letter assigned to the SLES 10 SP4 ISO image file, for example .../
xvdc.

5h Save the upgrade configuration file, then continue with Starting the Upgrade.
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Starting the Upgrade

1 On the VM host server at a terminal prompt, enter the following command:

xm create -F /path/to/modify_config_file.sxp

For example:

xm create -F /tmp/upgrade/modify_myserver_vm.sxp

The VM guest appears again in Virtual Machine Manager.

2 Open the VM guest, then select the language and accept the SLES 10 SP4 license agreement.

3 Complete the first phase of the upgrade process by following the standard upgrade instructions, 
starting with Section 5.4.6, “Selecting the Installation Mode Options,” on page 132.

IMPORTANT: Remember that you must specify the location URL for the OES 2 SP3 
installation files, either by using a network protocol such as HTTP:// or by using the device 
path assigned to the OES ISO, such as hd:///?device=/dev/xvdd.

Resuming and Completing the Upgrade

After you complete the instructions in Section 5.4.11, “Accepting the Installation Settings,” on 
page 140, the server doesn’t reboot automatically and the VM guest disappears from Virtual 
Machine Manager. 

You must re-create the VM guest to continue the upgrade process and complete the second phase. 

1 Enter the following command at the terminal prompt:

xm new -F /path/to/unmodified_config_file.sxp

For example:

xm new -F /tmp/upgrade/unmodified_myserver_vm.sxp

2 Open the VM guest and follow the standard upgrade instructions to completion, starting with 
Section 5.4.12, “Specifying Configuration Information,” on page 141.

When the upgrade process is complete, you can remove the upgrade directory that you created in 
Step 1 on page 198.

10.6  Updating an OES 2 SP3 VM Guest
Patching or updating an OES 2 SP3 VM guest is essentially the same as updating an OES 2 SP3 
physical server. For instructions on updating a physical OES 2 SP3 server, see Chapter 7, “Updating 
(Patching) an OES 2 SP3 Server,” on page 157.

10.7  Managing a Virtual Machine Running OES 2 
SP3
Managing a virtual machine running OES 2 SP3 is the same as managing virtual machines running 
other operating systems. For procedures, see “Managing a Virtualization Environment (http://
www.novell.com/documentation/sles10/book_virtualization_xen/data/
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cha_xen_virtualization_manage.html)” in the Virtualization with Xen guide (http://
www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

10.8  Setting Up an OES 2 SP3 VM Guest to Use 
Novell Storage Services (NSS)
When you install OES 2 SP3 on a virtual machine, we recommend that you configure a virtual 
machine with multiple devices. Use the primary virtual disk as the system device with LVM2 (the 
YaST install default) as the volume manager. After the install, you can assign additional storage 
resources from the host server to the virtual machine. In the guest server environment, the additional 
disks can use LVM2 or EVMS as needed. In this scenario, NSS volumes are created only on 
additional virtual disks, not on the primary virtual disk that you are using for the guest server’s 
system device.

IMPORTANT: When you create the virtual machine, make sure to configure the size of the primary 
virtual disk according to the amount of space you need for the /boot, swap, and root (/) volumes. 

If you decide to use EVMS for the system device on the virtual machine, follow the install 
instructions in “Section A.2, “Configuring the System Device to Use EVMS,” on page 234,” just as 
you would for a physical machine.

After the virtual machine is set up, you need to perform additional tasks to set up additional Novell 
Storage Service (NSS) devices. See “Using NSS in a Virtualization Environment” in the OES 2 SP3: 
NSS File System Administration Guide for Linux.
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11
11Installing and Managing NetWare 
on a Xen-based VM

IMPORTANT: NetWare 6.5 SP8 has been modified to run in paravirtual mode on a Xen virtual 
machine. Running NetWare in fully virtualized mode on a Xen host server is not supported.

You can install NetWare as a virtual machine guest (VM guest) operating system on the following 
servers: 

 A SUSE Linux Enterprise Server (SLES) 10 Linux server 

See “Setting Up a Virtual Machine Host” (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/cha_xen_virtualization_vhost_setup.html) in the Virtualization 
with Xen guide (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

 An OES 2 SP3 server that has been set up as a Xen-based host server

See “Chapter 9, “Installing OES as a Xen VM Host Server,” on page 187” in the .

For general information on the Xen virtualization technology in SLES 10 SP4, see the Virtualization 
with Xen guide (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

This section documents the system requirements, installation instructions, upgrade and migration 
instructions, and issues associated with setting up NetWare on a Xen-based virtual machine. 

 Section 11.1, “Introduction,” on page 203

 Section 11.2, “Support Information,” on page 204

 Section 11.3, “Preparing to Install a NetWare VM Guest Server,” on page 205

 Section 11.4, “Installing Virtualized NetWare,” on page 208

 Section 11.5, “Managing NetWare on a Virtual Machine,” on page 215

 Section 11.6, “If VM Manager Doesn’t Launch on a Xen VM Host Server,” on page 217

11.1  Introduction
There are many reasons to install NetWare 6.5 SP8 on virtual machines, such as: 

 Incorporating a NetWare server into a production environment without committing additional 
hardware resources.

 Isolating Novell iFolder, iPrint, GroupWise, or other applications to a single virtual server 
without committing additional hardware resources.

 Extending the useful life of NetWare services by running them on a Linux host server, thereby 
taking advantage of the widespread industry support for Linux hardware drivers.

To simplify the process of installing virtualization software, the SLES 10 SP4 software includes Xen 
Virtual Machine Host Server as a primary server function that you can select when installing SLES 
10 SP4 as a virtualization host server. 
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Selecting this pattern installs the Xen host server software, which enables the server to boot the Xen 
version of the SLES 10 SP4 operating system kernel. It also installs utilities for preparing and 
creating virtual machines.

After the host server is up and running, you can then create a virtual machine and install NetWare 
6.5 SP8 as a guest operating system.

11.2  Support Information
 Section 11.2.1, “OES 2 Registration Is Required for Support,” on page 204

 Section 11.2.2, “Supported Configurations and Features,” on page 204

 Section 11.2.3, “Unsupported Configurations and Features,” on page 204

11.2.1  OES 2 Registration Is Required for Support

Although OES 2 NetWare and NetWare 6.5 share the same code base and are the same in every way, 
virtualized NetWare in Xen is an OES 2 product feature. Support for NetWare on a Xen virtual 
machine is available only to OES 2 registered customers.

11.2.2  Supported Configurations and Features

The following configurations and features are supported for NetWare VM guest servers.

 OES 2 NetWare or later running in paravirtual mode.

 The graphical paravirtualized frame buffer and the text-based console interface.

 Running on 32-bit, 32-bit PAE, and 64-bit hypervisors. 

 Running in 32-bit PAE compatibility mode on 64-bit platforms.

 Up to 16 block devices.

 Up to 32 virtual CPUs.

 The pause and resume functionality.

 The xm shutdown command.

 The shutdown command in Virtual Machine Manager.

 Allocated memory from 1 GB to 8 GB.

 VCPU cover commitment, pinning, and capping.

 Installations through a NetWare response file.

11.2.3  Unsupported Configurations and Features

The following configurations and features are not supported for NetWare VM guest servers.

 NetWare in full virtualization mode.

 NetWare 6.5 SP6 and earlier running on a virtual machine.

 VCPU hotplug.

 Network or block device hotplug.

 Virtual memory resizing.
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 Direct access to physical devices.

 The save, restore, and migrate commands.

 Some Novell Remote Manager debugging features.

11.3  Preparing to Install a NetWare VM Guest 
Server
 Section 11.3.1, “Planning for VM Host Servers,” on page 205

 Section 11.3.2, “Planning for NetWare VM Guest Servers,” on page 206

 Section 11.3.3, “You Must Use Timesync for Time Synchronization,” on page 207

 Section 11.3.4, “Disabling the Alt+Esc Shortcut on the Host,” on page 207

11.3.1  Planning for VM Host Servers

 “Meeting Server Hardware and Software Requirements” on page 205

 “Deciding Whether to Run OES Services on VM Host Servers” on page 205

Meeting Server Hardware and Software Requirements

To accommodate NetWare VM guest servers, your VM host servers must:

 Meet the criteria specified in “Setting Up a Virtual Machine Host” (http://www.novell.com/
documentation/sles10/book_virtualization_xen/data/cha_xen_virtualization_vhost_setup.html) 
in the Virtualization with Xen guide (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/book_virtualization_xen.html).

 Have enough memory (RAM) on the physical machine for: 

 The SLES 10 operating system (512 MB)

 Any of the supported OES services that you install on the VM host (512 MB) 

 Each NetWare virtual machine that you plan to run concurrently (1 GB to 8 GB)

For example, if you are installing one NetWare VM guest server on a SLES 10 VM host server, 
you need a minimum of 1.5 GB of memory: 512 MB for the VM host server and 1 GB for the 
NetWare VM guest server. For optimal performance, you should allocate as much memory as 
possible for each NetWare VM guest, up to 8 GB each. 

 Have enough disk space on the host server for creating and running the VM guest servers.

The default disk space for a NetWare VM guest server is 10 GB. You might need more or less 
space, depending on what you will use the guest server for and what its storage configuration 
will be. You might want to locate your virtual machines on a separate partition or even on a 
separate storage device. For example, you might create a /vm partition on a separate drive 
installed in the server. For additional information, see “Storage Planning” on page 206.

Deciding Whether to Run OES Services on VM Host Servers

You should also decide whether to install OES 2 SP3 and one or more of its supported services on 
your VM host servers. 
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To ensure that optimal resources are available to the virtual machines, each VM host server should 
be dedicated to running the Xen virtualization software as much as possible. However, there are 
several good reasons why you might want to choose to install one or more of the supported OES 
services on the host server itself. For more information, see “Why Install OES Services on Your VM 
Host?” in the OES 2 SP3: Planning and Implementation Guide.

11.3.2  Planning for NetWare VM Guest Servers

Before creating NetWare virtual machines, you need to plan for the following:

 “RAM Planning” on page 206

 “Storage Planning” on page 206

 “Network Planning” on page 206

 “eDirectory Planning” on page 207

RAM Planning

To ensure the best performance by your NetWare VM guests, you should plan for the optimal RAM 
configuration of each NetWare VM guest server. As a general rule, the more RAM you assign to a 
NetWare guest server (up to 8 GB), the better the server performance is. For specific planning 
information, see “Optimizing Server Memory” in the NW 6.5 SP8: Server Memory Administration 
Guide.

Storage Planning

The disk space that you allocate while creating the Xen virtual machines is used by the NetWare VM 
guest for the sys: volume.

For best performance in a Xen virtual environment, NSS pools and volumes on NetWare should be 
created on virtual devices that are SCSI devices, Fibre Channel devices, or iSCSI devices on the host 
server, or on partitions that are on those types of devices.

SATA or IDE disks have slower performance because special handling is required when working 
through the Xen driver to ensure that data writes are commited to the disk in the order intended 
before the driver reports back.

For more information on NSS disk storage, see “Using NSS in a Virtualization Environment” in the 
OES 2 SP3: NSS File System Administration Guide for Linux.

Network Planning

Each Xen guest VM is assigned one virtualized network card by default. You can create additional 
cards if desired. 

You must obtain one static IP address for each virtualized network card you plan to create on your 
NetWare VM guest servers. OES 2 SP3 does not support dynamically assigned (DHCP) IP 
addresses.
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eDirectory Planning

You can place a NetWare virtual machine in an existing tree or as the first server in a new tree. 
However, the performance of virtualized NetWare doesn’t match a physical NetWare installation. In 
most cases, it is probably preferable to add your NetWare virtual machine to an existing tree located 
on a physical NetWare server, particularly if the tree is large.

Also, because virtualized servers might be started and stopped more often than they would normally 
be on physical servers, we recommend that the master replica (usually the first server in a tree) be 
placed on a system that is running at all times. For more information about master replicas, see 
“Managing Partitions and Replicas” in the Novell eDirectory 8.8 Administration Guide.

11.3.3  You Must Use Timesync for Time Synchronization

Because of known issues with Xen and the NTP NLM, you must use Timesync as the time 
synchronization method for NetWare VM guests running on Xen VM hosts. Otherwise, time drift 
causes problems for your NetWare VM guests.

Keeping accurate time is a critical function for servers in an eDirectory tree. The reported time must 
be synchronized across the network to provide the expiration dates and time stamps necessary for 
ordering eDirectory events.

NetWare VM guest servers synchronize time in the same ways that NetWare physical servers do. In 
other words, the clock on the VM host server has no influence on the NetWare VM guest server’s 
time. 

IMPORTANT: To ensure that your NetWare VM guest is configured correctly, be sure to follow the 
instructions in “Configuring Time Synchronization” (specifically Step 4) in the NW65 SP8: 
Installation Guide, and configure the NetWare VM guest to get time from the same time source as 
the eDirectory tree it is joining. If the time source specified is an NTP server, be sure to select the 
NTP option next to the source’s DNS name or IP address. This enables Timesync to communicate 
with the NTP time source.

11.3.4  Disabling the Alt+Esc Shortcut on the Host

Alt+Esc is used on a NetWare server to switch between console screens, but on SLES 10 it moves 
between open windows. To provide the expected behavior for the virtualized NetWare server, you 
must disable the shortcut for SLES 10.

1 On the host server as the root user, click Computer > Control Center.

2 Click Personal > Shortcuts.

3 Under the Window Management category, click Move between windows immediately, then 
press the Backspace key to disable the shortcut.

4 Click Close.

5 Close the Control Center.
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11.4  Installing Virtualized NetWare
This section provides the instructions for installing NetWare 6.5 SP8 as a guest OS.

 Section 11.4.1, “Preparing the Installation Media,” on page 208

 Section 11.4.2, “Creating a Response File for an Unattended NetWare Installation,” on 
page 209

 Section 11.4.3, “Creating a Xen Virtual Machine and Installing a NetWare VM Guest Server,” 
on page 210

11.4.1  Preparing the Installation Media

You must use the DVD installation files to install a NetWare VM guest on a Xen VM host server. 
(Xen on SLES 10 doesn’t support CD swapping.) 

The installation media must appear as a local disk to the virtual machine, but it can be physically 
located in either of the following locations: 

 On a DVD in the host’s physical DVD reader.

 As the DVD ISO image file copied to the Xen VM host server desktop.

The following steps are for downloading to the VM host server’s desktop and can be adapted as 
necessary for the other locations listed above.

1 Use the Firefox browser on the VM host server to access the Novell Open Enterprise Server 2 
Downloand Instructions page (http://www.novell.com/documentation/oes2/esd/
di_oes2_sp1.html) and download the NW65SP8_OVL_DVD.iso file to the server’s desktop (or 
another location of your choosing). 

2 After the file downloads, if you are installing on an OES 2 SP3 VM host server by using a 
response file, continue with Step 3. Otherwise, skip to Section 11.4.3, “Creating a Xen Virtual 
Machine and Installing a NetWare VM Guest Server,” on page 210.

3 Click Open in the Firefox download dialog box.

4 Sort the list of files by Location by clicking the column heading, then scroll to /LICENSE.

5 Select the .NFK and .NLF files, right-click them, and select Extract.

6 In the Extract dialog box, click Extract, then close the ISO file and the browser.

7 Double-click the LICENSE folder on the desktop or other location that you chose in Step 1, 
select the two files you extracted and drag them to the desktop, then delete the LICENSE folder 
by dragging it to the Trash. 

8 Continue with Creating a Response File for an Unattended NetWare Installation.
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11.4.2  Creating a Response File for an Unattended NetWare 
Installation

OES 2 SP3 includes a YaST-based NetWare Response File utility that asks you for information 
about the NetWare server you want to install. Basically, you answer the same questions as you 
would during a physical NetWare installation. When the time comes to run the NetWare Install 
program, the installation reads your responses from the file and proceeds without requiring further 
intervention.

1 Open YaST and click Open Enterprise Server > NetWare Response File Utility.

2 On the Select Install Type page, make sure the Hardware Type is set for Virtual. Do not change 
any other options. Click Next.

3 Click Destination Address, specify a valid NetWare server name for the virtualized NetWare 
server, and specify the IP address you want the virtualized server to use. 

The IP address must be unique on the subnet just as it would be for a physical NetWare 
installation.

4 Click Next.

5 Click Destination eDirectory.

6 Specify the name of the eDirectory tree and a context for this server object.

7 In the Replica Server IP Address field, specify the IP address of the eDirectory server.

8 In the User Information section, specify the admin information for the tree, then click Next.

9 Click License, specify the eDirectory container where you want the NetWare license files 
stored (usually the Organization object), then click Next.

10 Click Protocols.

11 Specify the Subnet Mask and Gateway information for the subnet and click Next.

12 Click Language, change the language settings if needed, then click Next.

13 Click SLP Configuration.

14 If your tree has more than three servers, you must specify valid SLP information before 
continuing. Otherwise, you can leave the page at the default settings.

After you are finished with the page, click Next.

15 Click DNS Configuration, specify the DNS information, then click Next.

16 Click Time Zone Configuration, select your time zone options, then click Next.

17 Click Time Sync Configuration.

18 Leave the protocol set to TimeSync (do not select NTPv3), select Use TIMESYNC Configured 
Sources, specify the same time synchronization source as your eDirectory server uses, select 
NTP if applicable, then click Next.

19 Click Install Settings, change the default settings if needed, add any needed SET parameters by 
clicking Edit, then click Next.

20 Click Storage Configuration, adjust the default sizes if desired, then click Next.

21 Click Pattern Selection, select the preconfigured server pattern you want installed, then click 
Next.

22 If you selected Customized NetWare Server in Step 21, click Product Selection, select the 
services you want installed, then click Next.
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23 Click NMAS Configuration > Next > Next.

24 (Conditional) Depending on what products you selected for the server, click the headings and 
enter the required information until all the configuration options have been completed for the 
response file.

25 On the Save Response File page, specify a response filename, then browse to the directory 
where you stored your NetWare license files. (If you completed all of the instructions in 
Section 11.4.1, “Preparing the Installation Media,” on page 208, the field should show a path 
that ends with a forward slash (/).

26 If you want the VM Manager to launch automatically after you exit the Response File 
Generator, select Launch VM Manager.

IMPORTANT: If the option is not selectable, the server isn’t running the Xen kernel. See 
Section 11.6, “If VM Manager Doesn’t Launch on a Xen VM Host Server,” on page 217.

27 Specify the location of the Installation Source by browsing to the DVD .iso file that you 
copied to the local server, then click Finish.

28 Click Next. 

29 If you chose to automatically launch VM Manager in Step 26 above, click Forward and skip to 
Step 5 on page 213. Otherwise, continue with Section 11.4.3, “Creating a Xen Virtual Machine 
and Installing a NetWare VM Guest Server,” on page 210.

11.4.3  Creating a Xen Virtual Machine and Installing a NetWare 
VM Guest Server

1 Open YaST, then click Virtualization > Create Virtual Machines.
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2 Read the Create a Virtual Machine welcome page, then click Forward.

3 Select I need to install an operating system, then click Forward.
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4 Click the triangle next to NetWare, select Novell Open Enterprise Server 2 (NetWare), then 
click Forward.

The Summary page appears, showing the settings to be used for the virtual machine. 
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5 Click Name of Virtual Machine.

Specify the name that you want displayed for this virtual machine in the Virtual Machine 
Manager.

For example, you might specify hostname_vm, where hostname is the host name of the server 
you are installing.

6 Click Hardware.

Change the initial memory setting to at least 1024 MB and the maximum setting to as much as 
8 GB, depending on the RAM available on your host server.

Add additional virtual processors if desired.

7 Click Disks.

The Virtual Disks dialog box lets you create the virtual disks that the NetWare VM guest has 
access to. This includes the installation media if you are installing from a DVD on the host 
server or from an ISO image file copied to the host server’s storage devices. 

Initially, a 10 GB file is specified for the partitions/volumes on the virtual server. The default 
location of the file is /var/lib/xen/images. 

By default, this is a sparse file, meaning that although 10 GB is allocated, the size of the file on 
the disk is only as large as the actual data it contains. Sparse files conserve disk space, but they 
have a negative impact on performance. 
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The NetWare install allocates 500 MB for a DOS partition and 4 GB for the sys: volume. The 
default disk size of 10 GB leaves about 5.5 GB for other partitions.

8 If you want to change the location of the NetWare VM’s first virtual hard drive, select the 
default Hard Disk and click Edit. Then modify the path in the Server field to where you want 
the virtual disk located.

Make sure that you specify enough physical disk space on the host server’s hard drive and 
partition to accommodate the maximum size of the virtual disk. 

9 If you want optimal performance, deselect the sparse file option. This creates a blank file of the 
selected size when you start the virtual machine installation.

10 Click OK.

11 If you are installing from a mounted DVD, click CD-ROM, browse to /dev/cdrom or /dev/
dvd, then click Open > OK > Apply.

or

If you are installing from a downloaded ISO image file, browse to the image file, then click 
Open > OK > Apply.

12 If you want multiple virtual network adapters, click Network Adapters. 

Create virtual network adapters for the server. 

The default setting is a single paravirtualized network adapter.

13 If you are installing on an OES 2 SP3 VM host and you created a response file that you want to 
use for the NetWare installation, click Operating System Installation and complete the 
following tasks:  

13a Click Find, then browse to and select the file you created in Section 11.4.2, “Creating a 
Response File for an Unattended NetWare Installation,” on page 209.

13b Click Open > Apply.

The response file ’s path and filename should be displayed in the Automated Installation 
field on the Summary page.

14 When you have the virtual machine settings the way you want them, click OK to proceed with 
the creation of the virtual machine and the installation of the virtual NetWare server. 

A VNC viewer window appears, displaying the progress of the NetWare install program. 
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If you specified a response file, the installation uses the information you recorded in the 
response file. If a required parameter is missing in the response file, you are prompted to enter 
the desired values during the installation. 

15 If you did not specify a response file, you must do the following:

15a Click inside the installation window to set the mouse pointer.

The mouse is not used on the first few screens, but you must set it now. Otherwise, the 
mouse and the keyboard might not work as expected when the GUI pages appear.

15b Enter all of the installation information as you would for a physical NetWare installation. 

IMPORTANT: Do not close the VNC viewer window while the NetWare install program is 
running. Doing so prevents the installation from finishing properly.

11.5  Managing NetWare on a Virtual Machine
Virtualized NetWare is managed in the same way as if it were running on a physical machine. For 
information about managing your NetWare server, see the NW 6.5 SP8: Server Operating System 
Administration Guide. For additional information about managing NetWare servers in a virtualized 
environment, see “Running NetWare in a Virtualized EnvironmentNW 6.5 SP8: Server Memory 
Administration Guide” in the same guide.

 Section 11.5.1, “Using the Virtual Machine Manager,” on page 216

 Section 11.5.2, “Using the Command Line,” on page 216
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11.5.1  Using the Virtual Machine Manager

Managing a NetWare virtual machine is simplified by using the Virtual Machine Manager utility, 
which is installed by default when you install the Xen virtualization software.

To start the Virtual Machine Manager, open a terminal prompt and enter virt-manager.

For more information, see “Managing a Virtualization Environment (http://www.novell.com/
documentation/sles10/book_virtualization_xen/data/cha_xen_virtualization_manage.html)” in the 
Virtualization with Xen guide (http://www.novell.com/documentation/sles10/
book_virtualization_xen/data/book_virtualization_xen.html).

11.5.2  Using the Command Line

Many NetWare administrators prefer to manage the server through the command line. If you want to 
use the command line, you should be aware of the following issues:

 “Terminal Size” on page 216

 “NetWare Debugger” on page 216

 “VNC Viewer” on page 216

 “The xm Commands” on page 216

Terminal Size

The terminal window might display only 80x24 characters. If you don’t want to scroll to the 
command line, you need to resize the terminal. 

NetWare Debugger

If pressing Alt+Shift+Shift+Esc doesn’t launch the debugger, you can enter 386debug at the 
command line.

VNC Viewer

In the VNC Viewer, pressing F8 displays a pop-up utility menu. Press F8 twice to pass single F8 to 
the remote side.

The xm Commands

 You can also manage the NetWare virtual machine, and all other virtual machines, by using the 
xm command line tools. For more information, see “The xm Command (http://
www.novell.com/documentation/sles10/book_virtualization_xen/data/
sec_xen_virtualization_xm.html)” in the Virtualization with Xen guide (http://
www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html).

 To make a break in NetWare from a terminal, enter xm sysrq x c, where x is the domain ID 
and c is any keyboard character.
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11.6  If VM Manager Doesn’t Launch on a Xen VM 
Host Server
If the option to launch the VM Manager for installing a NetWare guest is not available, the most 
likely cause is that the Xen kernel is not running on the Xen VM host server. See The Boot Loader 
Program (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
sec_xen_config_bootloader.html) in the Virtualization with Xen guide (http://www.novell.com/
documentation/sles10/book_virtualization_xen/data/book_virtualization_xen.html).
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12Upgrading NetWare on a Xen-
based VM

 Section 12.1, “Upgrading the VM Host Server,” on page 219

 Section 12.2, “Upgrading the NetWare VM Guest Server,” on page 219

12.1  Upgrading the VM Host Server
Before you upgrade the NetWare VM guest servers on any Xen-based VM host servers, be sure to 
upgrade the host server to either SUSE Linux Enterprise Server (SLES) 10 SP4 or Open Enterprise 
Server (OES) 2 SP3, as applicable. 

For SLES 10 SP4 upgrade instructions, see the SLES 10 SP4 Installation and Administration Guide 
(http://www.novell.com/documentation/sles10/book_sle_reference/data/book_sle_reference.html).

For OES 2 SP3 upgrade instructions, see Chapter 5, “Upgrading to OES 2 SP3,” on page 119.

12.2  Upgrading the NetWare VM Guest Server
After you have upgraded the Xen VM host server, upgrading a NetWare 6.5 guest on the host server 
is the same as upgrading a physical installation. You accomplish this by installing the Support Pack 
8 (SP8), which is the same thing as NetWare 6.5 SP8, on the server. 

The only difference with upgrading a NetWare VM guest is the process of providing access to the 
SP8 media.

If the support pack is unzipped to a location on the guest, such as the sys: volume, the process of 
installing the support pack is exactly the same as on a physical server. 

If the support pack is unzipped on a DVD or to a location on the host server, you must add the DVD 
or location to the VM guest. Keep in mind that you can only specify a block device, such as a 
mounted DVD or the root of a separately defined partition on the VM host server. You cannot 
specify a directory where you unzipped the support pack files as a block device for the VM guest to 
access.

 Section 12.2.1, “Downloading the NetWare SP8 Zip File,” on page 219

 Section 12.2.2, “Providing Access to a Mounted DVD,” on page 220

12.2.1  Downloading the NetWare SP8 Zip File

1 Log into your Novell account and access the NetWare 6.5 SP8 e-Media Kit (http://
download.novell.com/Download?buildid=dpIR3H1ymhk~).

2 Download the NW65SP8.zip file.

3 Extract the support pack files contained in the zip file you downloaded.
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4 Complete the step that applies to your situation:

 If you extracted the file to a root-level directory on the VM guest, continue with the 
instructions in “Starting an Upgrade” in the NW65 SP8: Installation Guide.

 If you extracted the file to a partition on the VM host, see the Virtualization with Xen 
guide (http://www.novell.com/documentation/sles10/book_virtualization_xen/data/
book_virtualization_xen.html) for information on making a block device available to a 
VM guest. 

IMPORTANT: After adding the block device, you will probably need to reboot the 
NetWare VM guest before the guest will recognize the device.

 If you extracted the file to a DVD, continue with Providing Access to a Mounted DVD.

12.2.2  Providing Access to a Mounted DVD

After downloading the NW65SP8.zip file and extracting it to a DVD:

1 Insert the DVD in the VM host server.

2 On the desktop, click Computer > Virtual Machine Manager.

3 Select the NetWare VM guest you are upgrading, then click the Details button.

4 Click the Hardware tab.

5 Click the Add button.

6 In the Hardware Type drop-down list, select Storage Device, then click Forward.

7 Under Target in the Device Type drop-down list, select Virtual Disk (read only).

8 With the Normal Disk Partition option selected, click Browse.

9 In the Places column, double-click File System, then double-click the dev folder.

10 Click the dvd device file, then click Open.

11 Click Forward > Finish. 

You should see a new disk in the Hardware list.

12 In the NetWare VM guest’s machine console, open the file browser. 

13 If the DVD is listed, write down the volume name, then go to “Installing the Support Pack” 
Step 2 in the NW65 SP8: Installation Guide and complete the instructions there.

If the DVD is not listed, continue with Step 14.

14 Shut down and restart the NetWare VM. 

15  After the VM restarts, confirm that the DVD is listed, write down the volume name listed, then 
go to “Installing the Support Pack” Step 2 in the NW65 SP8: Installation Guide.
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13
13Disabling OES 2 Services

Although you can uninstall Novell Open Enterprise Server 2 (OES) Linux service RPMs through 
YaST, we do not recommend it because so many modules have interdependencies. Uninstalling 
services can leave the server in an undesirable state. Instead, we recommend disabling the service.

1 Log in as root and start YaST.

2 Click System > System Services (Runlevel).

3 Select Expert Mode.

4 Select the applicable_service_name, then click Set/Reset > Disable the service.

5 Repeat Step 4 for each service you want to disable.

6 Click Finish to exit the YaST Runlevel tool.

NOTE: YaST does not support removing products that create objects or attributes in eDirectory. 
You need to use iManager to remove these objects and attributes. For procedures, see “Deleting an 
Object” in the Novell iManager 2.7.4 Administration Guide.
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14
14Reconfiguring eDirectory and OES 
Services 

If the eDirectory database becomes corrupt, you need to reconfigure eDirectory and the OES 
services. This section outlines the steps to be performed, depending on the role of the server with 
regard to your eDirectory tree. 

If a backup of the eDirectory database is not available, you can contact Novell Support or perform 
the following procedures: 

 Section 14.1, “Cleaning Up the eDirectory Server,” on page 223

 Section 14.2, “Reconfiguring the eDirectory Server through YaST,” on page 225

 Section 14.3, “Reconfiguring OES Services,” on page 225

14.1  Cleaning Up the eDirectory Server
Novell does not recommend performing the operations in this section unless you have problems 
with eDirectory that aren’t resolved by performing regular eDirectory maintenance tasks, or unless 
Novell Support recommends that you do them. 

 Section 14.1.1, “Before You Clean Up,” on page 223

 Section 14.1.2, “Reconfiguring the Replica Server,” on page 223

 Section 14.1.3, “Reconfiguring the CA Server,” on page 224

 Section 14.1.4, “Cleaning Up eDirectory,” on page 224

14.1.1  Before You Clean Up 

 Before the cleanup, make a note of the following eDirectory configuration parameters:

 eDirectory tree name

 Replica server IP

 eDirectory admin context

 eDirectory server context

 IP address of servers running NTP and SLP services

 If you are cleaning the master replica server, ensure that you make a read-write replica as a 
master. For more information, see Section 14.1.2, “Reconfiguring the Replica Server,” on 
page 223.

 If the reconfiguration is performed on a CA server, transfer the role of CA server to another 
server or create a new CA server. If you don’t do this, the CA does not work. For more 
information, see Section 14.1.3, “Reconfiguring the CA Server,” on page 224.

14.1.2  Reconfiguring the Replica Server

1 If the corrupted server is a master replica, make any other replica into the master replica. 
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For more information, refer to Managing Partitions and Replicas (http://www.novell.com/
documentation/edir88/edir88/?page=/documentation/edir88/edir88/data/a2iiiik.html) in the 
Novell eDirectory 8.8 Administration Guide.

2 Clean up the replica server. 

For more information, see Section 14.1.4, “Cleaning Up eDirectory,” on page 224.

3 Reconfigure the replica server. 

For more information, see Section 14.2, “Reconfiguring the eDirectory Server through YaST,” 
on page 225. 

4 On successful reconfiguration of the replica server, continue with Section 14.3, “Reconfiguring 
OES Services,” on page 225.

14.1.3  Reconfiguring the CA Server

1 If the corrupted server is a CA server, transfer the CA server role to another server or create a 
new CA server. 

For more information, refer to Moving the Organizational CA to a Different Server (http://
www.novell.com/documentation/crt33/crtadmin/data/a2ebop8.html#acea8nu) and Creating a 
Server Certificate Object (http://www.novell.com/documentation/crt33/crtadmin/data/
fbgcdhec.html) in the Novell Certificate Server 3.3.2 Adminstration Guide.

2 Clean up the server. 

For more information, see Section 14.1.4, “Cleaning Up eDirectory,” on page 224.

3 Reconfigure the server. 

For more information, see Section 14.2, “Reconfiguring the eDirectory Server through YaST,” 
on page 225. 

4 After successfully reconfiguring the server, continue with Section 14.3, “Reconfiguring OES 
Services,” on page 225.

14.1.4  Cleaning Up eDirectory

1 Stop the ndsd daemon:

rcndsd stop

2 Delete the eDirectory configuration file and eDirectory instance file.:

rm -f /etc/opt/novell/eDirectory/conf/nds.conf

rm -f /etc/opt/novell/eDirectory/conf/instances.0 

3 Delete the eDirectory database:

 rm -rf /var/opt/novell/eDirectory/data/dib

4 Use iManager to delete the NCP server object, HTTP server object, SNMP group object, LDAP 
server object, and LDAP group object from the eDirectory tree. 

5 Remove the server from the replica ring. 

For more information, see Section 17.7.1, Cleaning Up the Replica Ring (http://
www.novell.com/documentation/edir88/edir88/?page=/documentation//edir88/edir88/data/
agm7hq7.html) in the Novell eDirectory 8.8 Administration Guide.
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14.2  Reconfiguring the eDirectory Server 
through YaST 
The eDirectory reconfiguration can be done on the Root partition Master replica server, a Read-
Write replica server, a server without a replica, or the CA server.

1 Open YaST.

2 Click Open Enterprise Server > OES Install and Configuration. 

3 On the Software Selection Page, click Accept.

The status of eDirectory service is displayed as Reconfigure is disabled. 

4 To reconfigure, click disabled to change the status to enabled. 

5 Click eDirectory to access the configuration dialog box. 

6 Provide all the eDirectory configuration information that was noted in Section 14.1.1, “Before 
You Clean Up,” on page 223:

6a Verify the eDirectory tree name and click Next.

6b Specify the admin password and click Next.

6c Specify the server context and click Next. 

6d Specify the IP address of the Network Time Protocol Server.

6e (Conditional) If SLP was configured earlier, select Configure SLP to use an existing 
Directory Agent, then click Add.

6f Specify the SLP DA server IP address and click Add.

6g Click Next.

7 In the Novell Modular Authentication Service (NMAS) window, click Next.

8 Verify the listed configuration information and click Next.

eDirectory is configured and installation is successfully completed.

9 Click Finish.

14.3  Reconfiguring OES Services
After you have successfully configured eDirectory, some of the OES services are started by default, 
some services require a manual start, some services require the eDirectory objects to be re-created, 
and some services must be reconfigured.
Reconfiguring eDirectory and OES Services 225



226 OES 2
Table 14-1   Services

 Section 14.3.1, “Re-creating eDirectory Objects,” on page 226

 Section 14.3.2, “Services Requiring Reconfiguration,” on page 227

 Section 14.3.3, “Manually Starting Services,” on page 228

14.3.1  Re-creating eDirectory Objects

 “Novell Storage Service” on page 226

 “NCP Server” on page 227

Novell Storage Service

Use the NSS Management utility to re-create the eDirectory objects for NSS pools and volumes. For 
additional information, see NSS Management Utility Quick Reference (http://www.novell.com/
documentation/oes2/stor_nss_lx/data/boswzl1.html) in the NSS Administration Guide. 

1 Re-create the eDirectory object for each NSS pool:

1a Start NSSMU by entering the following command at the command prompt:

nssmu

1b Select Pools and press Enter to list all the NSS pools.

1c Select a pool that needs to be re-created and press F4.

1d Select Yes when you are prompted to delete and re-create an NDS pool object.

The selected NDS pool object is re-created.

1e Repeat from Step 1c for each NDS pool object that needs to be re-created.

Starts by Default Start Manually Re-create Objects Reconfigure

SMS Novell AFP NSS Novell DNS

LUM NCS NCP Novell CIFS

NRM Archive and Version 
Services

SLP

Novell FTP Novell DHCP NMAS

Novell iFolder iPrint

Groupwise Novell Samba

DST NetStorage

DFS iManager

 WBFM NTP

Welcome Page

CASA QuickFinder

VLOG Utility 
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2 Re-create the eDirectory object for each NSS volume:

2a In NSSMU, select Volumes and press Enter to list all the NSS volumes.

2b Select a volume and press F4.

2c Select Yes when you are prompted to delete and re-create the NDS volume object.

The selected volume object is re-created.

2d Repeat from Step 2b for each NDS volume object that needs to be re-created.

3 (Conditional) If the eDirectory object for _ADMIN volume exists, execute the following 
command:

 rcadminfs restart

NCP Server

Use the NCP server console (NCPCON) utility to delete and re-create the eDirectory objects for the 
NCP volumes. For more information on the NCPCON utility, see NCP Server Console Utility (http:/
/www.novell.com/documentation/oes2/file_ncp_lx/?page=/documentation/oes2/file_ncp_lx/data/
ba456t4.html#ba440lz) in the NCP Server for Linux Administration Guide.

IMPORTANT: If restoration of the eDirectory database is not possible, simply delete the NCP 
server object.

1 Delete the eDirectory object of the NCP volume by entering the following command:

ncpcon remove volume SYS

2 Re-create the eDirectory object of the NCP volume by entering the following command:

ncpcon create volume SYS /usr/novell/sys

14.3.2  Services Requiring Reconfiguration

 “Novell DNS” on page 227

 “Novell CIFS” on page 228

 “Novell SLP” on page 228

 “NMAS” on page 228

Novell DNS

1 Open YaST.

2 Click Open Enterprise Server > OES Install and Configuration. 

3 On the Software selection page, click Accept.

The status of the Novell DNS service is displayed as Reconfigure is Disabled. 

4 To reconfigure the DNS service, click disabled to change the status to enabled. 

5 Click the DNS Services heading link and enter the admin password to access the configuration 
dialog box. 

6 Validate the displayed information and click Next.

7 Ensure that the Create DNS Server Object check box is not selected, then click Next.
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8 Verify the configuration information and click Next.

9 Click Finish to complete the Novell DNS reconfiguration.

Novell CIFS

1 Open YaST.

2 Click Open Enterprise Server > OES Install and Configuration. 

3 Click Accept to skip the Software Selection page.

The status of Novell CIFS service is displayed as Reconfigure is Disabled. 

4 To reconfigure CIFS, click the Disabled link to change the status to Enabled. 

5 Click the Novell CIFS services heading link and enter admin password to access the 
configuration dialog box. 

6 Validate the displayed information and click Next. 

7 Provide the user context and select the password policy of the previous CIFS configuration, 
then click Next.

8 Verify the configuration information and click Next.

9 Click Finish to complete the CIFS reconfiguration.

Novell SLP

The SLP DA IP address is added during eDirectory reconfiguration. See Step 6e on page 225 for 
more information.

NMAS

The NMAS login method is selected during eDirectory reconfiguration. See Step 7 on page 225 for 
more information.

14.3.3  Manually Starting Services 

Re-create the eDirectory objects of NCP and NSS volumes as directed in the Section 14.3.1, “Re-
creating eDirectory Objects,” on page 226, before starting the following services manually:

Table 14-2   Manually Restarting Services

Service Name Starting the Service

Novell AFP rcnovell -afptcpd start

Novell Cluster Service (NCS) rcnovell -ncs start

Archive and Version Service rcnovell -ark start

rcadminfs start

NetStorage rcnovell -xregd start

rcnovell -xsrvd start
 SP3: Installation Guide



QuickFinder Generate the index again from QuickFinder 
Administration.

Samba Start the Samba service through iManager

Novell DHCP rcnovell -dhcpd start

iPrint rcnovell -ipsmd start

rcnovell -idsd start

iManager /etc/init.d/tomcat5 start

rcapache2 restart

NTP rcntpd restart

Service Name Starting the Service
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15
15Security Considerations

This section includes issues that you should consider when installing and configuring a Novell Open 
Enterprise Server 2 (OES) Linux server.

 Section 15.1, “Password for User Admin Written in Clear Text in control.xml,” on page 231

 Section 15.2, “Access to the Server During an Installation or Upgrade,” on page 231

 Section 15.3, “Remote Installations Through VNC,” on page 231

 Section 15.4, “Improperly Configured LDAP Servers,” on page 231

15.1  Password for User Admin Written in Clear 
Text in control.xml
When you create a control.xml file by using AutoYast, the eDirectory password for user Admin is 
written in clear text. This password can be read by anyone who has access to the file. Linux 
passwords are stored in the file in a hashed form.

We recommend controlling access to this file.

15.2  Access to the Server During an Installation 
or Upgrade
Because eDirectory passwords are not obfuscated in system memory during the installation or 
upgrade, we recommend not leaving a server unattended during installation, upgrade, or 
configuration.

You can use SSH (secure shell) to access the system to perform an installation. However, only 
authorized users can access the installation.

15.3  Remote Installations Through VNC
When you install the server, we recommend that you do not use Virtual Network Computing (VNC) 
for remote installation in an untrusted environment. Consider using one of the more secure options 
(such as SSH) as outlined in “Installation Scenarios for Remote Installation” in the SLES 10 
Installation and Administration Guide (http://www.novell.com/documentation/sles10/
book_sle_reference/data/sec_deployment_remoteinst_scenario.html).

15.4  Improperly Configured LDAP Servers
Issue 1:  Improperly configured LDAP servers allow any user to connect to the server and query for 
information.

An eDirectory LDAP server enables NULL BIND by default, but allows it to be disabled on the 
server. To enhance the security of the OES server, disable the NULL BIND on LDAP server port 
389. See “Configuring LDAP Services for Novell eDirectory” in the Novell eDirectory 8.8 
Administration Guide.
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Issue 2: Improperly configured LDAP servers allow the directory BASE to be set to NULL. This 
allows information to be culled without any prior knowledge of the directory structure. Coupled 
with a NULL BIND, an anonymous user can query your LDAP server through a tool such as 
LdapMiner.

An eDirectory LDAP server allows the directory BASE to be set to NULL, and there is no way to 
disable it. However, with the NULL BIND disabled, as previously mentioned, the security threat 
posed by this feature is minimized.
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A
AInstalling with EVMS as the 
Volume Manager of the System 
Device

This section describes how to modify the default partitioning scheme for the system device during 
installation of Novell Open Enterprise Server 2 (OES) and Novell Storage Services (NSS) so that 
the system device is managed by the Enterprise Volume Management System (EVMS) instead of the 
Linux Volume Manager 2 (LVM2). 

IMPORTANT: For the purpose of this documentation, a system device is any device that contains 
the Linux /boot, swap, or root (/) partitions for your OES 2 server. 

 Section A.1, “Using EVMS to Manage the System Device,” on page 233

 Section A.2, “Configuring the System Device to Use EVMS,” on page 234

 Section A.3, “Installing SLES 10 SP4 and Post-Installing OES 2 SP3,” on page 239

 Section A.4, “Using EVMS to Manage Devices,” on page 240

A.1  Using EVMS to Manage the System Device
The Novell Storage Services file system requires that the Enterprise Volume Management System 
(EVMS) be used as the volume manager of devices that contain (or will contain) NSS pools and 
volumes. NSS management tools cannot see devices managed by non-EVMS volume managers, so 
those devices and the space on them are unavailable for creating NSS pools and volumes. EVMS 
also makes it possible to use the full range of services that NSS offers. NSS is not supported or 
tested for non-EVMS volume managers. 

IMPORTANT: NSS management tools require that the devices you use for NSS pools and volumes 
be managed by EVMS. 

For a list of the NSS capabilities that are not available when using a non-EVMS volume manager, 
see “NSS Limitations for Non-EVMS Volume Managers” in the OES 2 SP3: NSS File System 
Administration Guide for Linux.

SUSE Linux Enterprise Server 10 supports LVM2 and EVMS as volume managers; however, a 
given device can be managed by only one volume manager at a time. LVM2 is the default volume 
manager for SUSE Linux. During the install, the YaST Installation Settings page automatically 
recommends a partitioning scheme that uses LVM2 as the volume manager of the primary device 
and that allocates the entire disk for the Linux system partitions and POSIX file systems. 
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This default partitioning scheme creates two problems for administrators who want to use NSS 
pools and volumes on the same device as the system partitions:

 NSS management tools cannot see devices that are managed by LVM2. Therefore, any 
unpartitioned free space on the system device is not available to be used for NSS pools and 
volumes.

 The default LVM partitioning scheme allocates the entire device for Linux POSIX file systems, 
so there is no free space available to be used later. 

Possible workarounds for these problems are:

 (Recommended) Use Additional Disks for NSS Pools and Volumes: Use multiple devices 
on the server, and reserve the system device for system partitions and Linux POSIX file 
systems. Create NSS pools and volumes on the non-system disks only.

This solution does not require that the system device be managed by EVMS. During the install, 
use LVM2 as the volume manager for the system device. Do not partition or configure the non-
system devices during the install. Otherwise, follow the install procedures described in 
Section A.2, “Configuring the System Device to Use EVMS,” on page 234. Any free space on 
the LVM2-managed system device is not seen by NSS management tools and is not available 
for creating NSS pools. 

After the install, you can create NSS pools or Linux POSIX file systems on other EVMS-
managed devices. 

 (Supported) Modify the Partitioning Scheme During Install: At install time, modify the 
partitioning scheme for the system device to use EVMS and to leave unpartitioned free space 
available on the device that can be used later for NSS pools.

NOTE: This option applies to physical machines. With virtual machines, you can easily add a 
second virtual disk to use for NSS pools and volumes.

Beginning in OES 2 SP3, the Partitioner in the YaST Install offers the Create EVMS Based 
Proposal option. Follow the procedure in Section A.2, “Configuring the System Device to Use 
EVMS,” on page 234. 

After the install, you can create NSS pools or Linux POSIX file systems on the system device 
and on any additional disks. For information about creating NSS and Linux POSIX file systems 
on EVMS-managed devices, see Section A.4, “Using EVMS to Manage Devices,” on 
page 240.

A.2  Configuring the System Device to Use EVMS
Beginning in OES 2 SP3, the Partitioner in the YaST install offers the Create EVMS Based Proposal 
option. For unpartitioned devices over 20 GB in size, this option creates a boot partition and a 
system partition for the container that holds the swap and / (root) volumes. 

 Section A.2.1, “Understanding the EVMS–Based Partitioning Scheme,” on page 235

 Section A.2.2, “Prerequisites,” on page 235

 Section A.2.3, “Modifying the Installation Settings,” on page 235
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A.2.1  Understanding the EVMS–Based Partitioning Scheme

Using EVMS to manage the system device allows you to later add NSS pools and volumes on any 
unpartitioned free space on it. You must modify the partitioning scheme to use EVMS during the 
install. It is not possible to change the volume manager for the system device after the install. 

Beginning in OES 2 SP3, the Partitioner in the YaST Install offers the Create EVMS Based Proposal 
option to automatically create an EVMS solution for the system device. For unpartitioned devices 
over 20 GB in size, this option creates a boot partition and a container for the swap and / (root) 
volumes in up to the first 20 GB, and leaves the remainder of the space on the device as 
unpartitioned free space. 

Table A-1 shows the default proposed setup for a machine with 768 MB RAM. The default swap 
size is 1 GB or larger, depending on the size of the RAM on your machine. The remainder of the 
device is left as unpartitioned free space.

Table A-1   Default EVMS Proposal for Devices over 20 GB in Size

A.2.2  Prerequisites

This setup assumes that you have a single device in your physical server and you want to add NSS 
pools and volumes on the device after the install.

 The device must be unpartitioned.

If the device has existing partitions, you can remove them all or specify which ones to keep 
during the install as described in Step 3 on page 236.

 The device must be over 20 GB in size.

A.2.3  Modifying the Installation Settings 

The procedure in this section describes how to use the Create EVMS Based Proposal option in the 
YaST Partitioner to modify the partitioning settings during the install of OES 2 SP3 or later.

IMPORTANT: The procedure assumes SCSI devices and refers to device node names with the sdn 
notation. Other device drivers use different notation for device node names. For example, IDE 
drives use the hdn notation. 

1 Begin the SLES 10 SP4 install for OES 2 SP3. 

For information, see “Installing OES 2 SP3 as a New Installation” on page 47.

Device Size Type Mount Point

/dev/sda1 70.5 MB Ext2 /boot

/dev/sda2 14.9 GB Linux LVM

/dev/evms/lvm2/system 14.9 GB EVMS lvm2/system

/dev/evms/lvm2/system/root 10.0 GB EVMS /

/dev/evms/lvm2/system/swap 1.1 GB EVMS swap
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2 When the installation reaches the Installations Settings page, select Partitioning to open the 
Partitioner and modify the default device setup.

For example, a default device setup might look like the one below: 

3 If the device is already partitioned, you must remove some or all of the partitions before you 
use the EVMS-based partitioning proposal. If the device is unpartitioned, skip to Step 4.

3a On the Suggested Partitioning page under Partitioning, select Create Custom Partition 
Setup.

3b On the Preparing Hard Disk: Step 1 page, select the disk, then click Next.

3c On the Preparing Hard Disk: Step 2 page under Disk Areas to Use, do one of the following 
to specify which partitions can be deleted:

WARNING: The data on the deleted partitions will no longer be available.

 Keep One or More Partitions: Select only those partitions that can be deleted; 
deselect (clear the check box) the partitions that you want to keep.

This allows you to keep partitions if they have data on them that you don’t want to be 
deleted. This is very important if the disk was used previously, and has an NSS 
partition with pools that you want to keep.
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 Remove All Partitions: Click Use Entire Hard Disk. All of the partitions on the disk 
are selected for deletion.

3d On the Preparing Hard Disk: Step 2 page under Proposal type, select Create an EVMS 
Based Proposal.

3e Skip to Step 5.

4 If the device is unpartitioned, on the Suggested Partitioning page under Partitioning, select 
Create EVMS Based Proposal.

5 Click Next to create the default EVMS-based partitioning scheme.
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This deletes the LVM2 proposed partitions and the related partition table on the disk and 
replaces them with the EVMS proposed partitions and setup described in Section A.2.1, 
“Understanding the EVMS–Based Partitioning Scheme,” on page 235. 

On the Installation Settings page, the new EVMS partitioning scheme is displayed.

6 Modify the software settings to install NSS.:

IMPORTANT: This step describes essential services for NSS. You can optionally install other 
OES 2 services on the same server. For information, see Section 2.7, “Deciding What Patterns 
to Install,” on page 30.

6a On the Installations Settings page, click Software to go to the Software Selections and 
System Tasks page.

6b Select Novell Storage Services from the available OES Services options. 

Novell Distributed File Services is part of NSS, so it is automatically installed whenever 
you install NSS. When you select Novell Storage Services, the following additional OES 
services are automatically selected:

 Novell Backup / Storage Management Services

 Novell eDirectory

 Novell Linux User Management

 Novell NCP Server / Dynamic Storage Technology

6c (Optional) Select Novell iManager to be installed on the server.

You must install iManager somewhere in the same tree as the server. If you install 
iManager and NSS on the same server, the storage-related plug-ins are automatically 
installed.
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If you install iManager on a different server, make sure you install the storage-related 
plug-ins that you need to manage NSS file system and services. For information about 
installing storage-related plug-ins on an existing server, see “Novell iManager and 
Storage-Related Plug-Ins” in the OES 2 SP3: NSS File System Administration Guide for 
Linux.

6d Click Accept to return to the Installation Settings page. 

7 If you are prompted to accept proprietary modules being installed, accept them.

8 Continue with the OES 2 installation.

Refer to the product documentation for information about configuring OES Services that are 
being installed. For general information about the install, see “Installing OES 2 SP3 as a New 
Installation” on page 47.

A.3  Installing SLES 10 SP4 and Post-Installing 
OES 2 SP3
It is also possible to install SLES 10 SP4 with EVMS as the system device, and then post-install 
OES 2 SP3 with NSS and other components. 

1 Install SLES 10 SP4 and use EVMS as the system device.

For information, see “Configuring the System Device at Install to Use EVMS” (http://
www.novell.com/documentation/sles10/stor_admin/data/configsysdevatinstall.html) in the 
SLES 10 SP4: Storage Administration Guide (http://www.novell.com/documentation/sles10/
stor_admin/data/bookinfo.html).

2 Use the Create EVMS Proposal option to partition the device with EVMS as the volume 
manager.
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For instructions, see Step 2 through Step 5 in Section A.2, “Configuring the System Device to 
Use EVMS,” on page 234.

3 After the install and before you reboot the server, make sure to following the setup instructions 
in “After the Install” (http://www.novell.com/documentation/sles10/stor_admin/data/
configsysdevatinstall.html#b1xfw90) in the SLES 10 SP4: Storage Administration Guide 
(http://www.novell.com/documentation/sles10/stor_admin/data/bookinfo.html).

4 In YaST, use the OES 2 SP3 Add-on disk to post-install NSS and other OES 2 components.

For information about selecting patterns, see Step 6 in Section A.2, “Configuring the System 
Device to Use EVMS,” on page 234.

For information about post-installing, see Chapter 4, “Installing or Configuring OES 2 SP3 on 
an Existing Server,” on page 113.

5 ,If the NSS services do not start automatically after you install NSS and reboot the server, use 
one of the following methods to start NSS. Thereafter, NSS should start automatically on 
reboot.

32-bit: At a terminal console prompt, enter the following commands:

cd /lib/modules/`uname -r`/updates
depmod -a
rcnovell-nss start

64-bit: At a terminal console prompt, enter

rcnovell-nss start

A.4  Using EVMS to Manage Devices
You can use the free space on the system device for NSS or Linux POSIX file systems. Consider the 
guidelines below when working with EVMS-managed devices.

 Section A.4.1, “NSS File Systems on EVMS-Managed Devices,” on page 240

 Section A.4.2, “Linux POSIX File Systems on EVMS-Managed Devices,” on page 241

A.4.1  NSS File Systems on EVMS-Managed Devices

Use only an NSS tool (such as NSSMU or the Storage plug-in to iManager) to create a pool on a 
new EVMS-managed device. The tool automatically carves out a partition with the DOS Segment 
Manager so that the device can be used later for either NSS or Linux POSIX file systems. Then the 
tool adds the NetWare Segment Manager and creates the NSS partition and pool.

For the best performance, if you plan to use a non-system device for both NSS and Linux POSIX 
file systems, create the NSS file systems on the device first. NSS partitions the device in a manner 
that ensures the best performance for the NSS file systems, and does not adversely affect 
performance for Linux POSIX file systems.

For instructions for creating pools and volumes, see the “Managing NSS Pools” and “Managing 
NSS Volumes” in the OES 2 SP3: NSS File System Administration Guide for Linux.
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A.4.2  Linux POSIX File Systems on EVMS-Managed Devices

Use the Linux EVMSGUI tool (evmsgui) to create Linux POSIX file systems on the EVMS-
managed device. For EVMS-managed devices, Linux POSIX file systems require that the Linux 
partitions be managed by the DOS Segment Manager (DOSSegMgr). This is laid down 
automatically if you first create an NSS file system on the device.

WARNING: EVMS administration utilities (evms, evmsgui, and evmsn) should not be running 
when they are not being used. EVMS utilities lock the EVMS engine, which prevents other EVMS-
related actions from being performed. This affects both NSS and Linux POSIX volume actions.

NSS and Linux POSIX volume cluster resources should not be migrated while any of the EVMS 
administration utilities are running.

Failure to observe this warning could cause a system hang and lead to data corruption.

Consider the following guidelines when working with EVMSGUI to create a Linux POSIX 
partition:

If no partitions are on the device, use the following procedure to add a DOS Segment Manager to a 
non-clustered device:

1 Log in as the root user, open a terminal console, then enter

evmsgui

2 If necessary, remove the NetWare Segment Manager:

2a Click the Disks tab, then locate and select the device, such as device sdb.

Scenario To create the Linux partition in evmsgui:

Free space is controlled by the 
DOS Segment Manager.

Create the Linux partition as usual.

Disk is not initialized. 1. Select No at the prompt to initialize. 

On a pure SLES system (no NSS), ignore this step.

2. Delete the disk object from the Volumes tab.

3. Add the DOS Segment Manager to the device.

4. Create the Linux partition as usual.

Free space is controlled by the 
NetWare Segment Manager.

Do one of the following:

 If no partitions are on the device, remove the NetWare Segment 
Manager from the device, add the DOS Segment Manager, then 
create the partition as usual.

WARNING: Changing the segment manager initializes the disk 
again (destroys existing data), so you should do this only with a 
disk that has no partitions on it, or if you do not want any of the 
partitions that are currently on the disk.

 If partitions exist, reboot the server to automatically give control 
of the device back to the DOS Segment Manager, then create 
the partition as usual.
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2b Right-click the device, then select Remove segment manager from Object.

This option appears only if there is an existing segment manager for the selected disk.

2c Select the listed segment manager, click Remove, then click OK.

WARNING: All data on the selected disk space is destroyed.

2d Click Save, then click Save again to save your changes.

3 Add the DOS Segment Manager:

3a From the EVMSGUI menu, click Actions > Add > Segment Manager to Storage Object.

3b On the Add Segment Manager to Storage Object page, select DOS Segment Manager, 
then click Next.

3c On the Select Plugin Acceptable Objects page, select the device where you want to add the 
segment manager, then click Next.

3d On the Configurable Options page, select the disk type (Linux is the default), click Add, 
then click OK.

3e Click Save, then click Save again to save your changes.

4 Create a segment for the DOS Segment Manager.

The DOS Segment Manager requires you to create a segment before creating an EVMS 
volume. Without a segment, the additional segment manager does not appear when you attempt 
to create an EVMS volume.

4a From the evmsgui menu, click Actions > Create > Segment.

4b On the Create Disk Segment page, select DOS Segment Manager, then click Next.

4c On the Select Plugin Acceptable Objects page, select the device where you want to add the 
segment, then click Next.

4d Specify the size of the segment, the partition type (such as Linux LVM), click Create, then 
click OK.

4e Click Save, then click Save again to save your changes.

For information about adding or changing segment managers when you are clustering a shared 
device with Novell Cluster Services, see “Creating Linux POSIX Volumes on Shared Devices” in 
the OES 2 SP3: Novell Cluster Services 1.8.8 Administration Guide for Linux.
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B
BOES 2 SP3 File and Data Locations

This section contains information about the general rules and conventions that Novell follows when 
determining where various data types and program components are stored on the Linux file system. 

Where possible, we have tried to ensure that Open Enterprise Server (OES) 2 SP3 components 
follow Linux Standard Base (LSB) requirements regarding file location. Efforts to do this are 
detailed here.

 Section B.1, “General Rules,” on page 243

 Section B.2, “Exceptions,” on page 244

B.1  General Rules
Where possible, product design has followed these rules:

 /opt/novell:  Contains all static data in the following standard subdirectories. 

 /etc/opt/novell:  Generally contains host-specific configuration data.

If a product has a single configuration file, it is named product or service.conf.

If a product uses multiple configuration files, they are placed in a subdirectory named for the 
product or service.

 /etc/opt/novell/service_name:  Contains various OES service configuration files.

 /var/opt/novell:  Contains all variable data.

Variable data (data that changes during normal run time operations) is stored in a product or 
service subdirectory.

 /var/opt/novell/log:  Generally contains log files.

If a product or service has a single log file, it is stored in a file with the product or service name.

If a product or service has multiple log files, they are stored in a subdirectory named for the 
product or service.

 All files and directories that could not follow the above rules have the prefix novell- where 
possible.

/opt/novell/bin Executable files that are used by multiple products or are 
intended to be executed by an end user.

/opt/novell/product/sbin Executable files that are used only by a product and are 
not executed by an end user.

/opt/novell/lib Shared libraries that are used by multiple products and 
shared or static libraries that are part of an SDK.

/opt/novell/include Header files for SDKs, typically in a product subdirectory.

/opt/novell/oes_install The OES installation and uninstallation code.
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B.2  Exceptions
Some files must reside in nonstandard locations for their products to function correctly. Two 
examples are init scripts, which must be in /etc/init.d, and cron scripts, which must be in /etc/
cron.d. When possible, these files have a novell- prefix. 

When standard conventions preclude the use of prefixes (such as PAM modules, which use suffixes 
instead of prefixes), the standard conventions are followed.
 SP3: Installation Guide



C
CUpgrading to OES 2 SP3 Through 
a ZENworks Linux Management 
Server

Use the information in the sections that follow to upgrade an OES 2 SP2 server to OES 2 SP3 
through a ZENworks Linux Management (ZLM) server and either the SP3 patch channel or a 
downloaded OES 2 SP3 ISO image file.  

 Section C.1, “Using a ZLM Server and the Patch Channel to Upgrade,” on page 245

 Section C.2, “Using a ZLM Server and an ISO Image File to Upgrade,” on page 252

 Section C.3, “Known Issues,” on page 259

C.1  Using a ZLM Server and the Patch Channel 
to Upgrade

NOTE: All of the examples in this section reflect the x86_64 (64-bit) platform.

The information and instructions in the following sections help you perform an unattended, online 
upgrade from Open Enterprise Server (OES) 2 SP2 to OES 2 SP3 by using ZENworks Linux 
Management (ZLM) and the OES 2 SP3 patch channel. 

After completing the instructions in the following sections, OES 2 SP2 servers are upgraded 
according to the schedule you set.

 Section C.1.1, “Preparing the Environment,” on page 245

 Section C.1.2, “Mirroring the Channels to Your ZENworks Linux Management Server,” on 
page 246

 Section C.1.3, “Creating OES 2 SP3 Bundles,” on page 247

 Section C.1.4, “Assigning the Bundles and Scheduling Upgrades,” on page 249

 Section C.1.5, “Creating the answer and prereboot.sh Files,” on page 250

 Section C.1.6, “Post-Installation Script File,” on page 251

 Section C.1.7, “Sample XML file for Mirroring,” on page 252

C.1.1  Preparing the Environment

Before you can use ZENworks Linux Management to upgrade OES 2 SP2 servers to OES 2 SP3, 
you must have the following:

 The ZENworks Linux Management 7.3 IR3 server installed and running on your network.

 The ZENworks Linux Management 7.3 IR3 Agent installed on each OES 2 SP2 server that you 
plan to upgrade. 
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IMPORTANT: The agent included with OES provides package-management capabilities 
through the ZENworks Management Daemon. Unless the full agent is installed, updates cannot 
be scheduled from the ZENworks Linux Management server.

 Each OES 2 SP2 server registered with the ZENworks Linux Management server. 

 Each OES 2 SP2 server updated with the latest OES 2 SP2 and SUSE Linux Enterprise Server 
(SLES) 10 SP3 patches.

C.1.2  Mirroring the Channels to Your ZENworks Linux 
Management Server

Use the instructions in this section to create a mirror of the following OES 2 SP3 patch channels on 
your ZENworks Linux Management server.

 OES2-SP3-Online

 OES2-SP3-Pool

1 Save the zlm-mirror-conf.xml file to a working area on your workstation or server. For a 
sample file, see Section C.1.7, “Sample XML file for Mirroring,” on page 252. 

2 Open zlm-mirror-conf.xml in a UNIX text editor and customize it as shown in the 
following table:

Replace/Remove With

USERID The DeviceID of your ZENworks Linux Management server, which is 
used to authenticate to the nu.novell.com server.

1. To find the DeviceID, log in as root and enter the following 
command at a terminal prompt:

cat /etc/zmd/deviceid

The DeviceID is prepended to the terminal prompt. 

For example, if 123abc:myserver/ is displayed, the DeviceID is 
123abc.

PASSWORD The Secret of your ZENworks Linux Management server. 

1. To find the Secret, log in as root and enter the following 
command at a terminal prompt:

cat /etc/zmd/secret

The Secret is prepended to the terminal prompt. 

For example, if 456def:myserver/ is displayed, the Secret is 
456def.

ZLM-ADMINID The account name that the mirror operation uses to attach to the local 
ZENworks Linux Management server. 

Replace this only if you are using a different server administrative 
account to mirror the channels.

ZLM-ADMINPASSWORD The password for the administrative account (the default is 
administrator) that the mirror operation uses to attach to the local server.
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IMPORTANT: These customizations are required for the mirror operation to succeed. 
Experienced administrators might want to make further modifications to the zlm-mirror-
conf.xml file, but such modifications should be confined to those fields that have no values 
specified. For information on customizing the file, see the information in Mirroring Software 
(http://www.novell.com/documentation/zlm73/lm7admin/?page=/documentation/zlm73/
lm7admin/data/bvel3dn.html#bvel3dn) and zlmmirror(1) (http://www.novell.com/
documentation/zlm73/lm7admin/?page=/documentation/zlm73/lm7admin/data/
b74o97x.html#b74o97x) in the Novell ZENworks 7.3 Linux Management Administration Guide 
(http://www.novell.com/documentation/zlm73/lm7admin/?page=/documentation/zlm73/
lm7admin/data/front.html).

3 If the zlm-mirror-conf.xml file is on your workstation, copy it to a directory of your 
choosing on the ZENworks Linux Management server, for example /root/zlm_conf_files.

4 As the root user at a terminal prompt, change to the directory containing the zlm-mirror-
conf.xml file and enter the following command:

zlmmirror m -c zlm-mirror-conf.xml -v --force-nevra

The files start downloading to the server. Depending on your download speed, the mirror 
operation could take a few hours to complete. 

C.1.3  Creating OES 2 SP3 Bundles

For the upgrade process, you need to create the following bundles on the ZLM server:

 “OES2-SP3-file-bundle” on page 247

 “OES2-SP3-firstboot-bundle” on page 248

OES2-SP3-file-bundle

You must create the answer file and the prereboot.sh file before executing the following steps.

1 Log in to ZENworks Control Center.

2 Click Bundles.

3 In the Bundles panel, click New > Bundle.

4 Select File Bundle, then click Next.

5 In the Name field, type OES2-SP3-file-bundle.

6 Click Next.

The file bundle is ready to have files added to it.

7 Add the prereboot.sh file to OES2-SP3-file-bundle:

7a In the Files panel, click Add > Upload.

7b In the Destination field, type /tmp.

<Target> </Target> The two <Target>...</Target> entries in each section indicate that 
both the i586 (32-bit) and x86_64 (64-bit) patches are needed. If you 
have only one architecture type deployed, you can remove the entry for 
the architecture you don’t use.

Replace/Remove With
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7c In the Target Platforms list, select sles-10-x86_64.

7d Click Add File, browse to and select the prereboot.sh script file on your workstation or 
server, then click OK.

The prereboot.sh file is set to be uploaded to the /tmp directory on each server being 
upgraded.

8 Add the answer file to OES2-SP3-file-bundle:

8a In the Files panel, click Add > Upload.

8b In the Destination field, type /opt/novell/oes-install.

8c In the Target Platforms list, select sles-10-x86_64.

8d Click Add File, browse to and select the answer file on your workstation or server, then 
click OK.

The prereboot.sh and answer files are listed. 

9 Below the Files panel, click Next.

An empty Scriptable Actions list is displayed.

10 Click New.

11 In the Scriptable Action drop-down list, select Post-Installation.

12 In the Script to run drop-down list, select Define your own script.

13 Copy and paste the following contents to the Script Content box:

#!/bin/sh
/etc/init.d/atd start
at now + 2 minutes -f /tmp/prereboot.sh

14 Click OK > Next.

15 Click Finish > OK.

The file bundle is created.

OES2-SP3-firstboot-bundle

1 Log in to ZENworks Control Center.

2 Click Bundles.

3 In the Bundles panel, click New > Bundle.

4 Select RPM Package Bundle, then click Next.

5 In the Name field, type OES2-SP3-firstboot-bundle.

6 Click Next.

The file bundle is ready to have files added to it.

7 In the Packages panel, click Add > Import From Repository.

8 In the Search panel > Name field, type yast2-firstboot and click Search.

9 Select rpm, then click OK.

The yast2-firstboot RPM is available as part of the SLES 10 SP4 bundle on the ZENworks 
Linux Management server.

10 In the Packages panel, click Add > Import From Repository.

11 In the Search panel > Name field, type evms and click Search.
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12 Select the rpm evms2.5.5-24.73.17, then click OK.

13 In the Packages panel, click Add > Import From Repository.

14 In the Search panel > Name field, type ruby, then click Search.

15 Select the ruby-1.8.6.p369-0.5 and ruby-devel-1.8.6.p369-0.5 RPMs,  then click 
OK.

16 Click Next.

17 Under Scriptable Actions, click New.

18 In the Scriptable Action drop-down list, select Post-Installation.

19 In the Script to Run drop-down list, select Define your own script.

20 Copy and paste the contents from Section C.2.6, “Post-Installation Script File,” on page 258 to 
the Script Content box.

21 Click OK > Next.

22 Click Finish > OK.

The post-installation script is added to the Scriptable Actions panel.

23 After creating the OES2-SP3-firstboot-bundle, click the bundle and go to the Details tab. For 
the yast2-firstboot RPM, ensure that the state of freshen is set to false.

C.1.4  Assigning the Bundles and Scheduling Upgrades

Assign the bundles to the OES 2 SP2 servers, then schedule the bundles to install appropriately:

1 In the ZENworks Control Center, click Bundles.

2 In the left column, select oes2-sp3-pool-catalog.

3 Click Action > Assign Catalog.

4 Click Add, click the down-arrow by Servers, then select the servers that you want to assign the 
bundles to.

5 Click OK > Next.

6 Schedule the catalog to install according to your organization’s policy.

7 In the left column, select OES2-SP3-Online-bundle, OES2-SP3-file-bundle, and OES2-SP3-
firstboot-bundle.

8 Click Action > Assign Bundle.

9 Click Add, click the down-arrow by Servers, then select the servers you want to upgrade.

10 Click OK > Next.

11 Schedule the bundles to install according to your organization’s policy.

12 Click Next > Finish > OK.

IMPORTANT: The servers you selected in the preceding steps are now ready to be upgraded to 
OES 2 SP3. The actual upgrade operations occur automatically as scheduled.
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C.1.5  Creating the answer and prereboot.sh Files

 “answer file” on page 250

 “prereboot.sh file” on page 250

answer file

For the upgrade process to run without user intervention, each SP3 server must have an eDirectory 
password answer file for the YaST install.

1 As root, open a terminal prompt.

2 At the prompt, enter the following command:

sudo yast2 create-answer-file ldap_password optional_domain_admin_password

Replace ldap_password with the LDAP (eDirectory) Admin password and 
optional_domain_admin_password with the Domain Services for Windows (DSfW) Domain 
Administrator password, if it is needed for any of the servers being upgraded. (The existence of 
a second password in the answer file does not affect the upgrade process on servers that don’t 
have DSfW installed.)

IMPORTANT: Because passwords on the command line might include special characters, it is 
a good idea to surround the password with single quotes. For example, if the password is 
pa$$word, enter it as ‘pa$$word’.

All the uses of an exclamation mark (!) require that you escape the character by using a 
backslash (\). For example, the password novell! must be specified as novell\! or preferably 
‘novell/!’. 

A dash (-) used at the beginning of a password also requires escaping. For example, -novell- 
must be specified as \-novell- or preferably ‘\-novell-’.

3 Press Enter to close the confirmation message.

4 From your working directory, copy the resulting answer file to the workstation or server that 
you will use to create the bundles.

prereboot.sh file

The prereboot.sh script checks whether the bundles are installed. On successful installation of all 
bundles, it triggers a reboot.

1 Open any text editor.

2 Copy and paste the following text into the text editor, then save it as prereboot.sh. Copy the 
prereboot.sh file to the workstation or server that you will use to create the bundles.

#!/bin/bash

status="j"
while [ $status != "ii" ] ; do
sleep 10
status=i`rug bl |grep OES2-SP3-Online-bundle  |cut -f1 -d '|'`
done
status="j"
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while [ $status != "ii" ] ; do
sleep 10
status=i`rug bl |grep OES2-SP3-firstboot-bundle  |cut -f1 -d '|'`
done

sleep 60
/sbin/reboot

IMPORTANT: In the above script, the bundle names are OES2-SP3-Online-bundle and 
OES2-SP3-firstboot-bundle. If your bundle name is different, change the script accordingly. If 
the bundle names are inaccurate, the reboot is not triggered after installation of the bundles.

C.1.6  Post-Installation Script File

The following post-installation script is added to the OES2-SP3-firstboot-bundle. See Step 20 on 
page 249.

#!/bin/sh

touch /etc/reconfig_system
chkconfig firstboot on

cat  > /etc/YaST2/firstboot.xml << EndOfText
<?xml version="1.0"?>
<!DOCTYPE productDefines SYSTEM "/usr/share/YaST2/control/control.dtd">
<productDefines  xmlns="http://www.suse.com/1.0/yast2ns"
    xmlns:config="http://www.suse.com/1.0/configns">

    <!--
    : firstboot.xml 35106 2007-01-05 13:42:15Z jsrain $
    Work around for the text domain
    textdomain="firstboot"
    -->

    <textdomain>firstboot</textdomain>
    <workflows  config:type="list">
        <workflow>
            <defaults>
                <enable_back>yes</enable_back>
                <enable_next>yes</enable_next>
                <archs>all</archs>
            </defaults>
            <stage>firstboot</stage>
            <label>Channel Upgrade</label>
            <mode>installation</mode>
            <modules config:type="list">
                <module>
                    <label>upgrade</label>
                    <enabled config:type="boolean">true</enabled>
                    <name>channel-upgrade-oes</name>
                </module>
            </modules>
        </workflow>
    </workflows>
</productDefines>
EndOfText
Upgrading to OES 2 SP3 Through a ZENworks Linux Management Server 251



252 OES 2
C.1.7  Sample XML file for Mirroring

<ZLMMirrorConf>
 <Session>
  <RemoteServer>
   <Base>https://nu.novell.com/repo</Base>
   <Proxy></Proxy>
   <Type>nu</Type>
   <SystemID></SystemID>
   <User>USERID</User>
   <Password>PASSWORD</Password>
  </RemoteServer>
  <LocalServer>
   <Base></Base>
   <Type>zlm</Type>
   <User>ZLM-ADMINID</User>
   <Password>ZLM-ADMINPASSWORD</Password>
  </LocalServer>
  <Catalog>
   <Name>OES2-SP3-Pool</Name>
   <LocalName>oes2-sp3-pool-catalog</LocalName>
   <Folder>OES2-SP3</Folder>
   <Target>sles-10-x86_64</Target>
   <ExcludeTarget></ExcludeTarget>
   <Bundle></Bundle>
   <ExcludeBundle></ExcludeBundle>
   <Package></Package>
   <ExcludePackage></ExcludePackage>
  </Catalog>
  <Catalog>
   <Name>OES2-SP3-Online</Name>
   <LocalName>oes2-sp3-online-catalog</LocalName>
   <Folder>OES2-SP3</Folder>
   <Target>sles-10-x86_64</Target>
   <ExcludeTarget></ExcludeTarget>
   <Bundle></Bundle>
   <ExcludeBundle></ExcludeBundle>
   <Package></Package>
   <ExcludePackage></ExcludePackage>
  </Catalog>
 </Session>
</ZLMMirrorConf>

C.2  Using a ZLM Server and an ISO Image File to 
Upgrade

NOTE: All of the examples in this section reflect the x86_64 (64-bit) platform.

The information and instructions in the following sections help you perform an unattended, online 
upgrade from Open Enterprise Server (OES) 2 SP2 to OES 2 SP3 by using ZENworks Linux 
Management (ZLM) and an OES 2 SP3 ISO image file. 
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After completing the instructions in the following sections, OES 2 SP2 servers are upgraded 
according to the schedule you set.

 Section C.2.1, “Preparing the Environment,” on page 253

 Section C.2.2, “Creating OES 2 SP3 Bundles,” on page 253

 Section C.2.3, “Assigning the Bundles and Scheduling Upgrades,” on page 255

 Section C.2.4, “Creating the answer and prereboot.sh Files,” on page 256

 Section C.2.5, “Creating the pkgadd.sh file,” on page 257

 Section C.2.6, “Post-Installation Script File,” on page 258

C.2.1  Preparing the Environment

Before you can use ZENworks Linux Management to upgrade OES 2 SP2 servers to OES 2 SP3, 
you must have the following:

 The ZENworks Linux Management 7.3 IR3 server installed and running on your network.

 The ZENworks Linux Management 7.3 IR3 Agent installed on each OES 2 SP2 server that you 
plan to upgrade. 

IMPORTANT: The agent included with OES provides package-management capabilities 
through the ZENworks Management Daemon. Unless the full agent is installed, updates cannot 
be scheduled from the ZENworks Linux Management server.

 Each OES 2 SP2 server registered with the ZENworks Linux Management server. 

C.2.2  Creating OES 2 SP3 Bundles

For the upgrade process, you need to create the following bundles on the ZLM server:

 “OES2SP3-bundle” on page 253

 “OES2SP3-file-bundle” on page 254

 “OES2SP3-firstboot-bundle” on page 255

OES2SP3-bundle

When you create this bundle, all of the OES 2 SP3 RPMs are added to it.

1 Download  the OES 2 SP3 ISO image for the x86_64 (64-bit) platform. 

2 Create a pkgadd.sh file and copy it to the ZLM server. For more information on the  
pkgadd.sh file, refer to the “Creating the pkgadd.sh file” on page 257.

3 Add the execute permission to the pkgadd.sh file:

chmod +x pkgadd.sh

4 On the ZLM server, mount the OES 2 SP3 ISO image under the directory where you copied 
pkgadd.sh.

For example, if the pkgadd.sh file is copied to the /home/user1/ directory, mount the OES 2 
SP3 ISO image on /home/user1/oes2sp3/.

5 Execute the following command: 
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./pkgadd.sh OES2SP3-bundle sles-10-x86_64

This creates the OES2SP3-bundle for the x86_64 platform with OES 2 SP3 RPMs.

OES2SP3-file-bundle

You must create the answer file and the prereboot.sh file before executing the following steps.

1 Log in to ZENworks Control Center.

2 Click Bundles.

3 In the Bundles panel, click New > Bundle.

4 Select File Bundle, then click Next.

5 In the Name field, type OES2SP3-file-bundle.

6 Click Next.

The file bundle is ready to have files added to it.

7 Add the prereboot.sh file to OES2SP3-file-bundle:

7a In the Files panel, click Add > Upload.

7b In the Destination field, type /tmp.

7c In the Target Platforms list, select sles-10-x86_64.

7d Click Add File, browse to and select the prereboot.sh script file on your workstation or 
server, then click OK.

The prereboot.sh file is set to be uploaded to the /tmp directory on each server being 
upgraded.

8 Add the answer file to OES2SP3-file-bundle:

8a In the Files panel, click Add > Upload.

8b In the Destination field, type /opt/novell/oes-install.

8c In the Target Platforms list, select sles-10-x86_64.

8d Click Add File, browse to and select the answer file on your workstation or server, then 
click OK.

The prereboot.sh and answer files are listed. 

9 Below the Files panel, click Next.

An empty Scriptable Actions list is displayed.

10 Click New.

11 In the Scriptable Action drop-down list, select Post-Installation.

12 In the Script to run drop-down list, select Define your own script.

13 Copy and paste the following contents to the Script Content box:

#!/bin/sh
/etc/init.d/atd start
at now + 2 minutes -f /tmp/prereboot.sh

14 Click OK > Next.

15 Click Finish > OK.

The file bundle is created.
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OES2SP3-firstboot-bundle

1 Log in to ZENworks Control Center.

2 Click Bundles.

3 In the Bundles panel, click New > Bundle.

4 Select RPM Package Bundle, then click Next.

5 In the Name field, type OES2SP3-firstboot-bundle.

6 Click Next.

The file bundle is ready to have files added to it.

7 In the Packages panel, click Import From Repository

8 In the Search panel > Name field, type yast2-firstboot and click Search.

9 Select RPM, then click OK.

The yast2-firstboot rpm is available as part of the SLES10 SP4 bundle on the ZENworks Linux 
Management (ZLM) server. If the SLES 10 SP4 bundle is not available on the ZLM server, 
then copy yast2-firstboot.rpm from the SLES 10 SP4 ISO image and upload the RPM to 
this bundle.

10 Click Next.

11 Under Scriptable Actions, click New.

12 In the Scriptable Action drop-down list, select Post-Installation.

13 In the Script to Run drop-down list, select Define your own script.

14 Copy and paste the contents from Section C.2.6, “Post-Installation Script File,” on page 258 to 
the Script Content box.

15 Click OK > Next.

16 Click Finish > OK.

The post-installation script is added to the Scriptable Actions panel.

C.2.3  Assigning the Bundles and Scheduling Upgrades

Assign the bundles to the OES 2 SP2 servers, then schedule them to install appropriately.

1 In the ZENworks Control Center, click Bundles.

2 In the left column, select OES2SP3-bundle, OES2SP3-file-bundle, and OES2SP3-firstboot-
bundle.

3 Click Action > Assign Bundle.

4 Click Add, click the down-arrow by Servers, then select the servers you want to upgrade.

5 Click OK > Next.

6 Schedule the bundles to install according to your organization’s policy.

7 Click Next > Finish > OK.

IMPORTANT: The servers you have selected in the preceding steps are now ready to be upgraded 
to OES 2 SP3. The actual upgrade operations occur automatically as scheduled.
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C.2.4  Creating the answer and prereboot.sh Files

 “answer file” on page 256

 “prereboot.sh file” on page 256

answer file

For the upgrade process to run without user intervention, each SP3 server must have an eDirectory 
password answer file for the YaST install.

1 As root, open a terminal prompt.

2 At the prompt, enter the following command:

sudo yast2 create-answer-file ldap_password optional_domain_admin_password

Replace ldap_password with the LDAP (eDirectory) Admin password and 
optional_domain_admin_password with the Domain Services for Windows (DSfW) Domain 
Administrator password, if it is needed for any of the servers being upgraded. (The existence of 
a second password in the answer file does not affect the upgrade process on servers that don’t 
have DSfW installed.)

IMPORTANT: All the uses of an exclamation mark (!) require that you escape the character 
by using a backslash (\). For example, the password novell! must be specified as novell\!. 

A dash (-) used at the beginning of a password also requires escaping. For example, -novell- 
must be specified as \-novell-.

3 Press Enter to close the confirmation message.

4 From your working directory, copy the resulting answer file to the workstation or server that 
you will use to create the bundles.

prereboot.sh file

The prereboot.sh script checks whether the bundles are installed. On successful installation of all 
bundles, it triggers a reboot.

1 Open any text editor.

2 Copy and paste the following text into a text editor, then save it as prereboot.sh

#!/bin/bash

status="j"
while [ $status != "ii" ] ; do
sleep 10
status=i`rug bl |grep OES2SP3-bundle  |cut -f1 -d '|'`
done
status="j"
while [ $status != "ii" ] ; do
sleep 10
status=i`rug bl |grep OES2SP3-firstboot-bundle  |cut -f1 -d '|'`
done

sleep 60
/sbin/reboot
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IMPORTANT: In the above script, the bundle names are  OES2SP3-bundle and  OES2SP3-
firstboot-bundle. If your bundle name is different, change the script accordingly. If the bundle 
names are inaccurate, the reboot is not triggered after installation of the bundles.

C.2.5  Creating the pkgadd.sh file

This script is used to create a bundle from an ISO image.

Usage: pkgadd.sh <bundle_name> <arch/target>

To create the pkgadd.sh file:

1 Open any text editor.

2 Copy and paste the following text into the text editor, then save it as pkgadd.sh.

#!/bin/bash
#
# Run this program from a directory filled with RPMS to load them into a 
bundle in ZLM.
#
# All rpms, except src and nosrc rpms, in the directory and all of its 
subdirectories will be loaded into the bundle and architecture indicated 
below.
#
# Don't forget to enter your admin password below and update the bundle 
name and architecture below.
#
if [ $# -lt 2 ]

then

 echo "Usage :: pkgadd.sh <bundle_name> <arch> "

 echo "Example :: pkgadd.sh SLES-9-Distro sles-9-i586 "

exit

fi

# Create the bundle to load into

zlman -V -U administrator -P novell bc $1
 
# loop through these directories and load all of the rpms

STARTDIR=`pwd`

for dir in `find . |grep .rpm |grep -v src.rpm|grep -v nosrc.rpm|awk -F / 
'{NF--; OFS="/"; print $0}'| sort | uniq`; do

  cd $STARTDIR

  cd $dir
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  echo "Loading RPM's from `pwd`"

  zlman -V -U administrator -P novell bap $1 $2 *.rpm --force-nevra --
freshen;

done

C.2.6  Post-Installation Script File

The following post-installation script is added to the OES 2 SP3-firstboot-bundle. See Step 14 on 
page 255.

#!/bin/sh

touch /etc/reconfig_system
chkconfig firstboot on

cat  > /etc/YaST2/firstboot.xml << EndOfText
<?xml version="1.0"?>
<!DOCTYPE productDefines SYSTEM "/usr/share/YaST2/control/control.dtd">
<productDefines  xmlns="http://www.suse.com/1.0/yast2ns"
    xmlns:config="http://www.suse.com/1.0/configns">

    <!--
    : firstboot.xml 35106 2007-01-05 13:42:15Z jsrain $
    Work around for the text domain
    textdomain="firstboot"
    -->

    <textdomain>firstboot</textdomain>
    <workflows  config:type="list">
        <workflow>
            <defaults>
                <enable_back>yes</enable_back>
                <enable_next>yes</enable_next>
                <archs>all</archs>
            </defaults>
            <stage>firstboot</stage>
            <label>Channel Upgrade</label>
            <mode>installation</mode>
            <modules  config:type="list">
                <module>
                    <label>upgrade</label>
                    <enabled config:type="boolean">true</enabled>
                    <name>channel-upgrade-oes</name>
                </module>
            </modules>
        </workflow>
    </workflows>
</productDefines>
EndOfText
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C.3  Known Issues
 Section C.3.1, “oes-SPident Command Does Not Display the OES 2 SP3 Version,” on 

page 259

 Section C.3.2, “After Installing Bundles, the Status of ZLM Bundle Does Not Change to 
Install,” on page 259

C.3.1  oes-SPident Command Does Not Display the OES 2 SP3 
Version

This issue occurs because of duplicate files. When you upgrade the servers to OES 2 SP3, the 
system contains both the old and new versions of the novell-ifolder-mono RPM. 

To resolve this issue, delete the older version of the novell-ifolder-mono-2.4-0.13 RPM.

C.3.2  After Installing Bundles, the Status of ZLM Bundle Does 
Not Change to Install

If the iFolder service is running on the OES 2 SP2 server, the status of the bundles does not change 
to Installed.

To resolve this issue, execute the following command:

rug ref

The bundle status changes to Installed and a reboot is triggered.
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D
DDocumentation Updates

To help you keep current on updates to the documentation, this section contains information on 
content changes that have been made in this guide since publication for the FCS release. 

This document is provided on the Web in HTML and PDF, and is kept up to date with the 
documentation changes listed in this section. If you need to know whether a copy of the PDF 
documentation you are using is the most recent, check its publication date on the title page.

September, 2011

February 8, 2011

February 3, 2011

January 26, 2011

January 19, 2011

Section Change

All Updated SLES 10 SP3 references to SLES 10 
SP4.

Section Change

“OES2-SP3-firstboot-bundle” on page 248 Corrected reference to second ruby package.

Section Change

Section 1.2, “What’s New in the OES 2 SP3 Install,” 
on page 13

Mentioned common proxy support as a new 
feature, previously overlooked.

Section Change

All Made editorial changes for SP3.

Section Change

Section 3.6.10, “Configuring OES Services,” on 
page 79 and Section 5.4.12, “Specifying 
Configuration Information,” on page 141

Improved visibility and access to the OES service 
configuration guidelines.
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December 2010

October 7, 2010

February 24, 2010

February 18, 2010

February 2, 2010

January 13, 2010

Section Change

Section C.2, “Using a ZLM Server and an ISO 
Image File to Upgrade,” on page 252

New section added.

All sections Updated for the SP3 release.

Section Change

Chapter 14, “Reconfiguring eDirectory and OES 
Services,” on page 223

New section added.

Section Change

Section C.2.3, “Assigning the Bundles and 
Scheduling Upgrades,” on page 255

Minor clarifications made.

Section Change

Appendix C, “Upgrading to OES 2 SP3 Through a 
ZENworks Linux Management Server,” on 
page 245

New section added.

Section Change

Various Editing changes for style and uniformity throughout.

Section Change

Various Corrected references to SLES 10 SP2 that should 
refer to SLES 10 SP3.
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December 17, 2009

November 2009

Section Change

Section 2.9, “Preparing Physical Media for a New 
Server Installation or an Upgrade,” on page 39

Updated download links.

Section Change

Section 2.4, “eDirectory Rights Needed for 
Installing OES,” on page 20

Reworked and updated information.

Section 2.5, “Installing and Configuring OES as a 
Subcontainer Administrator,” on page 21

Reworked and updated information.

Section 5.4.5, “Using the Patch Channel to 
Upgrade (Online),” on page 130

New section.

Chapter 12, “Upgrading NetWare on a Xen-based 
VM,” on page 219

New section moved from the NetWare Installation 
Guide.

Appendix A, “Installing with EVMS as the Volume 
Manager of the System Device,” on page 233

Removed manual EVMS instructions.
Documentation Updates 263



264 OES 2
 SP3: Installation Guide


	OES 2 SP3: Installation Guide
	About This Guide
	1 What's New in the OES 2 Install
	1.1 New or Changed with the September 2011 Patch Release
	1.2 What’s New in the OES 2 SP3 Install
	1.3 What’s New in the OES 2 SP2 Install
	1.4 What’s New in the OES 2 SP1 Install
	1.5 What’s New in the OES 2 Install

	2 Preparing to Install OES 2 SP3
	2.1 Before You Install
	2.2 32-Bit vs. 64-Bit
	2.2.1 64-Bit eDirectory
	2.2.2 64-Bit NCP Server
	2.2.3 Matching Software with Server Hardware
	2.2.4 Don’t Mix 32-Bit and 64-Bit OES and SLES

	2.3 Meeting All Server Software and Hardware Requirements
	2.3.1 Server Software
	2.3.2 Server Hardware

	2.4 eDirectory Rights Needed for Installing OES
	2.4.1 Rights to Install the First OES Server in a Tree
	2.4.2 Rights to Install the First Three Servers in an eDirectory Tree
	2.4.3 Rights to Install the First Three Servers in any eDirectory Partition

	2.5 Installing and Configuring OES as a Subcontainer Administrator
	2.5.1 Rights Required for Subcontainer Administrators
	2.5.2 Starting a New Installation as a Subcontainer Administrator
	2.5.3 Adding/Configuring OES Services as a Different Administrator

	2.6 Preparing eDirectory for OES 2 SP3
	2.6.1 If Your Directory Tree Is Earlier than eDirectory 8.6
	2.6.2 If Your LDAP Server Is Running NetWare 6.5 SP2 or Earlier
	2.6.3 If Your Tree Has Ever Contained an OES 1 Linux Server with LUM and NSS Installed
	2.6.4 Extending the Schema

	2.7 Deciding What Patterns to Install
	2.8 Obtaining OES 2 Software
	2.9 Preparing Physical Media for a New Server Installation or an Upgrade 
	2.10 Setting Up a Network Installation Source
	2.10.1 SUSE Linux as a Network Installation Source Server
	2.10.2 NetWare as a Network Installation Source Server
	2.10.3 Windows as a Network Installation Source Server

	2.11 Always Install OES as an Add-On Product
	2.12 Install Only One Server at a Time
	2.13 What's Next

	3 Installing OES 2 SP3 as a New Installation
	3.1 Starting the OES 2 SP3 Installation
	3.1.1 Installing from Physical Media
	3.1.2 Installing from a Network Source with DHCP
	3.1.3 Installing from a Network Source without DHCP

	3.2 Specifying the Installation Mode
	3.3 Specifying the Add-On Product Installation Information
	3.4 Setting Up the Clock and Time Zone
	3.5 Specifying the Installation Settings for the SLES Base and OES Installation
	3.5.1 Setting Up Disk Partitions
	3.5.2 Customizing the Software Selections
	3.5.3 Accepting the Installation Settings

	3.6 Specifying Configuration Information
	3.6.1 Specifying the Password for the System Administrator “root”
	3.6.2 Specifying the Hostname and Domain Name
	3.6.3 Specifying Network Configuration Settings
	3.6.4 Testing the Connection to the Internet
	3.6.5 Specifying Novell Customer Center Configuration Settings
	3.6.6 Updating the Server Software
	3.6.7 Specifying Service Configuration Settings
	3.6.8 Specifying LDAP Configuration Settings
	3.6.9 Specifying eDirectory Configuration Settings
	3.6.10 Configuring OES Services
	3.6.11 Configuration Guidelines for OES Services

	3.7 Finishing the Installation
	3.8 Verifying That the Installation Was Successful
	3.9 What's Next

	4 Installing or Configuring OES 2 SP3 on an Existing Server
	4.1 Before You Install OES Services on an Existing Server
	4.1.1 Always Use YaST to Install and Initially Configure OES Services
	4.1.2 Don’t Install OES While Running the Xen Kernel
	4.1.3 If You Want eDirectory to Use a Local Database on the Server

	4.2 Adding/Configuring OES Services on an Existing Server
	4.3 Adding/Configuring OES Services on a Server That Another Administrator Installed
	4.4 What's Next

	5 Upgrading to OES 2 SP3
	5.1 Supported Upgrade Paths
	5.2 Planning for the Upgrade to OES 2 SP3
	5.2.1 Be Sure to Check the Readme
	5.2.2 Always Upgrade SLES and OES at the Same Time
	5.2.3 Understanding the Implications for Other Products Currently Installed on the Server

	5.3 Meeting the Upgrade Requirements 
	5.3.1 Securing Current Data
	5.3.2 Ensuring That There Is Adequate Storage Space on the Root Partition
	5.3.3 Preparing the Server You Are Ugrading
	5.3.4 Checking the Server’s IP Address
	5.3.5 Checking the Server’s DNS Name
	5.3.6 Ensuring That the Server Has a Server Certificate
	5.3.7 Preparing an Installation Source

	5.4 Upgrading to OES 2 SP3
	5.4.1 For Servers with EVMS and NSS on the System Device
	5.4.2 To Upgrade Using a Network Installation Source with DHCP (Offline)
	5.4.3 Upgrading Using a Network Installation Source without DHCP (Offline)
	5.4.4 Using Physical Media to Upgrade (Offline)
	5.4.5 Using the Patch Channel to Upgrade (Online)
	5.4.6 Selecting the Installation Mode Options
	5.4.7 Specifying the Partition to Update
	5.4.8 Specifying the Add-On Product Installation Information
	5.4.9 Reviewing the Delete Unmaintained Packages Notification
	5.4.10 Verifying and Customizing the Update Options in Installation Settings
	5.4.11 Accepting the Installation Settings
	5.4.12 Specifying Configuration Information

	5.5 Finishing the Upgrade
	5.6 Post-Migration iManager Configuration
	5.7 Verifying That the Upgrade Was Successful
	5.8 What's Next

	6 Completing OES Installation or Upgrade Tasks
	6.1 Determining Which Services Need Additional Configuration
	6.2 Rebooting the Server after Installing NSS
	6.3 Restarting Tomcat
	6.4 Launching and Configuring Firefox for Linux

	7 Updating (Patching) an OES 2 SP3 Server
	7.1 Overview of Updating (Patching)
	7.1.1 The Patch Process Briefly Explained
	7.1.2 Update Options

	7.2 Preparing the Server for Updating
	7.3 Registering the Server in the Novell Customer Center
	7.3.1 Prerequisites
	7.3.2 Registering the Server in the Novell Customer Center (Command Line)
	7.3.3 Registering the Server in the Novell Customer Center (GUI)

	7.4 Updating the Server
	7.4.1 Updating the Server Base from SLES 10SP3 to SLES10 SP4
	7.4.2 Updating the Server by Using the Command Line
	7.4.3 Updating the Server from the GNOME or KDE Desktop

	7.5 Verifying That Your Channel Subscriptions Are Up-to-Date
	7.6 Frequently Asked Questions about Updating
	7.6.1 Do I apply all the patches in the catalogs? How do I know which patches to apply?
	7.6.2 How do I re-add the catalogs for OES 2 in my ZENworks Management Daemon configuration after removing one or more of them?
	7.6.3 What about YaST Online Update?

	7.7 Patching From Behind a Proxy Server
	7.8 Quick Path Updating
	7.8.1 Do Not Use rug up without the -t Option
	7.8.2 Command Line Quick Path for Updating OES 2
	7.8.3 GUI Quick Path for Updating OES 2 SP3


	8 Using AutoYaST to Install and Configure Multiple OES Servers
	8.1 Security Considerations
	8.2 Prerequisites
	8.3 Setting Up a Control File with OES Components
	8.3.1 Fixing an Automatically Created Control File
	8.3.2 Using the AutoInstallation Module to Create the Control File

	8.4 Setting Up an Installation Source

	9 Installing OES as a Xen VM Host Server
	10 Installing, Upgrading, or Updating OES on a Xen-based VM
	10.1 System Requirements
	10.1.1 OES 2 SP3 VM Host Considerations
	10.1.2 Novell Storage Services Considerations
	10.1.3 Setup Instructions

	10.2 Prerequisites
	10.3 Preparing the Installation Software
	10.3.1 Downloading the Installation Software
	10.3.2 Preparing the Installation Source Files

	10.4 Installing an OES 2 SP3 VM Guest
	10.4.1 Specifying Options for Creating an OES 2 SP3 VM Guest
	10.4.2 Specifying the Installation Mode
	10.4.3 Specifying the Add-On Product Installation Information
	10.4.4 Completing the OES 2 SP3 VM Guest Installation

	10.5 Upgrading an OES 2 VM Guest to OES 2 SP3
	10.5.1 Upgrading an OES 2 VM Guest by Using the Update Channel
	10.5.2 Performing an Offline Upgrade

	10.6 Updating an OES 2 SP3 VM Guest
	10.7 Managing a Virtual Machine Running OES 2 SP3
	10.8 Setting Up an OES 2 SP3 VM Guest to Use Novell Storage Services (NSS)

	11 Installing and Managing NetWare on a Xen-based VM
	11.1 Introduction
	11.2 Support Information
	11.2.1 OES 2 Registration Is Required for Support
	11.2.2 Supported Configurations and Features
	11.2.3 Unsupported Configurations and Features

	11.3 Preparing to Install a NetWare VM Guest Server
	11.3.1 Planning for VM Host Servers
	11.3.2 Planning for NetWare VM Guest Servers
	11.3.3 You Must Use Timesync for Time Synchronization
	11.3.4 Disabling the Alt+Esc Shortcut on the Host

	11.4 Installing Virtualized NetWare
	11.4.1 Preparing the Installation Media
	11.4.2 Creating a Response File for an Unattended NetWare Installation
	11.4.3 Creating a Xen Virtual Machine and Installing a NetWare VM Guest Server

	11.5 Managing NetWare on a Virtual Machine
	11.5.1 Using the Virtual Machine Manager
	11.5.2 Using the Command Line

	11.6 If VM Manager Doesn’t Launch on a Xen VM Host Server

	12 Upgrading NetWare on a Xen- based VM
	12.1 Upgrading the VM Host Server
	12.2 Upgrading the NetWare VM Guest Server
	12.2.1 Downloading the NetWare SP8 Zip File
	12.2.2 Providing Access to a Mounted DVD


	13 Disabling OES 2 Services
	14 Reconfiguring eDirectory and OES Services 
	14.1 Cleaning Up the eDirectory Server
	14.1.1 Before You Clean Up 
	14.1.2 Reconfiguring the Replica Server
	14.1.3 Reconfiguring the CA Server
	14.1.4 Cleaning Up eDirectory

	14.2 Reconfiguring the eDirectory Server through YaST 
	14.3 Reconfiguring OES Services
	14.3.1 Re-creating eDirectory Objects
	14.3.2 Services Requiring Reconfiguration
	14.3.3 Manually Starting Services 


	15 Security Considerations
	15.1 Password for User Admin Written in Clear Text in control.xml
	15.2 Access to the Server During an Installation or Upgrade
	15.3 Remote Installations Through VNC
	15.4 Improperly Configured LDAP Servers

	A Installing with EVMS as the Volume Manager of the System Device
	A.1 Using EVMS to Manage the System Device
	A.2 Configuring the System Device to Use EVMS
	A.2.1 Understanding the EVMS–Based Partitioning Scheme
	A.2.2 Prerequisites
	A.2.3 Modifying the Installation Settings 

	A.3 Installing SLES 10 SP4 and Post-Installing OES 2 SP3
	A.4 Using EVMS to Manage Devices
	A.4.1 NSS File Systems on EVMS-Managed Devices
	A.4.2 Linux POSIX File Systems on EVMS-Managed Devices


	B OES 2 SP3 File and Data Locations
	B.1 General Rules
	B.2 Exceptions

	C Upgrading to OES 2 SP3 Through a ZENworks Linux Management Server
	C.1 Using a ZLM Server and the Patch Channel to Upgrade
	C.1.1 Preparing the Environment
	C.1.2 Mirroring the Channels to Your ZENworks Linux Management Server
	C.1.3 Creating OES 2 SP3 Bundles
	C.1.4 Assigning the Bundles and Scheduling Upgrades
	C.1.5 Creating the answer and prereboot.sh Files
	C.1.6 Post-Installation Script File
	C.1.7 Sample XML file for Mirroring

	C.2 Using a ZLM Server and an ISO Image File to Upgrade
	C.2.1 Preparing the Environment
	C.2.2 Creating OES 2 SP3 Bundles
	C.2.3 Assigning the Bundles and Scheduling Upgrades
	C.2.4 Creating the answer and prereboot.sh Files
	C.2.5 Creating the pkgadd.sh file
	C.2.6 Post-Installation Script File

	C.3 Known Issues
	C.3.1 oes-SPident Command Does Not Display the OES 2 SP3 Version
	C.3.2 After Installing Bundles, the Status of ZLM Bundle Does Not Change to Install


	D Documentation Updates

